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COPYRIGHT 
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1. Introduction to this manual 

This manual is intended to introduce LabSpec 5 to new users of HORIBA Scientific Raman 

spectrometers, and to act as a reference guide to the many acquisition and analysis functions 

available within LabSpec 5. 

1.1. Use of this manual 

This manual must be used in conjunction with the relevant hardware manual accompanying each 

HORIBA Scientific Raman spectrometer. 

It is advisable that specific hardware/software training is provided to new users by either a trained 

HORIBA Scientific service or application engineer, or by an experienced user within the institution.   

Please note that not all systems will have all available accessories and options installed, and thus the 

screen shots and images in this manual may not directly correspond to software installed with the 

specific system you are using.  If in doubt, please contact your local HORIBA Scientific office or 

representative to receive more information about available accessories and options. 

1.2. Terminology used 

For clarity explanations on key terms and conventions used throughout this manual are given below. 

Instrument, equipment, system, spectrometer 

These terms refer to the main Raman hardware, which typically comprises laser(s), microscope, 

monochromator(s), and detector(s). 

Accessory 

This refers to optional devices such as motorized sample stage, or temperature stage. 

Dialog window 

This refers to a window which appears during the operation/set-up of a specific function.  For 

example, clicking on the Peaks icon opens the Peaks dialog window, which contains a mixture of 

text/number inputs, buttons and drop down boxes. 

Menu 

Underlined text (for example, File or Edit) refers to an item in the Menu Bar.  The “>” symbol indicates 

a menu item, or a sub-menu (for example, File > Save, or Edit > Restore). 

[button] 

Text in square brackets (for example, [OK] or [Cancel]) refers to a software button in the dialog 

window currently being described. 

{radio button} 

Text in curved brackets (for example {Video On} or {Video Off}) refers to a radio button in the dialog 

window currently being described. 

<enter ����   > 

This refers to the keyboard ‘enter’ or ‘return’ button. 
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Multidimensional spectral array 

This refers to a spectral ‘map’ or ‘profile’, including time profiles, Z (depth) profiles, temperature 

profiles, XY maps, XZ and YZ slices, and XYZ datacubes. 

1.3. Display of Icons 

Please note that there are two icon views used in LabSpec 5, called “Big icon” and “Small icon”.  In 

the descriptions throughout this manual the “Big icon” will be displayed first, followed by the “Small 

icon”. 

For further information about the icons and how to switch between “Big icon” and “Small icon” display 

please see section 4.1, page 89. 
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2. Introduction to LabSpec 5 software 

LabSpec 5 is a fully configured data acquisition and analysis software designed for HORIBA 

Scientific’s range of Raman spectrometers and microscopes. 

It enables a full range of experiment types including single spectrum acquisition, multidimensional 

spectral array acquisition (including time profiles, Z (depth) profiles, temperature profiles, XY maps, 

XZ and YZ slices, and XYZ datacubes), video image capture and automated multiwell interrogation. 

Many commonly used data analysis and processing routines are also available, including peak 

labelling and fitting, smoothing, noise reduction, baseline subtraction, linear and non-linear filtering 

and direct classical least squares modelling. 

LabSpec 5 is also compatible with Microsoft Visual Basic programming, allowing specific acquisition 

and analysis routines to be written by the user.  In addition, third party software routines can call 

LabSpec 5 through ActiveX modules. 

2.1. Instruments controlled by LabSpec 5 

A wide range of HORIBA Scientific instruments are controlled and operated by LabSpec 5 software, 

including the following: 

o LabRAM 300 / LabRAM 1B 

o LabRAM HR 

o LabRAM ARAMIS 

o LabRAM INV 

o LabRAM IR and IR
2
 

o XploRA 

o XploRA INV 

o T64000 

o U1000 

o HE spectrograph 

o InduRAM 

o AccuRA 

o Modular Raman Systems (including iHR and micro-HR spectrometers) 

2.2. Accessories controlled by LabSpec 5 

There is a large number of accessories which can be used with the above Raman systems, many of 

which can be controlled through LabSpec 5 software, where appropriate.  The following list shows 

common accessories which are fully compatible with LabSpec 5. 

If you have other accessories you would like to control with LabSpec 5 then please consult your local 

HORIBA Scientific office, agent or service department for advice. 

o Märzhäuser XY and Z motorized stages (including Tango and LStep controllers) 

o Linkam Scientific temperature stages with T94 and T95 controllers 

o IDS µEye digital cameras 

o PI (Physik Instrumente) piezo XY and Z stages 
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o Stanford Research Systems lock-in amplifiers 

o HORIBA Scientific CCD detectors 

o HORIBA Scientific InGaAs array and single channel detectors 

o Andor Technology CCD, iCCD and EMCCD detectors 

2.3. General Layout of LabSpec 5 Software 

The main LabSpec screen is divided into a number of distinct regions. 

Menu bar 

Access to standard Microsoft Windows menu functions (such as File, Edit, Help) and specific 

LabSpec 5 menus for advanced control of data acquisition and analysis functions. 

Icon bar 

Access to commonly used file, acquisition and data analysis routines.  Includes main STOP button 

which will stop all currently active acquisition and analysis routines. 

Graphical manipulation toolbar 

Access to applicable spectrum/map/image manipulation functions.  This is an active toolbar, and its 

appearance and content will update according to the currently selected window.  For example, the 

options appearing in this toolbar when a spectrum is active will differ from those appearing when a 

video image is active. 

Data bar 

List of currently open data (including spectra, profiles, maps and images) allowing specific items to be 

activated and processed as desired. 

Control panel 

Access to instrument and accessory hardware controls, and main acquisition parameters (acquisition 

time, number of accumulations etc). 

Status bar 

Information about system status (e.g., progress of an acquisition), active options (e.g., intensity 

correction, or extended range settings), and cursor positions. 

Right mouse click menu 

Access to applicable spectrum/map/image manipulation functions.  This is an active menu, and its 

appearance and content will update according to the window with which it is being used.  For 

example, the right click menu appearing for a spectrum will differ from that appearing for a video 

image. 
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3. Menu Bar 

The Menu Bar located at the top of the screen is used to control either standard Windows functions 

(such as File Open, File Close) or to provide access to specialized data acquisition/analysis modules 

and options.  The Menu Bar will only show sections which apply to the correctly installed and 

configured hardware/software options for your instrument.  The image below shows the default 

sections, but be aware that some of these may not be visible in your software, and others could be 

visible for specific instrument configurations. 

 

3.1. File 

The File menu includes functions for data management (e.g., save or open files) and printing, and in 

addition includes a list of the last four data files which were opened. 

 

 

 

 

 

 

 

 

 

 

3.1.1. Data Management 

Please note that the term ‘data file’ or ‘data object’ means any form of data compatible with LabSpec 

5, such as spectra, multidimensional spectral arrays (profiles, maps) and video images. 

3.1.1.1. File Formats 

LabSpec 5 is compatible with a number of different file formats, which will be available to you when 

opening and saving data.  More information about specific options available when saving into these 

file formats can be found in section 3.1.1.2, page 11. The available file formats are listed below.   

.ngs LabSpec 5 spectrum file format. 

Data management 

Printing 

Last four most recently opened data files 
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.ngc LabSpec 5 array file format, for multidimensional spectral data such as 1D 

profiles (depth, time, temperature), 2D maps (XY map, XZ and YZ slices) and 

3D datacubes (XYZ cubes). 

.ngv LabSpec 5 video camera snapshot image 

.tsf Previous generation LabSpec4 spectrum file format. 

.tvf Previous generation LabSpec4 video and array file format, for multidimensional 

spectral data such as 1D profiles (depth, time, temperature), 2D maps (XY 

map, XZ and YZ slices) and 3D datacubes (XYZ cubes). 

.ms0, .ss0 Legacy file formats for Dilor Raman instruments 

.spc Grams SpectraCalc spectrum file format, compatible with many common 

spectroscopy software packages.  

.tif Tiff image file format 

.txt Text file format, compatible with many common spectroscopy software 

packages, data analysis software packages and spreadsheet software 

packages. 

.bmp, .jpg Bitmap and JPEG image file formats 

3.1.1.2. Data Management Functions 

Open... Open a previously saved data file. 

 This function can be performed using the <CTRL>+O keyboard shortcut. 

Close Close the data file currently active in LabSpec 5. 

Save As... Save the data file currently active in LabSpec 5.  See Options for Saving Data 

(section 3.1.1.3, page 12) for further information. 

 This function can be performed using the <CTRL>+S keyboard shortcut. 

Save All Save all open data files of a particular type (spectrum, map, video image) into a 

single file. 

For example, if there are three spectra open (spectrum1.ngs, spectrum2.ngs, 

spectrum3.ngs) it is possible to save a single data file (all_spectra.ngs) which 

contains the three spectra.  When you open the single data file 

(all_spectra.ngs) the three spectra will be available in LabSpec 5, and can be 

processed and analysed as single spectra again. 

Split Splits and saves a multidimensional spectrum array (such as a profile or map) 

into constituent single spectra.  Each spectrum will be identified by a coordinate 

corresponding to its position within the original array data set – for example, 

spectrum_0_0, spectrum_0_1, spectrum_0_2...spectrum_1_0, spectrum_1_1... 
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 The Split function is compatible with any of the spectrum file formats described 

above (i.e., .ngs, .tsf, .ms0, .spc, .txt). 

Save Picture As... Saves the active LabSpec 5 window as a colour image in .wmf format.  Saving 

a spectrum in this format results in a color image of the spectrum window, 

including the intensity/spectral axis values and titles.  Saving a Raman map 

image in this format results in a color image of the Raman map including X,Y or 

Z axes with values and titles, scale marker and intensity scale with values and 

titles.  

3.1.1.3. Options for Saving Data 

Depending on the chosen file format there are a number of additional save options which are set out 

below. 

Note that if a file is saved in a LabSpec format then instrument and measurement parameters will be 

included as meta data within the file – such meta data can be recalled at any time within LabSpec 5, 

allowing quick access to previous measurement conditions.  Data saved into other file formats will 

lose this meta data. 

LabSpec 5 files (.ngs / .ngc / .ngv) 

Select “Compress Data” in order to compress the 

data files for spectra (.ngs), mapped 

profiles/images (.ngc) and camera images (.ngv).  

This will result in smaller file sizes, and ensure that 

less hard disk storage space is required.  There is 

no loss in quality/information when files are 

compressed. 

 

Grams Spectracalc (.spc) 

Select ““Old” Format” to save the file to be 

compatible with legacy “old” format Grams 

software. 

Select “Arbitrary Y unit” to save the spectrum with 

the Y (intensity) axis labelled as “Arbitrary Y” 

(instead of “counts”). 

Select “Even spaced” to save the spectrum with 

even X axis spacing between data points. 

Select “Spectral X unit” to force a spectrum which 

has “Arbitrary Units” for the X axis to be saved with 

units of either “Raman shift (cm
-1

)” or 

“Nanometers” (depending on the units currently 

selected within LabSpec). 
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Text (.txt) 

Select “Save axes” to save both X and Y axis data 

in text format.  If this item is not ticked, then only 

the Y axis (intensity) data will be saved in text 

format. 

 

 

 

3.1.2. Printing Functions 

Print… Print the current data window (to the default printer) using the Print Template 

Page.  Full information about using and setting up the Print Template can be 

found in section 3.1.2.1, page 13. 

 This function can be performed using the <CTRL>+P keyboard shortcut. 

Print Preview Open a preview window showing the Print Template Page (including data from 

the active data window) as it will be printed. 

Print Setup… Open the standard print dialog window to select a printer, and set up print 

options. 

Page… Open the Print Template Page set up dialog window.  See section 3.1.2.1, 

page 13 for full information about setting up the Print Template Page. 

3.1.2.1. Print Template Page Set Up Dialog Window 

The Print Template Page set up dialog window allows the layout and display information of the Print 

Template Page to be configured.  The Print Template Page is used whenever data is printed from 

directly within LabSpec 5. 
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Click on [Save] to save the current Print Template 

Page (in .ini format), using the standard File Save 

dialog window.  

Click on [Load] to open a previously saved Print 

Template Page (in .ini format), using the standard 

File Open dialog window.  

3.1.2.1.1. Print Template Page Elements 

The Print Template Page can be edited and organized by the user.  It is composed of the following 

elements, which can be inserted by left clicking and dragging after activating the appropriate icon.  

Elements can be edited by double clicking or right clicking (see section 3.1.2.1.2, page 15). 

Header 

Text box in the header position (top of window) 

displaying either custom text, or data object 

acquisition date, name, file path, or associated 

user name.  

Footer 

Text box in the footer position (bottom of window) 

displaying either custom text, or data object 

acquisition date, name, file path, or associated 

user name.  

Text 

Text box which can be positioned freely within the 

Print Template Page, displaying either custom text, 

or data object acquisition date, name, file path, or 

associated user name.  
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Image 

Image display box which can be freely positioned 

within the Print Template Page.  Note that the 

default image is the HORIBA Jobin Yvon logo, but 

a standard file browse window will be opened by 

double clicking on the image display box, allowing 

other images to be displayed.  

Graph 

Display box for the active LabSpec 5 data window 

which can be freely positioned within the Print 

Template Page.  The data and axes will be 

displayed as set in the main LabSpec 5 graphical 

user interface (GUI).  

Figure 

Text box which can be positioned freely within the 

Print Template Page, displaying either custom text, 

or data object acquisition date, name, file path, or 

associated user name. 

Param 

Multiple column text box which can be positioned 

freely within the Print Template Page, displaying 

acquisition parameters for the active data object in 

the active data window.  The parameters which are 

displayed, and their labels, can be customized by 

double clicking on the parameters text box.  

3.1.2.1.2. Editing Print Template Page Elements 

Right Click Menu 

Right click anywhere on the Print Template Page 

to display the right click menu.  

o Select “Cut” to delete the selected 

element on the Print Template Page. 

o Select “Black&White” to display the Print 

Template Page in greyscale. 

o Select “Format” to open the default 

printer Page Setup dialog window, 

allowing control of page layout (portrait or 

landscape), paper source, and print 

margins. 

o Select “Turn” to toggle between 

landscape and portrait page views. 

o Select “Skip prefix” to hide the data 

object ‘type’ prefix from the print job.  

This is particularly useful when printing 

the document to pdf, where typically the 
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print job name will be “<Object Type>: 

<Object Name>” (e.g., “Spectrum: 

data001”).  When “Skip Prefix” is ticked, 

the print job name will be the object 

name only (e.g., “data001”). 

o Select “Zoom” to change the display size 

of the Print Template Page. 

Header, footer, text and figure display boxes 

Double click on the box to display the Options 

dialog window.  The box can be configured using 

the following controls: 

o Type – select the box shape from the 

“Type” drop down box. 

o Font – select the font, style, size and 

color from the “Font” drop down box. 

o Line – select the box outline color, style 

and width from the “Line” drop down box. 

o Fill – select the box fill color and style 

from the “Fill” drop down box. 

o Text – if custom text is selected from the 

“Text mode” drop down box, type in the 

desired text in the “Text” box. 

o Text mode – select the text information 

which will be displayed in the box, from 

the “Text mode” drop down box.  Choose 

to display custom text, or data object 

acquisition date, name, file path, or 

associated user name. 

Image box 

Double click on an image box to display a standard 

File Open dialog window.  Browse to locate the 

image which will be displayed in the image box. 

 

 

 

 

Parameters box 

Double click on a parameters box to display the 

Parameter Selection dialog window.  

Parameters which will be displayed in the 

parameters box on the Print Template Page are 

shown in the right hand list box. 
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Other available parameters (from the standard 

parameters information window – see section 

4.4.5, page 92) are shown in the left hand list box. 

 

 

 

Click on the left and right arrow icons to move 

parameters from one list box to the other.  

Click on the up and down arrow icons to adjust 

display order of parameters in the parameters box.  

The Title text box shows the display name for the 

parameter selected in the right hand list box.  The 

display name can be modified by typing the 

desired name in the Title text box. 

Click on [Style] to open the Style Options dialog 

window – the options displayed here are identical 

to those listed above for header, footer, figure and 

text boxes.  

In the Column text box type in the number of 

columns in which the parameters will be displayed.  

Note that a single column is a double-column 

entity, in order to display the parameter name and 

value. 

3.2. Edit 

The Edit menu includes functions to restore data to its original form after it has been manipulated, and 

to copy and paste data. 

 

 

 

 

 

 

 

Restore data functions 

Copy and paste functions 



LabSpec 5 user manual 

 

 

 

 

Page | 18  

 

 

3.2.1. Restore Data Functions 

Undo Undo the last action which has been made in LabSpec 5.  For example, if a 

baseline subtraction does not give the desired result, the Edit > Undo function 

will return the spectrum to its original form. 

This function can be performed using the <CTRL>+Z keyboard shortcut. 

Redo Redo the last action which has been undone.  For example, if a process has 

been reversed using Edit > Undo, it can be repeated using the Edit > Redo 

function. 

This function can be performed using the <CTRL>+Y keyboard shortcut. 

Restore Reload a data object which has been closed using the Delete icon (see section 

4.2, page 90).  Edit > Restore will display a list of all data objects which have 

been deleted – left click on the data object name to reload it. 

3.2.2. Copy and Paste Functions 

Cut Close the currently active data file so that it is no longer displayed in LabSpec 

5.  Note that if the data has been saved to the computer hard drive, then it will 

remain there after it has been cut from LabSpec 5.  The data can be re-opened 

using File > Open. 

If data has not been saved, or has been modified since the last save, a warning 

message will appear prompting for you to save the changes.  Click [Yes] to 

save the changes, or [No] to close the data without saving the changes. 

Real Time Display (RTD) data (see section 4.5.1, page 95) will be closed 

without a prompt to save the changes. 

This function can be performed using the <CTRL>+X keyboard shortcut. 

Copy Copy the currently active data to the clipboard, so that it can be transferred to a 

different LabSpec data window, or to a different software program.  Please also 

see information below about the copy/paste format, which allows you to control 

how the data is copied. 

This function can be performed using the <CTRL>+C keyboard shortcut. 

Paste Paste the data from the clipboard into LabSpec 5 or into a different software 

program. 

This function can be performed using the <CTRL>+V keyboard shortcut. 

Format... Control the format for the copy and paste functions. 

 Data – this allows copy/paste of data in its LabSpec 5 format, which includes 

both the actual data and its ‘type’ designation.  Common data types within 

LabSpec 5 include “spectrum”, “map point spectrum”, “map model spectrum”, 

and “profile”.  If data is copied or pasted as “Data”, then it retains this 



 

 

 

designation.  Note that data of a certain ‘type’ can 

matching ‘type’ window.  For example, 

the “spectrum” window, and it is not possibl

spectrum” window.

LabSpec 5

 Text – this allows copy/paste of data in text format only, which includes actual 

data but excludes its ‘type’ designation

from one ‘type’ window into a

into different windows.  For example, a “map point spectrum” can be copied 

and pasted into a “spectrum” window.

 Picture –

allowing an image of the window to be pasted into other software.  If data is 

copied as a picture then it can be pasted as a picture only.

3.3. Data 

The Data menu displays a list of the first eight open data files, and allows you to open a full list of all 

data files, and to view and edit parameters relating to the spatial/spectral/intensity range of the 

currently active data. 

 

 

 

 

3.3.1. Selecting Data 

An open data file can be selected (activated) by 

clicking on the file name displayed in the 

menu.  

 

 

If more than eight data files are open

list can be displayed by clicking on “Data list...”.  

Click on the file name to select (activate) the file.

The data list will automatically close once the 

chosen file has been selected. 

 

Data files can also be selected by clicking on 

coloured radio button in the data bar (see 
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designation.  Note that data of a certain ‘type’ can only

‘type’ window.  For example, “spectrum” data can only be pasted into 

the “spectrum” window, and it is not possible to paste it 

” window.  “Data” copy/paste functions are intended to be used within 

LabSpec 5 only. 

this allows copy/paste of data in text format only, which includes actual 

data but excludes its ‘type’ designation.  In this case, it is possible to paste data 

from one ‘type’ window into another, and is a useful method to transfer data 

into different windows.  For example, a “map point spectrum” can be copied 

and pasted into a “spectrum” window. 

– this allows a screen capture of the currently active window, thus 

allowing an image of the window to be pasted into other software.  If data is 

copied as a picture then it can be pasted as a picture only. 

menu displays a list of the first eight open data files, and allows you to open a full list of all 

data files, and to view and edit parameters relating to the spatial/spectral/intensity range of the 

An open data file can be selected (activated) by 

clicking on the file name displayed in the Data 

If more than eight data files are open then the full 

list can be displayed by clicking on “Data list...”.  

lick on the file name to select (activate) the file.  

The data list will automatically close once the 

Data files can also be selected by clicking on 

coloured radio button in the data bar (see section 
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data files, and to view and edit parameters relating to the spatial/spectral/intensity range of the 
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6, page 196), or by using the SHIFT+click function 

on the spectrum in the spectrum display window. 

3.3.2. Data Range 

 

 

 

 

Clicking on Data > Data range... opens the “Data range” dialog window, which displays information 

about the number of data points and maximum and minimum values for the active data.  Typical 

information includes maximum and minimum values for the spectrum axis, intensity axis, XYZ spatial 

axes, and colors.  The exact categories which are displayed depend on the specific ‘type’ of the 

selected data. 

3.3.2.1. Data Range Information 

The “Data range” dialog window shows the following information: 

Axis Identification of the axis type (see section 3.3.2.2, page 20). 

Size Number of data points within the axis. 

From / To The end limit values (‘start’ and ‘stop’) for the axis. 

Unit The units associated with the axis. 

Label The display label for the axis.  Note that default labels (such as “Raman shift 

(cm
-1

)” for the X axis of a spectrum) are not displayed. 

3.3.2.2. Data Range Axes 

The “Data range” dialog window shows information about the following data axes: 

Spectrum axis (S) 

This will be displayed for spectral data, showing the information for the Raman shift (cm
-1

) or 

wavelength (nm) axis. 

Intensity axis (I) 

This will be displayed for spectral data, Raman XYZ maps/slices/profiles and optical images, showing 

the information regarding the intensity axis.  The units will be counts (cnt) or counts per second 

(cnt/sec) for spectra and Raman XYZ maps/slices/profiles, and arbitrary units (a.u.) for optical images. 
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Spatial axes (X, Y and Z) 

These will be displayed for Raman XYZ maps/slices/profiles, and optical images, with units of 

micrometers (µm). 

Colors (C) 

These will be displayed for optical images only, and shows the number of colors associated with the 

image.  Typically there will be three colors (red, green and blue) for the image. 

3.3.2.3. Data Range Functions 

Scale Allows the axis scale to be modified (for example, shifted in position, or 

stretched/compressed).  To use this function, manually adjust the figures in the 

“From” and “To” boxes, and then click [Scale].  The axis will be scaled using 

the new “From” and “To” values.  This function can be used to shift a spectrum 

to higher or lower Raman shift (cm
-1

) or wavelength (nm) position.  In this case, 

ensure that the “From” and “To” values are adjusted by exactly the same 

amount; otherwise the spectrum will be stretched or compressed. 

Extract Truncates the data file by deleting all data outside the “From” and “To” values. 

To use this function, manually adjust the figures in the “From” and “To” boxes, 

and then click [Extract].  This function can be used in conjunction with [Get] 

(see below) to extract just the currently displayed data. 

Get Updates the Data Range values according to the current display in the active 

spectrum/map/image window.  To use this function click [Get] to refresh the 

Data Range window with the current display values.  This function can be used 

in conjunction with [Extract] (see above) to extract just the currently displayed 

data.  For example, use the Zoom tool (see section 5.5, page 169) to select the 

desired data range, and then click on [Get] and then [Extract]. 

Label Re-labels the data axes according to the values set in the “Label” boxes.  Note 

that default labels (such as “Raman shift (cm
-1

)” for a spectrum X axis) are not 

displayed in the “Label” boxes.  To use this function type the desired axis label 

in the relevant “Label” box and then click on [Label]. 

Resize... Modifies the number of data points for an axis.  For example, the “Resize...” 

function allows a spectrum of 1024 data points to be reduced to 512, or an 

image of 100 x 100 data points to be increased to 150 x 150. 

To use this function manually modify the number of data points in the “Size” 

box, and then click on [Resize...].   

 

 

 

Two functions are available for “Resize...”. 
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Polynom – fits a polynomial curve through a number of adjacent pixels, and 

calculates the required new data points based on this curve.  The degree of the 

polynomial and the number of adjacent pixels can be selected from the “Poly 

degree” and “Pixel number” drop down boxes. 

Bin – co-adds a specified number of adjacent pixels.  The binning factor can be 

selected from the drop down box – this indicates the number of adjacent pixels 

which will be co-added.  For example, binning factor=2 indicates that every two 

pixels will be binned (i.e., 1+2, 3+4, 5+6...). 

3.4. Options 

The Options menu allows control of a number of optional functions within LabSpec.  Note that many 

items in the Options menu will only be visible if they have been specifically activated, and hence the 

visible menu may vary from that shown below. 

 

3.4.1. Unit 

Hovering the mouse over Options > Unit a new menu will be displayed, allowing you to select the 

units for the spectrum and intensity axes.  A tick indicates which option is currently selected and 

active. 

 

 

 

Spectrum (X axis) units 

Intensity (Y axis) units 

Conversion options 
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3.4.1.1. Spectrum (X axis) Units 

nm Nanometers (nm) 

1/cm Raman shift (cm
-1

) – energy (in wavenumbers, cm
-1

) relative to the laser line 

eV Electron volts (eV) 

1/cm abs Absolute wavenumbers (cm
-1

) – absolute energy (cm
-1

 = 10
7
/nm) 

THz Terahertz frequency (THz) – (THz = 0.03cm
-1

) 

kbar Kilobar (kbar) [Only visible if “Pressure units (custom units)” module is active 

within LabSpec] 

5U Position of user defined custom units – the unit name (e.g., 5U) will be 

displayed as set by the user.  [Only visible if “Pressure units (custom units)” 

module is active within LabSpec] 

3.4.1.2. Intensity (Y axis) Units 

cnt Counts 

cnt/sec Counts per second 

3.4.1.3. Conversion Options 

Convert Click on “Convert” to convert the relevant axis to the selected units. 

Auto Convert When “Auto Convert” is ticked the units for the relevant axis are automatically 

converted when the units are modified. 

3.4.2. Multi 

The “Multi” function allows batch processing of open data files. 

If “Multi” is ticked then when a data processing function (e.g., smoothing or peak searching) is started 

it will be applied to all data files open within the active window.   

If “Multi” is used in conjunction with File > Save As, then all of the data within the active window will be 

saved sequentially. The files will be saved in the order they are presented within the Data Bar (see 

section 6, page 196) or Data List (see section 3.3, page 19). 

3.4.3. Pressure Unit 

The “Pressure Unit” dialog window allows control of the formulae used to convert data into pressure 

units (such as kilobar, kbar).  The dialog window and its use is identical to the “Custom Unit” dialog 

window, which is described in section 3.4.4, page 24. 
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3.4.4. Custom Unit 

The “Custom Unit” dialog window allows specific spectral (X axis) units to be defined and used.  Click 

on “Custom Unit” to open the following window, which includes a number of sections: 

 

 

 

 

 

 

 

Custom units are defined by inserting an appropriate mathematical formula to convert from standard 

units (of nanometers, nm, or counts, cnt).  In the example shown in the above image, the custom units 

5U are calculated as 5U = x * 5, where x is nm.  The reverse conversion is also shown, so that 

nm = x / 5, where x is now 5U. 

3.4.4.1. Defining Custom Units 

In order to define custom units it is necessary to have mathematical formulae which relate the custom 

unit to standard units (of nanometers, nm, or counts, cnt).  Formulae are required which convert (a) 

the standard unit to custom unit, and (b) the custom unit to standard unit. 

The following example of converting nanometers (nm) to kilo electron volts (keV) will illustrate the 

principles of creating custom units. 

The formula for converting nanometers (nm) to kilo electron volts (keV) is: keV = 1240 / (nm * 1000) 

The formula for converting kilo electron volts (keV) to nanometers (nm) is: nm = 1240 / (keV * 1000) 

 

 

 

 

 

 

 

 

 

Constants A, B, C and D 

Conversion formula of custom unit to standard unit (nm or cnt) 

and vice versa 

Label and name for specified custom unit 

Set constant values for A 

and B 

Choose the standard unit 

(in this case nanometers 

“nm”) from the drop down 

box, and type in the 

formula to convert from 

keV to nm. 

Specify the custom unit 

(which will be displayed in 

Options > Unit) as “keV” 

and type in the formula to 

convert from nm to keV 

Type in the “Label” which 

will be used as the axis 

label for the custom unit, 

and the “Name” for this 

specific custom unit 

configuration. 
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The configuration can be saved (as a .ini file) by clicking on [Save], and previously saved 

configurations can be opened by clicking on [Load]. 

3.4.5. Profiles... 

The “Profiles...” module allows individual user accounts to be set up, so that personal settings and the 

user’s last used instrument configuration can be restored.  If desired, it can configured to prompt for a 

user name and password when the software is opened. 

Please note that “Profiles...” is not intended to be a software security module, but rather a method of 

maintaining ease of use in a multi-user environment.  The module allows each user to have LabSpec 

configured in a different way – in addition, it can be used to prevent confusion with 

acquisition/analysis settings, by ensuring that all settings are restored to the user’s preferred values. 

 

Log-in User Name and Password 

Each user has an individual log-in user name and password 

User Level 

Three user levels are available:  (1) administrator, (2) operator and (3) guest.  

o “Administrator” has full control of the software and system.   

o “Operator” cannot modify instrument parameters (such as laser wavelength, confocal hole, 

slit etc) but can control acquisition time and number of accumulations, and has full access to 

data processing functions.  

o “Guest” has full control of the software and system, but is intended for one-off guest users 

who do not have their own user name and password. 

Profile name 

Each user can have multiple profiles associated with his/her account.  This allows the user to choose 

a specific preferred configuration at log-in. 

 

Log-in user name and password 

User level 

Profile name 

Options 
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Options 

The options set how the “Profiles...” module operates.  Note that the displayed settings are used for 

all users; they are not saved individually as part of the user’s profile. 

o Load profile at start up – when this box is ticked user log-in is required when the software is 

opened.  If this option is not active, then users can log-in via Options > Profiles... 

o Include instrument set up – when this box is ticked the instrument settings (such as laser, 

confocal hole, slit, spectrometer position etc) will be saved as part of the user’s profiles.  

This function ensures that a user will see either his/her preferred instrument configuration, or 

the instrument configuration that (s)he last used. 

o Save configuration on exit – when this box is ticked the instrument and software 

configuration will be automatically saved when the software is closed.  This means that 

when the user logs in again, the instrument and software will be restored to his/her last used 

configuration. 

o Allow program restart – when this box is ticked, the software is permitted to close and re-

open when a new user profile is selected via Options > Profiles...  In this way it is possible to 

apply the user’s desired instrument and software configuration. 

3.4.5.1. User Log-in 

3.4.5.1.1. Log-in At Start of LabSpec 

If the “Load profile at start up” is ticked (see 3.4.5, 

page 25) a window will appear prompting for 

“Login” and “Password” when LabSpec is started.  

Type in the correct log-in user name and 

password, and then select the desired profile from 

the drop down box.  

Click [Load] to apply the profile. 

Click [Skip] to access LabSpec at an “Operator” 

level, without having to log-in.  Note that an 

“Operator” cannot modify instrument parameters 

(such as laser wavelength, confocal hole, slit etc) 

but can control acquisition time and number of 

accumulations, and has full access to data 

processing functions. 
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3.4.5.1.2. Log-in During a LabSpec Session 

If the “Load profile at start up” is not ticked, or if 

you wish to change profile during a LabSpec 

session use Options > Profiles... Type in the 

correct log-in user name and password, and then 

select the desired profile from the “Name” drop 

down box.  

Click [Load] to apply the profile. 

Note that if “Allow program restart” is ticked (see 

section 3.4.5, page 25) then LabSpec will be 

closed and re-started automatically. 

 

3.4.5.2. Creating a New User Profile 

New user profiles are created in the Profiles 

window (Options > Profiles...), by specifying the 

user name, password, level and profile name(s).  

The new user profile will be created when you next 

exit LabSpec.  

“Login” User Name 

Type in the new “Login” user name. 

Password 

Type in a password in the “Password” box. 

Profile “Name” 

Type in a name for this specific profile into the 

“Name” drop down box.  Each user can specify 

multiple profiles activated with a single “Login” user 

name and password. 

Level 

Select the appropriate user level from the “Level” 

drop down box. 

Three user levels are available:  (1) administrator, 

(2) operator and (3) guest.  

o “Administrator” has full control of the 

software and system.   

o “Operator” cannot modify instrument 

parameters (such as laser wavelength, 

confocal hole, slit etc) but can control 

acquisition time and number of 
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accumulations, and has full access to 

data processing functions.  

o “Guest” has full control of the software 

and system, but is intended for one-off 

guest users who do not have their own 

user name and password. 

Options 

Note that the Profile “Options” (see section 3.4.5, 

page 25) are universally applied for all users, and 

cannot be independently set for each user. 

3.4.5.3. Changing a User Profile Password 

To change an existing password, select Options > 

Profiles..., and type in your “login” user name and 

“password”.  Type the new password into the “New 

Password” box.  If the “New Password” box is 

greyed out and inactive, tick the box to the right 

hand side to activate it. 

Click [OK] to register the new password.  This 

password will be active from the next log-in. 

 

 

 

3.4.5.4. Using Multiple Profiles With a Single User 

Each user can save multiple profiles activated with 

a single “Login” user name and password. 

3.4.5.4.1. Creating a New Profile Name 

In Options > Profiles... log-in with your “Login” user 

name and password.  

In the “Name” drop down box type in the desired 

name for the new profile and click [OK] to register 

the new profile name.  The new profile will be 

created and saved when you next exit LabSpec. 
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3.4.5.4.2. Deleting a Profile Name 

In Options > Profiles... log-in with your “Login” user 

name and password. 

In the “Name” drop down box select the name of 

the profile you wish to delete, and then click on the 

blue ‘down arrow’ to move the selected profile 

name to the trash bin. 

Click [OK] to exit the Profiles... dialog window. 

Note that deleted profiles are always available to 

be restored to active use.  See Restoring a Deleted 

Profile Name below. 

3.4.5.4.3. Restoring a Deleted Profile Name 

In Options > Profiles... log-in with your “Login” user 

name and password.  

In the trash can drop down box select the name of 

the profile you wish to restore, and then click on 

the blue ‘up arrow’ to restore the deleted profile 

name to the active “Name” drop down box. 

Click [OK] to exit the Profiles... dialog window. 

 

 

 

3.4.6. Template 

The “Template” module allows you to save a specific instrument configuration and measurement set 

up as a template.  The template can be recalled and applied as required.  Templates are useful when 

you wish to measure a number of sample types, each of which requires a specific measurement 

configuration.  In this case, a number of templates can be set up allowing you to quickly recall the 

desired configuration without needing to set each parameter individually. 

To learn more about the various options shown in the template dialog window please consult the 

relevant section of this manual. 

Enhanced template control is provided through the LabAssistant menu (see section 3.8, page 76), 

and it is recommended that the LabAssistant function is used in preference to Options > Template. 
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3.4.6.1. Using Templates 

Open the “Template” dialog window by clicking on 

Options > Template. 

In the “Template” dialog window set up the 

instrument and measurement configuration as 

required.  Note that all modules and accessories 

active on the system will be visible within the 

“Template” window.  Depending on your instrument 

configuration the “Template” window you see may 

vary from that shown here. 

Click on [Current] to import the current instrument 

configuration and measurement set up into the 

Template. 

Click [Save] and [Load] to save and open 

template files (.tpl format) respectively.  Standard 

Windows save and open dialog windows will be 

displayed. 

Click [Apply] to apply the current template – 

motorized hardware changes will be made 

automatically; manual hardware changes will 

prompt for you to change the hardware. 

3.5. Acquisition 

The Acquisition menu allows control of a number of functions which relate to data acquisition. 

 

3.5.1. Custom Info 

The “Custom info” module allows you to add specific information and metadata to a data file.  

LabSpec 5 automatically saves hardware and measurement related information to an information 

shell for each data file, which is accessed the “Information” icon (  / ) or <CTRL>+I (see section 



 

 

 

4.4.5, page 92).  With “Custom info” you can add further information about the sample and 

measurement. 

3.5.1.1. Adding Information to the Custom Info Window

Open the “Custom info” dialog window by clicking 

on Acquisition > Custom info. 

When the “Custom info” window is 

will show the default categories for “Date”

“Operator”, “Sample”, “Remark” and “Power”.

Left click in the desired “value” box and insert the 

relevant text.  Add information for each category as 

required. 

Tick the “Open Dialog, when data acquisition 

started” box if you want the “Custom info” wind

to automatically open at the start of each 

measurement.  This can be useful to prevent you 

forgetting to add custom information to each data 

file. 

3.5.1.2. Adding New Categories to the Custom Info Window

Additional categories can be added by right 

clicking on one of the category name boxes and 

selecting “Insert row”. 

 

 

 

A new row will be inserted above the selected 

position, and will display the same name as the 

original category.  

 

 

 

Double click on the category name box to allow the 

name to be edited.  Type in the desired category 

name. 
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Adding Information to the Custom Info Window 

Open the “Custom info” dialog window by clicking 

When the “Custom info” window is first opened it 

will show the default categories for “Date”, 

“Operator”, “Sample”, “Remark” and “Power”.  

Left click in the desired “value” box and insert the 

for each category as 

Tick the “Open Dialog, when data acquisition 

started” box if you want the “Custom info” window 

to automatically open at the start of each 

measurement.  This can be useful to prevent you 

forgetting to add custom information to each data 

Adding New Categories to the Custom Info Window 

ditional categories can be added by right 

one of the category name boxes and 

A new row will be inserted above the selected 

position, and will display the same name as the 

Double click on the category name box to allow the 

name to be edited.  Type in the desired category 
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Click on any other category box to register the new name.

 

 

 

 

 

3.5.1.3. Deleting Categories from the Custom Info Window

Categories can be deleted by right clicking on the 

category name boxes which is to be deleted and 

selecting “Remove row”. 

 

 

 

The category will be deleted from the Custom Info 

window. 

 

 

 

 

3.5.2. Trigger 

The “Trigger” dialog window allows you to configure manual trigger prompts which can be set to 

appear before an acquisition.  Manual triggers are useful if you wish to start a measurement at a 

specific point in time, or if you wish to acquire an array of data manually.  Once the trigger prompt 

[OK] is clicked then the measurement will start.

The window shows the trigger prompt 

section 3.5.2.1, page 33), and a “Sample” trigger (see

ticked, then the trigger will be active, and a prompt window will be displayed before the acquisition.
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ry box to register the new name. 

Deleting Categories from the Custom Info Window 

Categories can be deleted by right clicking on the 

category name boxes which is to be deleted and 

The category will be deleted from the Custom Info 

allows you to configure manual trigger prompts which can be set to 

Manual triggers are useful if you wish to start a measurement at a 

specific point in time, or if you wish to acquire an array of data manually.  Once the trigger prompt 

is clicked then the measurement will start. 

The window shows the trigger prompt message which will be displayed for a “Start” trigger (see

), and a “Sample” trigger (see section 3.5.2.2, page 33).  

ticked, then the trigger will be active, and a prompt window will be displayed before the acquisition.
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Manual triggers are useful if you wish to start a measurement at a 

specific point in time, or if you wish to acquire an array of data manually.  Once the trigger prompt 

message which will be displayed for a “Start” trigger (see 

).  If the “Use” box is 

ticked, then the trigger will be active, and a prompt window will be displayed before the acquisition. 
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3.5.2.1. Trigger “Start” 

The trigger “start” message will be displayed at the 

start of a complete acquisition.  In this case, a 

complete acquisition means acquisition of a single  

spectrum (  / ; see section 4.5.3, page 96) or 

multidimensional spectral array (  / ; see 

section 4.5.4, page 96) such as a profile (e.g., 

depth, time, temperature, time) or map (XYZ). 

Click [OK] to start the measurement, or [Cancel] 

to abort the measurement. 

3.5.2.2. Trigger “Sample” 

The trigger “sample” message will be displayed at 

each measurement point in a spectrum array 

acquisition, such as a profile (e.g., depth, line, 

temperature, time) or map (e.g., XYZ).  In addition, 

the “sample” message will be displayed before 

each window acquisition in an extended range 

measurement. 

This function can be useful to allow manual 

focussing before each measurement point in an 

array acquisition. 

Click [OK] to start the measurement, or [Cancel] 

to abort the measurement. 

3.5.3. RTD 

The “Real Time Display, RTD” dialog window allows you to control the two dimensional real time read 

out configuration of the CCD array detector – it is typically only used for diagnostic and maintenance 

purposes.  Real time display of the CCD detector is activated using the  /  icon. 

 

 

 

 

 

Image binning X 

Select an appropriate binning factor from the drop down box for the X dimension of the CCD image. 
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Image binning Y 

Select an appropriate binning factor from the drop down box for the Y dimension of the CCD image. 

Readout zone 

Select “Full” to read out the entire CCD array, or select “Spectrum” or “Image” to read out from the 

CCD zone used for spectrum or image acquisition.  The “Spectrum” and “Image” read out zones are 

set in Acquisition > Detector – see section 3.5.7, page 57. 

Accumulate image 

Tick the box if you want sequential images from the CCD to be co-added to improve image quality 

and signal to noise ratio. 

Exposure time (sec) 

Set the default integration time to be used for the CCD real time display. 

3.5.4. Options 

The “Options” dialog window allows you to control a number of default settings which will be applied 

automatically for data acquisition.  Most parameters controlled in Acquisition > Options are not 

changed for every acquisition, but rather are set according to a user’s specific preferences and then 

applied to all acquisitions.  Certain items which are required to be modified for each individual 

acquisition (i.e., “Exposure time”, “Accumulation number” or “Data name”) can be quickly accessed 

through the Control Panel (see section 9, page 228). 

 

3.5.4.1. Exposure time (sec) 

This sets the exposure time (or acquisition time) in seconds for an individual spectrum acquisition.  

The value displayed and set here is identical to that displayed and set in the Control Panel – see 

section 9.9.2, page 236. 
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3.5.4.2. Accumulation number 

This sets the number of accumulations which allows multiple spectra to be averaged to improve 

spectrum quality and signal to noise ratio.  The value displayed and set here is identical to that 

displayed and set in the Control Panel – see section 9.9.3, page 236. 

3.5.4.3. Data name 

This sets the data name tag, which is a prefix which is used for every newly acquired spectrum.  In 

addition, it is used as the default file name during a File > Save As procedure.  The value displayed 

and set here is identical to that displayed and set in the Control Panel – see section 9.8, page 235. 

3.5.4.4. Photo-bleaching time 

Photo-bleaching is a process whereby high fluorescence backgrounds are reduced by interaction of 

the sample with the high intensity laser beam used for Raman analysis.  Photo-bleaching can assist in 

reducing backgrounds in a spectrum, and allowing a better quality Raman spectrum to be acquired. 

When a photo-bleaching time is set in Acquisition > Options, once a measurement is started the 

software will wait for the specified photo-bleaching time before acquiring data (according to the 

specified acquisition time and number of accumulations – see section 9.9, page 235).  This option is 

useful to have a controlled and consistent photo-bleaching time for a number of spectra. 

When using the photo-bleaching function it is advisable to check that the sample behaviour is suitable 

for this function.  Photo-bleaching depends on the fluorescence background reducing, but otherwise 

the sample must remain unchanged and chemically viable.  In some cases, a reduction in 

fluorescence background may be accompanied by laser-induced burning of the sample, which is 

apparent through a changing Raman spectrum and/or visible of signs of burning on the sample 

surface.  If this happens, then photo-bleaching cannot be used, and it is necessary first to reduce the 

laser power to prevent sample burning – this can be done by inserting a neutral density filter into the 

laser path (see section 9.2, page 228). 

The photo-bleaching ‘wait’ time will be applied before the start of a single acquisition.  Note that it will 

not be applied for the real time display (RTD) acquisition. 

o For an extended range acquisition (see section 3.5.6, page 49) the photo-bleaching ‘wait’ 

time is applied before the first spectral window only.  

o For a multidimensional spectral array acquisition (including time profiles, Z (depth) profiles, 

temperature profiles, XY maps, XZ and YZ slices, and XYZ datacubes) the photo-bleaching 

‘wait’ time is applied before each spectrum acquisition in the array. 

When the photo-bleaching function is active (i.e., 

photo-bleaching time is >0s), an indicator will be 

displayed in the Status Bar.  

3.5.4.4.1. Turning On the Photo-bleaching Function 

In Acquisition > Options set the “Photo-bleaching 

time” to be any value greater than 0s. 
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Click on [OK]. The photo-bleaching function is now 

active. 

The indicator icon is displayed in the Status Bar. 

 

3.5.4.4.2. Turning Off the Photo-bleaching Function 

In Acquisition > Options set the “Photo-bleaching 

time” to be 0s. 

Click on [OK]. The photo-bleaching function is now 

inactive. 

The indicator icon is no longer displayed in the 

Status Bar. 

3.5.4.5. Binning Factor 

The “Binning Factor” controls the number of data points in a spectrum. 

Binning Factor = 1 (default value) 

When the “Binning Factor” is set to 1, the full number of data points is used to create the spectrum.  

Typically this will result in each spectral window having between 1000-1600 data points; the exact 

number depends on the specific configuration and set up of the Raman system. 

The default value for “Binning Factor” is 1. 

Binning Factor > 1 

When the “Binning Factor” is set to >1, the number of data points used to create a spectrum is 

reduced, by co-adding adjacent pixels on the detector.  Increasing the “Binning Factor” results in 

spectra which have less data points, and result in smaller file sizes; in addition, the spectral quality 

(e.g., signal to noise ratio) will be increased.  However, spectral resolution will be correspondingly 

reduced, which may result in detailed spectral features being lost. 

Typically using a “Binning Factor” > 1 is only suitable for specialized applications.  If in doubt, use the 

default value of 1. 

The data shown right has been acquired with 

“Binning Factor” = 1. 
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The data shown right is the same spectrum but 

acquired with “Binning Factor” = 3. 

Note how there are 3x less data points, but the 

maximum signal level is 3x higher, resulting in a 

spectrum with increased spectral quality (e.g., 

signal to noise ratio).  However, the detail of the 

spectrum (such as peak shape) is reduced. 

3.5.4.6. Accumulation Mode 

The “Accumulation Mode” sets how multiple accumulations (see section 9.9.3, page 236) are treated 

during an acquisition. 

Average 

Select “Average” from the drop down box to have multiple accumulations averaged together as they 

are displayed.  The averaging is performed post-acquisition, after data transfer from the detector to 

the PC. 

During an acquisition of multiple accumulations, the spectrum displayed on-screen represents the 

sequentially averaged data.  For example, if three accumulations are specified the data will be 

displayed sequentially: 

o Display 1: accumulation 1 

o Display 2: Average(accumulation1 + accumulation2) 

o Display 3: Average(accumulation1 + accumulation2 + accumulation3) 

Sum 

Select “Sum” from the drop down box to have multiple accumulations summed together before they 

are displayed.  The summing is performed post-acquisition, after data transfer from the detector to the 

PC. 

During an acquisition of multiple accumulations, the spectrum displayed on-screen represents the 

sequentially summed data.  For example, if three accumulations are specified the data will be 

displayed sequentially: 

o Display 1: accumulation 1 

o Display 2: Sum(accumulation1 + accumulation2) 

o Display 3: Sum(accumulation1 + accumulation2 + accumulation3) 

Detector 

Select “Detector” from the drop down box to accumulate spectra on the detector prior to data transfer 

to the PC.  This mode is only available for specific detectors. 

3.5.4.7. Spike Filter 

The “Spike Filter” is a sophisticated algorithm designed to remove random spikes (also known as 

cosmic rays) which can appear in any spectrum.  These spikes are entirely natural, and do not 

indicate a fault with your system.  Without the “Spike Filter” it is difficult to know whether an observed 

peak is real (e.g., Raman) or a spike artefact.  With the “Spike Filter” active you are assured that all 

peaks in your spectrum are real. 
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The spectrum shown to the right was acquired 

without the “Spike Filter”.  Spikes in the spectrum 

are highlighted. 

 

 

 

 

The “Spike Filter” algorithm compares multiple accumulations of a spectrum and calculates what 

peaks are real (e.g., Raman peaks) and what peaks are spikes.  It then automatically removes spikes 

from the spectrum.  The comparison method ensures that real peaks can never be incorrectly deleted. 

The spectrum shown to the right was acquired with 

the “Spike Filter” active.  This time all peaks in the 

spectrum are Raman peaks, and there are no 

spikes visible. 

 

 

 

 

3.5.4.7.1. Turning On the “Spike Filter”  

In Acquisition > Options select either “On (auto add)” or “On” from the “Spike Filter” drop down box. 

o On (auto add): this mode automatically adds an extra accumulation to your measurement.  

For example, if you specify three accumulations in the control panel (see section 9.9.3, page 

236) the actual number acquired will be four (3+1).  This mode ensures that every spectrum 

will be spike filtered, even if you only specify one accumulation (since the software will 

automatically acquire two accumulations (1+1) to enable the “Spike Filter” comparison 

algorithm). 

o On: this mode will activate the “Spike Filter” only if the number of accumulations set in the 

control panel (see section 9.9.3, page 236) is greater than 1.  So, if an acquisition is made 

with 2,3,4... accumulations, then the “Spike Filter” will be active.  If an acquisition is made 

with only 1 accumulation, then the “Spike Filter” will be inactive, and there is the possibility 

of spikes being present in your spectrum.  This mode is useful since it allows you to easily 

switch between a fast analysis mode without the “Spike Filter” (e.g., when the accumulation 

number is set to 1), and standard analysis with the “Spike Filter” (e.g., when the 

accumulation number is set to 2 or more) 

3.5.4.7.2. Turning Off the “Spike Filter”  

In Acquisition > Options select “Off” from the “Spike Filter” drop down box. 
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3.5.4.8. Autofocus 

The “Autofocus” function sets how the autofocus 

measurement.  There are three main modes o

Before acquisition 

In this mode, the autofocus procedure will be applied a single time at the start of a spectrum or 

acquisition (including time profiles, Z (depth) profiles, temperature profiles, XY maps, XZ an

slices, and XYZ datacubes). 

For example, if an XY map comprising 10 x 10 data points is to be acquired, the autofocus procedure 

will be applied once at the beginning to find the optimal focus point, and the 100 data points will then 

be acquired at the same optimal focus point.

This mode is useful when you wish to use autofocus for single spectrum acquisition, or for surface 

mapping of a flat, smooth sample.

Before each point 

In this mode, the autofocus procedure will be applied for each individual spectrum being measured in 

the acquisition.  For an array acquisition (including time profiles, Z (depth) profiles, temperature 

profiles, XY maps, XZ and YZ slices, and XYZ datacubes) this means that the autofocus will be 

performed before each point in the array.

For example, if an XY map comprising 10 x 10 data points is to be acquired, the autofocus procedure 

will be applied at each XY coordinate prior to spectrum acquisition.

This mode is useful when you wish to use autofocus for mappin

sample.  If the sample is smooth but non

see below. 

In limits point 

In this mode, the autofocus procedure will be applied at four 

surface (XY) mapping area to calc

at each measurement point to compensate for the tilt.

In the diagram below showing a

autofocus points are marked with with 

For example, if an XY map comprising 1

will be applied at the intermediate positions

acquisition starts, the focus position will be adju

by the autofocus. 

This mode is useful when you wish to use autofocus for mapping of a smooth but non

sample. 

LabSpec 5

 

The “Autofocus” function sets how the autofocus operation (see section 3.5.8, page 

There are three main modes of operation: 

In this mode, the autofocus procedure will be applied a single time at the start of a spectrum or 

acquisition (including time profiles, Z (depth) profiles, temperature profiles, XY maps, XZ an

For example, if an XY map comprising 10 x 10 data points is to be acquired, the autofocus procedure 

will be applied once at the beginning to find the optimal focus point, and the 100 data points will then 

be acquired at the same optimal focus point. 

This mode is useful when you wish to use autofocus for single spectrum acquisition, or for surface 

mapping of a flat, smooth sample. 

In this mode, the autofocus procedure will be applied for each individual spectrum being measured in 

array acquisition (including time profiles, Z (depth) profiles, temperature 

d YZ slices, and XYZ datacubes) this means that the autofocus will be 

performed before each point in the array. 

map comprising 10 x 10 data points is to be acquired, the autofocus procedure 

will be applied at each XY coordinate prior to spectrum acquisition. 

This mode is useful when you wish to use autofocus for mapping of a rough and/or non

f the sample is smooth but non-flat (tilted) then the “In limits point” mode is recommended 

In this mode, the autofocus procedure will be applied at four intermediate positions in 

surface (XY) mapping area to calculate the tilt of the sample.  The focus position will then be adjusted 

at each measurement point to compensate for the tilt. 

In the diagram below showing a surface (XY) mapping area the intermediate “In

autofocus points are marked with with “+”. 

 

mple, if an XY map comprising 10 x 10 data points is to be acquired, the autofocus procedure 

intermediate positions of the map area prior to the mapping.  When the map 

acquisition starts, the focus position will be adjusted at each point, based on the tilt plane calculated 

This mode is useful when you wish to use autofocus for mapping of a smooth but non
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, page 59) is applied to a 

In this mode, the autofocus procedure will be applied a single time at the start of a spectrum or array 

acquisition (including time profiles, Z (depth) profiles, temperature profiles, XY maps, XZ and YZ 

For example, if an XY map comprising 10 x 10 data points is to be acquired, the autofocus procedure 

will be applied once at the beginning to find the optimal focus point, and the 100 data points will then 

This mode is useful when you wish to use autofocus for single spectrum acquisition, or for surface 

In this mode, the autofocus procedure will be applied for each individual spectrum being measured in 

array acquisition (including time profiles, Z (depth) profiles, temperature 

d YZ slices, and XYZ datacubes) this means that the autofocus will be 

map comprising 10 x 10 data points is to be acquired, the autofocus procedure 

g of a rough and/or non-flat (tilted) 

flat (tilted) then the “In limits point” mode is recommended – 

intermediate positions in a rectangular 

ulate the tilt of the sample.  The focus position will then be adjusted 

pping area the intermediate “In-limits point” 

data points is to be acquired, the autofocus procedure 

of the map area prior to the mapping.  When the map 

sted at each point, based on the tilt plane calculated 

This mode is useful when you wish to use autofocus for mapping of a smooth but non-flat (tilted) 
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3.5.4.8.1. Turning On Autofocus 

In Acquisition > Options select either “Before 

acquisition”, “Before each point” or “In limits point” 

from the “Autofocus” drop down box. 

Click [OK].  Autofocus is now active. 

The Autofocus indicator icon is displayed in the 

Status Bar. 

3.5.4.8.2. Setting the Autofocus Offset 

Depending on the exact Autofocus mode being used (see section 3.5.8, page 59) the focus position 

located by the autofocus procedure may correspond to a visual focus of the sample, which is not 

always the position giving a maximum Raman signal. 

In this case, it is possible to set a Z-axis offset, which will be applied after the autofocus position has 

been located.  A negative offset means that the focus will be moved upwards (e.g., analysis will be 

made higher in the sample than the autofocus position); a positive offset means that the focus will be 

moved downwards (e.g., analysis will be made lower in the sample than the autofocus position). 

The offset is also useful if you wish to do mapping inside a sample at a fixed position below the 

surface.  The autofocus procedure (depending on the exact mode being used – see section 3.5.8, 

page 59) will locate the surface of the sample, and the positive offset will then be applied to move to a 

specified position below the surface. 

3.5.4.8.3. Turning Off Autofocus 

In Acquisition > Options select “Off” from the 

“Autofocus” drop down box. 

Click [OK].  Autofocus is now inactive. 

The Autofocus indicator icon is no longer displayed 

in the Status Bar. 

3.5.4.9. Scanning Device 

The “Scanning Device” function sets what device is used for Y axis movement in multidimensional 

spectral array measurements (such as XY surface maps, or YZ depth slices). 

The default mode is “Stage” which uses the motorized sample XY stage to move the sample in both X 

and Y dimensions. 

On systems which are equipped with the confocal LineScan mirror scanning hardware it is also 

possible to use the LineScan to acquire data in the Y axis.  In this case select “Scanner” to disable the 

XY motorized stage for Y axis movement during the measurement, and to use the LineScan mirror. 
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3.5.4.10. Use Detector 

The “Use detector” function sets how multiple detectors are used during a measurement. If your 

Raman system is equipped with a single detector only, then this option will be set to “Active” and will 

be greyed out. 

3.5.4.10.1. Setting the Use Detector Mode 

In Acquisition > Options select either “Active” or “Both” from the “Use Detector” drop down box. 

Active 

In this mode data will only be acquired from the active detector.  The active detector is selected from 

the status bar (see section 7.3.2, page 202). 

Both 

In this mode it is possible to acquire data from two detectors simultaneously, but this only applies to 

very specific configurations.  For most standard systems, it is only ever possible to acquire data from 

the active detector. 

3.5.4.11. Signal Mode 

The “Signal Mode” function controls whether a ‘dark’ subtract procedure is implemented automatically 

during a spectrum acquisition. 

Some detectors (e.g., the InGaAs near infra-red array detector) have a significant fixed pattern 

artefact signal which can dominate the spectrum acquired from a sample with low signal level.  In this 

case, it is possible to acquire a ‘dark’ spectrum (e.g., a spectrum acquired with a shutter in front of the 

detector, so that no sample signal is observed) which corresponds to the fixed pattern signal only.  By 

performing a ‘dark’ subtract (e.g., subtract the ‘dark’ spectrum from the sample spectrum) significant 

improvement in spectrum quality can be realised. 

3.5.4.11.1. Setting the Signal Mode 

In Acquisition > Options select either “Signal”, “Dark”, “Signal-Dark” or “Signal-Dark (always)” from the 

“Signal Mode” drop down box.  These choices what type of spectrum is acquired from the detector. 

Signal 

In this mode, the sample spectrum (detector shutter open) will be acquired and displayed on screen. 

Dark 

In this mode, the ‘dark’ spectrum (detector shutter closed) will be acquired and displayed on screen.  

Note that in this mode you will not see a spectrum corresponding to your sample. 

Signal-Dark 

In this mode, the ‘dark’ spectrum (detector shutter closed) will be automatically subtracted from the 

sample spectrum (detector shutter open).  The ‘dark’ spectrum will be acquired first, followed by the 

sample spectrum. 

The ‘dark’ spectrum will be acquired with identical acquisition settings as the sample spectrum – for 

example, if the acquisition is set for two accumulations of 30s each, then the ‘dark’ spectrum will also 
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be acquired with two accumulations of 30s each.  As a result, the total acquisition time will be 

doubled. 

In the case of an extended range spectrum acquisition the ‘dark’ spectrum will be acquired once at 

the start of the extended range acquisition only, and then subtracted from each spectral window.  In 

the case of an array acquisition (including time profiles, Z (depth) profiles, temperature profiles, XY 

maps, XZ and YZ slices, and XYZ datacubes), the ‘dark’ spectrum will be acquired once at the start of 

the acquisition only, and then subtracted from the spectrum acquired at each measurement point. 

This mode is useful when the ‘dark’ spectrum is constant, and is not expected to change between 

measurements. 

Signal-Dark (always) 

This mode is similar to “Signal-Dark” discussed above.  However, in this case, the ‘dark’ spectrum is 

acquired before each and every readout from the detector. 

In the case of an extended range spectrum acquisition the ‘dark’ spectrum will be acquired for each 

spectral window and subtracted from the sample spectrum.  In the case of an array acquisition 

(including time profiles, Z (depth) profiles, temperature profiles, XY maps, XZ and YZ slices, and XYZ 

datacubes), the ‘dark’ spectrum will be acquired and subtracted at each measurement point. 

This mode is useful when the ‘dark’ spectrum is expected to vary between measurements. 

3.5.4.12. Autoexposure 

The Auto Exposure function sets whether the auto exposure operation (see section 3.5.10, page 65) 

is applied to a measurement. 

3.5.4.12.1. Turning Auto Exposure On 

In Acquisition > Options select “On” from the 

“Autoexposure” drop down box. 

When Auto Exposure is active, the Acquisition 

Time section in the Control Panel is set to “Auto” 

and greyed out. 

 

3.5.4.12.2. Turning Auto Exposure Off 

In Acquisition > Options select “Off” from the “Autoexposure” drop down box. 

3.5.4.12.3. Setting Up the Auto Exposure 

In Acquisition > Options click on [Set] in the “Autoexposure” section.  See section 3.5.10, page 65, to 

learn how the Auto Exposure function can be configured. 
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3.5.4.13. Shutter Mode 

The “Shutter Mode” function sets the operation of the detector shutter during an acquisition. 

3.5.4.13.1. Setting the Shutter Mode 

In Acquisition > Options select  “Auto”, “Open” or “Closed” from the “Shutter Mode” drop down box. 

Auto 

In this mode, the shutter operation is set automatically by LabSpec 5.  Typically this means that for 

standard spectrum and array acquisition the shutter will be opened during spectrum acquisition, and 

closed during detector readout and other system processes (such as moving the sample stage, or 

spectrometer grating).  For ultra-fast SWIFT™ mapping (see 4.5.5, page 97) the shutter is opened at 

the start of the acquisition, and then kept open throughout the acquisition.  It is closed only once the 

final spectrum has been acquired. 

Open 

In this mode, the shutter will be kept open throughout an acquisition.  For example, for an extended 

range spectrum acquisition (see section 3.5.6, page 49) the shutter will be opened prior to acquisition 

of the first spectral window, and will be kept open throughout the acquisition.  It is closed only once 

the final spectral window has been acquired. 

Closed 

In this mode, the shutter will be kept closed throughout an acquisition – it can be used to monitor the 

inherent background ‘dark’ response of the detector.  This mode can be used to assess the spectrum 

of a detector without any light.  Note that in this mode you will not see a spectrum corresponding to 

your sample. 

3.5.4.14. Intensity Correction 

The LabSpec 5 intensity correction algorithm allows true comparison of spectra acquired using 

different laser wavelengths and optics. Without intensity correction, spectra acquired using different 

laser wavelengths and optics can show significant differences in relative peak intensities.  These 

differences are caused by varying performance of the instrument components (including microscope 

objectives, laser rejection filters, diffraction gratings and CCD detectors) at different wavelengths. 

The spectrum shown right for 4-acetyl salicylic acid 

was acquired using a 785 nm near infra-red laser.  

In this case the CCD detector sensitivity decreases 

as the Raman shift increases.  Thus peak 

intensities at high Raman shift positions are 

observed to be significantly weaker than they really 

are.  The observed spectrum is not correct, since it 

is perturbed by instrumental factors. 
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By applying the “HORIBA ICS” intensity correction 

factor the perturbed Raman spectrum peak 

intensities can be restored, as illustrated in the 

corrected spectra shown right. 

 

 

 

3.5.4.14.1. How is the “HORIBA ICS” Correction Factor Calculated? 

The “HORIBA ICS” intensity correction factor is created individually for each instrument at the time of 

manufacture. 

The output from a calibrated white light source is passed through the system, and the recorded 

“response” spectrum is compared with the calibrated “source” spectrum of the white light source. The 

correction factor is calculated as 

correction = [source] / [response] 

The obtained correction factor is a multiplicative factor, which means that each spectrum acquired is 

multiplied by the correction factor to yield the corrected spectrum. 

A correction factor is created for each and every pairing of laser wavelength and diffraction grating 

available on the instrument (e.g., 532nm-600gr/mm; 532nm-1800gr/mm; 633nm-600gr/mm;  

633nm-1800gr/mm etc). When the automatic intensity correction is activated, the software 

automatically applies the appropriate correction factor based on the active laser wavelength and 

diffraction grating pair. 

In the event that there are multiple laser rejection filters for a single laser wavelength configured on a 

LabRAM HR system (e.g., one notch filter and one edge filter for 633nm) the software cannot 

automatically detect which filter is in place.  In this case, the specific laser filter must be selected from 

Setup > ICS Filters before the acquisition is made – see section 3.7.3, page 75, for further 

information. 

3.5.4.14.2. Turning On the Automatic Intensity Correction 

In Acquisition > Options, select “HORIBA ICS” 

from the “Intensity Correction” drop down box. 

Click [OK].  Intensity Correction is now active, and 

will be applied to all acquired data. 

The Intensity Correction indicator icon is displayed 

in the Status Bar. 

If multiple injection/rejection or photoluminescence 

(PL) filters have been set up for a single laser 

wavelength ensure the correct filter is selected 
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from the ICS Filters dialog window, by clicking on 

Setup > ICS Filters. 

Note that an intensity correction factor must have 

been created for the specified laser wavelength 

and diffraction grating pair, otherwise an error 

message similar to that shown right will be 

displayed when an acquisition is started.  Click on 

[OK] or [Cancel] to clear the message, and start 

the acquisition.  Remember that in this case the 

spectrum will be uncorrected.  The error message 

will only be shown once during a LabSpec session 

– if LabSpec is closed and then re-opened, the 

message will be displayed again if intensity 

correction is activated when no intensity correction 

factor has been created. 

3.5.4.14.3. Turning Off the Automatic Intensity Correction 

In Acquisition > Options, select “Off” from the 

“Intensity Correction” drop down box. 

Click [OK].  Intensity Correction is now inactive. 

The Intensity Correction indicator icon is no longer 

displayed in the Status Bar. 

3.5.4.14.4. Applying Post-acquisition Intensity Correction 

Ensure that the correct laser wavelength and 

diffraction grating pair are selected in the Control 

Panel. 

If multiple injection/rejection or photoluminescence 

(PL) filters have been set up for a single laser 

wavelength ensure the correct filter is selected 

from the ICS Filters dialog window, by clicking on 

Setup > ICS Filters. 

Select the spectrum which is to have the Intensity 

Correction applied post-acquisition. 

In Acquisition > Options, select “HORIBA ICS” 

from the “Intensity Correction” drop down box. 

Click on [Correct] in the Intensity Correction 

section.  

Click [OK].  The Intensity Correction has now been 

applied to the spectrum. 
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Note that an intensity correction factor must have 

been created for the specified laser wavelength 

and diffraction grating pair, otherwise an error 

message similar to that shown right will be 

displayed when an acquisition is started.  Click on 

[OK] or [Cancel] to clear the message.  

Remember that in this case the spectrum will 

remain uncorrected.  The error message will only 

be shown once during a LabSpec session – if 

LabSpec is closed and then re-opened, the 

message will be displayed again if intensity 

correction is activated when no intensity correction 

factor has been created. 

3.5.4.15. Denoise 

The Denoise function is a unique noise reduction algorithm which can be used to significantly 

enhance spectrum quality without losing subtle spectral information.  When Denoise is activated in 

Acquisition > Options, all data acquired will be processed with the Denoise reduction – this includes 

real time display (RTD) acquisition (  /  ), spectrum acquisition (  /  ) and multidimensional 

spectral array acquisition (  /  ). 

Standard smoothing functions can result in loss of peak shape and position, and subtle features (such 

as weak shoulders on a strong band) can be lost. The Denoise function ensures that all this important 

information is retained, whilst still reducing noise in the spectrum. 

The spectra shown right illustrate the effect of the 

Denoise function. 

 

 

 

 

 

Two main Denoise algorithms are available from the “Denoise” drop down box: 

o Standard: recommended for spectra with signal to noise ≥ 20 

o Lite: recommended for very noisy spectra with signal to noise ≤ 20 

In addition, both algorithms can be used with an integrated Despike function to remove random spikes 

(also known as cosmic rays).  See also section 3.5.4.7, page 37, for more information about other 

spike filter options in LabSpec 5. 

Denoise can be applied post-acquisition using the Smoothing icon and Filtration dialog window – see 

section 4.6.4, page 125.  If a spectrum has had the Denoise function automatically applied through 

Acquisition > Options, it cannot have the function applied again through the Filtration dialog window. 
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3.5.4.15.1. Turning On the Automatic Denoise Function 

In Acquisition > Options select the desired Denoise function from the “Denoise” drop down box: 

o Standard: recommended for spectra with signal to noise ≥ 20 

o Standard + Despike:  as “Standard” but with an integrated Despike function to remove 

random spikes (also known as cosmic rays) 

o Lite: recommended for very noisy spectra with signal to noise ≤ 20 

o Lite + Despike:  as “Lite” but with an integrated Despike function to remove random spikes 

(also known as cosmic rays) 

Note that this function will be automatically applied to all data acquisition. 

3.5.4.15.2. Turning Off the Automatic Denoise Function 

In Acquisition > Options select “Off” from the “Denoise” drop down box. 

3.5.5. Auto save 

The autosave function allows data to be saved automatically when a measurement is completed.  

This function is useful to ensure that important data is immediately saved, so that there is no risk of 

loss of data caused by intervention of another user, power cut, or computer crash. 

 

 

 

 

 

 

 

Note that the autosave function can only be activated for spectrum acquisition (  /  ) and 

multidimensional spectral array acquisition (  /  ).  Real time display (RTD) data (see section 

4.5.1, page 95) will not be autosaved, even if the autosave function is activated in LabSpec 5. 

3.5.5.1. Setting the Autosave Function 

The Autosave function can be configured to automatically save data in a specific format to a specific 

location. 

Save acquired data 

If the “Save acquired data” box is ticked the Autosave function is active, and data will be automatically 

saved. 
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Auto repeat 

If the “Auto repeat” box is ticked a spectrum acquisition (  /  ) will be continuously repeated until 

the STOP icon (  /  ) is clicked.  Each spectrum displayed on the screen will be replaced by the 

next spectrum. 

If the “Save acquired data” box is also ticked each individual spectrum will be automatically saved. 

Format 

Select the file format from the drop down box which will be used to save the data.  Please see section 

3.1.1.1, page 10, for full details about available file formats. 

o LabSpec (*.ngs) – data will be saved in its inherent LabSpec 5 format.  Spectra will be 

saved as .ngs, and multidimensional spectral arrays (including time profiles, Z (depth) 

profiles, temperature profiles, XY maps, XZ and YZ slices, and XYZ datacubes) will be 

saved as .ngc. 

o Dilor (*.ms0) – data will be saved a legacy file format for Dilor Raman instruments. 

o Grams (*.spc) – data will be saved in a Grams SpectraCalc spectrum file format, compatible 

with many common spectroscopy software packages. 

o LabSpec (*.tsf) – data will be saved in the previous generation LabSpec 4 format.  Spectra 

will be saved as .tsf, and multidimensional spectral arrays (including time profiles, Z (depth) 

profiles, temperature profiles, XY maps, XZ and YZ slices, and XYZ datacubes) will be 

saved as .tvf. 

Folder 

Type in the file path (or browse using the file browse button) for the location where the data should be 

saved. 

o If the folder exists already, data will be saved inside the specified folder.  Tick the boxes for 

“Year”, “Month” and “Day” to create a new folder labelled “_YYYY_MM_DD”, which indicates 

the year (YYYY), month (MM) and day (DD) according to the computer’s clock. 

o If the folder does not already exist it will be created when the Autosave procedure is next 

performed.  If the boxes for “Year”, “Month” and “Day” are ticked, the year (YYYY), month 

(MM) and day (DD) according to the computer’s clock will be appended to the specified 

folder name (for example, “Folder_YYYY_MM_DD”). 

 

 

File 

Type in the file name for the data which is to be saved.  Tick the “Hour”, “Min” and/or “Count” boxes to 

append the hour (HH), minute (mm) and/or integer count (C) to the file name.  The count number will 

start at the number indicated in the box – to start the count at a different number type in the desired 

first number in the count box.  This number will be automatically incremented for subsequent 

autosaves. 

For example, with “Hour” and “Min” ticked, the data will be saved as “FileName_HH_mm.xxx” where 

“.xxx” indicates the specified file format. 

With “Count” ticked, the data will be saved as “FileName_C.xxx” where “.xxx” indicates the specified 

file format. 
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3.5.5.2. Turning On the Autosave Function 

In Acquisition > Autosave, tick the box for “Save 

acquired data”. 

 

 

 

 

 

3.5.5.3. Turning Off the Autosave Function 

In Acquisition > Autosave, untick the box for “Save 

acquired data”. 

 

 

 

 

 

3.5.6. Extended Range 

The Extended Range dialog window controls the spectral range which will be analysed during a 

spectrum acquisition (  /  ) or multidimensional spectral array acquisition (  /  ).  When an 

extended range is specified, the software will acquire multiple spectra and seamlessly glue them to 

give a final spectrum corresponding to the desired extended range. 
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In the description that follows the term “Spectral Range” refers to the specified extended range, and 

“Spectral Window” refers to the individual spectra which are acquired to cover the extended range. 

3.5.6.1. Extended Range Acquisition Modes 

The Extended Range module offers three main modes for spectrum acquisition. 

Single Window 

In Single Window mode, only the spectral range covered by a single CCD detector readout will be 

used.  The actual range will depend on the spectrometer position (see section 9.5, page 231), the 

laser wavelength (see section 9.1, page 228), and the diffraction grating (see section 9.6.1, page 

232).  Remember that the acquired spectrum will be centered about the current spectrometer position.  

In the example below, data has been acquired from 4-acetylsalicylic acid with the spectrometer 

centered at 1200cm
-1

 in Single Window mode. 

 

 

 

Multiwindow 

In Multiwindow mode, a user defined spectral range can be covered, with the software automatically 

adjusting the spectrometer position and capturing multiple spectral windows to cover the desired 

range.  In the example below, data has been acquired from 4-acetylsalicylic acid in the range 100-

3500cm
-1

 using the Multiwindow mode. 

-1 000 0 1 000 2 000 3 000 4 000

Raman Shift (cm-1)
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Auto scanning 

In Auto scanning mode the spectrometer is moved in a number of very small steps, allowing the 

spectrum to be slowly built up step by step.  The advantage of this method is that any pixel to pixel 

variation in response can be averaged out over the spectrum.  In the example below, data has been 

acquired from 4-acetylsalicylic acid in the range 100-3500cm
-1

 using the Autoscanning mode. 

The stacked spectra (—) show the individual spectra which are acquired, but they have been offset 

for clarity.  The blue spectrum (—) shows the final spectrum as observed by the user, which is an 

average of all the individual spectra, in the range 100-3500cm
-1

. 

-1 000 0 1 000 2 000 3 000 4 000

Raman Shift (cm-1)

Spectral 

Window 1 

Spectral 

Window 2 

Spectral 

Window 3 

Spectral 

Window 4 
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3.5.6.2. Sub-pixel Acquisition Function 

The Sub-pixel acquisition function uses the high precision, fine step size of the spectrometer drive 

mechanism to acquire spectra which are shifted by less than a whole pixel value.  The result is to 

increase the number of data points defining a band (i.e., sub-pixel = 2 results in twice the number of 

data points; sub-pixel = 3 results in three times the number etc). 

Note that this will increase the total acquisition time, and it is suggested that sub-pixel acquisition is 

only used over limited ranges. 

The sub-pixel acquisition function does not increase the spectral resolution of the spectrometer, since 

this is defined principally by the laser wavelength, spectrometer focal length, diffraction grating and 

slit.  However, the sub-pixel acquisition function is useful to give increased definition of a peak, by 

providing more data points to define that peak.  This can be beneficial when studying peak shape, or 

performing peak fitting routines. 

Sub-pixel = 1 

The data shown right has been acquired with 

sub-pixel = 1, which is the default value for 

standard acquisitions. 
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Sub-pixel = 4 

The data shown right has been acquired with 

sub-pixel = 4.  The increased number of data 

points is clearly visible. 

 

 

 

3.5.6.3. Setting the Extended Range 

From and To 

Set the beginning (“From”) and end (“To”) spectral 

positions by typing in the desired values into the 

respective boxes.  The spectral units are those 

which are displayed in the spectrometer window in 

the control panel (see section 9.5, page 231), 

and/or selected via Options > Unit (see section 

3.4.1, page 22). 

Note that multiple spectral windows can be set up 

by ticking the check boxes on the right hand side. 

Up to five spectral ranges can be defined.  Each 

spectral range can be acquired with a specific 

integration time – see Time below. 

Multiple spectral ranges can be contiguous (e.g., 

100-200, 200-500, 500-2000cm
-1

) or discrete (e.g., 

100-1500, 1750-1900, 2900-4000cm
-1

). 

For most standard measurements it is generally 

sufficient to use a single spectral range covering 

the whole range desired. 

Time 

The acquisition time for each spectral range can be 

set up in two ways. 

o Time (%) – in this mode, the time in the 

Extended Range dialog window is 

specified as a percentage (%) of the 

acquisition time set in the Control Panel 

(see section 9.9.2, page 236).  For 

example, if the Control Panel has the 

acquisition time set as 10s, then if Time 

(%) is set to 50% in the Extended Range 

dialog window, the acquisition will be 

made with 5s per spectral window. 
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o Time (s) – in this mode, the time in the 

Extended Range dialog window is 

specified directly in seconds (s).  In this 

case the time set in the Control Panel 

(see section 9.9.2, page 236) is ignored. 

Mode 

Select “Single Window”, “Multiwindow” or “Auto scanning” from the “Mode” drop down box to choose 

the desired acquisition mode for the extended range measurement.  See section 3.5.6.1, page 50, for 

a detailed explanation of these modes. 

Note that if you use “Auto scanning” it is necessary to set a larger number of accumulations in the 

Control Panel (see section 9.9.3, page 236).  Typical values for good results would be between 10 

and 50.  The larger the number of accumulations, the better the averaging will be, resulting in a higher 

spectrum quality (signal to noise). 

Sub-pixel Number 

Select the sub-pixel number from the drop down box to determine whether data acquisition will be 

made in the default manner (sub-pixel = 1), or with additional data points to enhance band definition 

(sub-pixel > 1).  See section 3.5.6.2, page 52, for a detailed explanation of this function, and how it 

affects the acquired data. 

Min Overlap (pix) 

In the Multiwindow acquisition mode each spectral window overlaps with its neighbours.  The “Min 

Overlap (pix)” allows the user to define (in pixels) the minimum overlap which must be used.  Typically 

a value of 100 is adequate for most measurements. 

Combine Data 

When “Combine Data” is ticked, the individual spectral windows will be automatically glued together to 

yield a single spectrum at the completion of the measurement. 

Spectrum acquired with “Combine Data” unticked: 

 

 

 

 

 

 

Spectrum acquired with “Combine Data” ticked:  
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-1

)

1 000 2 000 3 000

Raman Shift (cm
-1

)



LabSpec 5 user manual 

 

 

 

Page | 55  

 

 

Adjust Intensity 

During an extended range measurement, discrete spectral windows are acquired to cover the entire 

range.  As the spectrometer is moved to capture each spectral window there is a natural small drop in 

efficiency of the diffraction grating, which can result in slight changes to the baseline of each spectral 

window. When these spectral windows are glued to create the final spectrum covering the extended 

range these baseline changes can give rise to small steps in the spectrum.    

If “Adjust Intensity” is ticked, the baselines of the individual spectral windows will be adjusted prior to 

gluing, to yield a seamless final spectrum. 

Raw data, showing the individual spectral windows 

with a natural baseline shift caused by changing 

efficiency of the spectrometer’s diffraction grating. 

 

 

 

 

Combined data, with “Adjust Intensity” unticked.  

Note the step at 3030 cm
-1

. 

 

 

 

 

 

Combined data, with “Adjust Intensity” ticked.  The 

gluing between the two individual spectral windows 

is seamless. 

 

 

 

 

Return to First Window 

If “Return to First Window” is ticked, at the end of an extended range measurement the spectrometer 

will be returned to the starting position for the measurement, so that it is ready to immediately start the 

next measurement.  If “Return to First Window” is unticked, the spectrometer will remain at the 

position used for the last spectral window.  When a new measurement is started, then the 

spectrometer will move to the correct starting position for that measurement. 

2 900 3 000 3 100 3 200

Raman Shift (cm
-1

)

2 900 3 000 3 100 3 200
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-1

)

2 900 3 000 3 100 3 200

Raman Shift (cm
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The “Return to First Window” function is pa

measurements with the extended range function.  In this case it is important that the spectrometer is 

ready to immediately start the measurement at the next trigger point for the kinetic run, and thus, it 

must be at the starting position for the extended range in advance.

3.5.6.4. Turning On the Extended Range Function

In the extended range dialog window (accessed 

via Acquisition > Extended range, or the Extended 

range icon  /  ) select the desired extended 

range mode from the “Mode” drop down box.

Choose either “Multi windows” or “Auto scanning” 

to make an extended range measurement.

Set up the spectral range and other options 

(section 3.5.6.3, page 53), and click 

extended range function is now active.

 

 

 

The extended range indicator icon is displayed in 

the Status Bar. 

Note that the extended range is only available for 

full spectrum acquisition (

multidimensional spectral array

 /  ).  It is not available for real time display 

(RTD) (  / ). 

3.5.6.5. Turning Off the Extended Range Function

In the extended range dialog window (accessed 

via Acquisition > Extended range, or the Extended 

range icon  /  ) select the “Single

mode from the “Mode” drop down box.
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The “Return to First Window” function is particularly useful when making kinetic time based 

measurements with the extended range function.  In this case it is important that the spectrometer is 

ready to immediately start the measurement at the next trigger point for the kinetic run, and thus, it 

st be at the starting position for the extended range in advance. 

Turning On the Extended Range Function 

In the extended range dialog window (accessed 

ge, or the Extended 

select the desired extended 

range mode from the “Mode” drop down box. 

windows” or “Auto scanning” 

to make an extended range measurement. 

Set up the spectral range and other options 

), and click [OK].  The 

extended range function is now active. 

cator icon is displayed in 

Note that the extended range is only available for 

full spectrum acquisition (   /  ), or 

multidimensional spectral array acquisition (

available for real time display 

Off the Extended Range Function 

In the extended range dialog window (accessed 

Acquisition > Extended range, or the Extended 

select the “Single window” 

mode from the “Mode” drop down box. 
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All the options will be greyed out. 

 

 

 

 

 

 

 

 

Click [OK].  The extended range function is now 

inactive. 

The extended range indicator icon is no longer 

show in the Status Bar. 

3.5.7. Detector 

The detector window controls the configuration of the detector(s) used by the Raman system.  In 

typical use these parameters do not need to be adjusted by the user, and it is recommended that they 

are only modified when instructed to do so by a trained engineer from HORIBA Scientific or one of its 

representatives. 

 

 

 



 

 

 

 

_________________________________________________________________________________

 

CAUTION: CHANGING SETTINGS IN 

MALFUNCTION.  ON NO ACCOUNT SHOULD SETTI

INSTRUCTED TO DO SO BY A TRAINED ENGINEE

REPRESENTATIVES. 

_________________________________________________________________________________

 

Type 

Select the detector to be used from the “Sensor” drop down box 

installed on the instrument. 

Note that when multiple detectors are installed the 

active detector can also be selected using the 

detector indicator in the Status Bar (see 

7.3.2, page 202). 

Select the read out mode for the detector from the “Mode” drop down box.  For two dimensional array 

detectors (such as a CCD), the software has different read out zones (areas) configured, 

spectrum acquisition, and one for area intensity acquisition.

o Spectrum – select this mode for acquiring normal spectra

one dimensional configuration (spectral axis).

o Image – select this mode for 

dimensional configuration (spectral axis and CCD height).

 

Sizes 

The “Sizes” section controls what area of the detector is used for the “Spectrum” and “Image” modes.  

Type in the desired minimum and maximum pixel num

values in the greyed out boxes indicate the maximum pixel size of the detector in the X and Y axes.

Options 

The options visible will depend on the parti

consult a trained engineer from HORIBA Scientific or one of its representatives to find out more about 

the options available for the detectors installed on your system.

In most cases, the temperature sensor and control options will be present, and these ar

below.  

3.5.7.1. Displaying the Detector Temperature

Click on the “temperature” icon to display the 

current temperature of the detector.

 

The current temperature (in degrees celsius, 

will be displayed in the adjacent indicator box.
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_________________________________________________________________________________

HANGING SETTINGS IN THE ACQUISITION > DETECTOR WINDOW MAY R

ACCOUNT SHOULD SETTINGS IN THIS DIALOG WINDOW BE MODIFIED EX

BY A TRAINED ENGINEER FROM HORIBA SCIENTIFIC OR ONE OF 

_________________________________________________________________________________

lect the detector to be used from the “Sensor” drop down box – this list will only show the detectors 

Note that when multiple detectors are installed the 

active detector can also be selected using the 

Status Bar (see section 

Select the read out mode for the detector from the “Mode” drop down box.  For two dimensional array 

detectors (such as a CCD), the software has different read out zones (areas) configured, 

spectrum acquisition, and one for area intensity acquisition. 

select this mode for acquiring normal spectra where the detector is used in a 

one dimensional configuration (spectral axis). 

select this mode for specialized applications where the detector is used in a two 

dimensional configuration (spectral axis and CCD height). 

The “Sizes” section controls what area of the detector is used for the “Spectrum” and “Image” modes.  

Type in the desired minimum and maximum pixel numbers to define the area which will be used.  The 

values in the greyed out boxes indicate the maximum pixel size of the detector in the X and Y axes.

The options visible will depend on the particular detector(s) installed on the instrument.  Please 

consult a trained engineer from HORIBA Scientific or one of its representatives to find out more about 

the options available for the detectors installed on your system. 

In most cases, the temperature sensor and control options will be present, and these ar

Displaying the Detector Temperature 

Click on the “temperature” icon to display the 

current temperature of the detector. 

The current temperature (in degrees celsius, 
o
C) 

will be displayed in the adjacent indicator box. -70 
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INDOW BE MODIFIED EXCEPT WHEN 
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this list will only show the detectors 

Select the read out mode for the detector from the “Mode” drop down box.  For two dimensional array 

detectors (such as a CCD), the software has different read out zones (areas) configured, one for 

where the detector is used in a 

ons where the detector is used in a two 

The “Sizes” section controls what area of the detector is used for the “Spectrum” and “Image” modes.  

bers to define the area which will be used.  The 

values in the greyed out boxes indicate the maximum pixel size of the detector in the X and Y axes. 

detector(s) installed on the instrument.  Please 

consult a trained engineer from HORIBA Scientific or one of its representatives to find out more about 

In most cases, the temperature sensor and control options will be present, and these are described 
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Tick the box to have the current temperature 

continuously updated.  

 

Note that the current temperature of the active 

detector is also displayed next to the detector 

indicator icon in the Status Bar. 

3.5.7.2. Setting the Detector Temperature 

To set the temperature of the detector, type in the 

desired value (in degrees celsius, 
o
C), and click 

[Set]. 

3.5.8. Autofocus 

The Autofocus function in LabSpec 5 automatically finds the optimum focus position for a sample, and 

ensures that the best quality spectrum with maximum signal level can be easily achieved. 

It is a useful tool for samples where manual focusing is difficult (such as highly polished, clean 

surfaces).  So long as the sample is relatively close to focus the Autofocus procedure will find the 

correct focus position and give a good quality spectrum. 

Autofocus also is invaluable when acquiring XY surface maps of samples which have significant 

surface roughness.  Without autofocus whenever the measurement position in the map is out of focus 

the signal level will be reduced, and analysis of the map data will be difficult.  With the autofocus 

running, the focus position will be adjusted at each measurement position in the map, ensuring that 

good quality data is acquired across the full mapping area, despite the sample’s inherent roughness. 

Spectrum acquired using 100x objective with 

autofocus. 

 

 

 

Spectrum acquired using 100x objective without 

autofocus; out of focus by approximately 20 µm.  

The bottom image is shown with the same intensity 

scale as the ‘autofocus’ spectrum shown above. 
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3.5.8.1. The Autofocus Procedure 

The Autofocus procedure uses a software controlled motor to control the microscope focus.  The 

focus position is adjusted in small increments whilst monitoring a signal from the sample.  The sample 

signal is maximum at the focus position, and thus the focus adjustment is made iteratively until the 

maximum signal is observed.  At this point, the Raman measurement is made. 

There are two main motors which are used to control the microscope focus. 

o Z motor – this motor controls the fine focus wheel of the microscope.  Its maximum range is 

limited only by the microscope focus mechanism, and the available space between the 

objective and the sample. 

o Piezo device (Pifoc) – this motor is attached to a single microscope objective, and uses 

piezo controllers to adjust the objective position up or down.  Its maximum range is limited 

by the piezo controllers, and typically has a travel of approximately 100 µm.  By using piezo 

motors, this device is extremely fast, and has very fine step size (typically <50 nm). 

There are two main signals which can be detected to find the focus position. 

o Reflection – this signal is the reflected and Rayleigh scattered light from the sample, and is 

detected by a small pin diode detector positioned at the top of the microscope, which 

monitors the total signal intensity (without spectral information).  The signal will be greatest 

at the surface of the sample. 

o Detector – this signal is based on the Raman signal from the sample detected in the normal 

way using the active detector.  The signal will be greatest at (or just below) the surface of 

the sample. 

The hardware present on your instrument will dictate whether autofocus is possible, and if so, what 

motor and signal will be used. 

3.5.8.2. Setting Up Autofocus 

The Autofocus dialog window (accessed via Acquisition > Autofocus) allows the Autofocus to be 

configured. 
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Z parameters 

Select the motor type from the “Device” drop down box.  Depending on the instrumentation 

configuration there may only be one motor available.  The typical devices which are used are as 

follows: 

o Motorized – this uses the Z motor connected to the fine focus wheel of the microscope. 

o Pifoc – this uses the piezo Z axis motor attached to a specific objective. 

Select the scan type from the adjacent drop down box.  There are two types of autofocus scans which 

can be used: 

o Continuous – the motor will make a continuous sweep through the Z axis, whilst reading out 

the signal. 

o Step by step – the motor will move to a set position, then read out the signal; then move to 

the next position etc. 

Set the Z scan “Range” and “Step”.  The range must be set sufficiently large to ensure that the 

sample’s roughness can be countered using Autofocus; however the range must not be set so large 

that the objective would be driven into the sample.  With the “Motorized” Z motor device the range is 

only limited by the microscope focus mechanism, and the available space between the objective and 

the sample.  With the “Pifoc” piezo motor the range is limited by the piezo controllers, and typically 

has a travel of approximately 100 µm. 

_________________________________________________________________________________ 

 

CAUTION: TAKE CARE SETTING THE Z SCAN “RANGE” WHEN USING THE Z MOTOR (“MOTORIZED” DEVICE).  IF 

THE RANGE IS SET LARGER THAN THE AVAILABLE SPACE BETWEEN THE SAMPLE AND THE OBJECTIVE, THE 

SAMPLE, OBJECTIVE, MICROSCOPE AND/OR Z MOTOR COULD BE SERIOUSLY DAMAGED. 

_________________________________________________________________________________ 

 

Signal 

Select the autofocus signal from the “Signal” drop down box. 

o Reflection - this signal is the reflected and Rayleigh scattered light from the sample, and is 

detected by a small pin diode detector positioned at the top of the microscope, which 

monitors the total signal intensity (without spectral information). 

o Detector - this signal is based on the Raman signal from sample detected in the normal way 

using the active detector. 

Tick the “Profile” box to create a profile of signal intensity versus Z (depth) position during the 

autofocus procedure.  This can be a useful tool to monitor and troubleshoot the autofocus procedure. 

If “Reflection” signal is selected, there are no other parameters which need to be set in the “Signal” 

section. 

If “Detector” signal is selected, specify the spectral range which will be used to optimise the focus 

position, and set the “exposure” (acquisition) time (in seconds, s) which will be used for the autofocus 

spectrum read out.  Note that this exposure time is used only for the autofocus procedure – once the 

focus position is located the sample measurement will be made using the acquisition parameters set 

in the Control Panel (see section 9.9, page 235). 
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Zone 

The “Zone” section of the Autofocus dialog window can be used to set up an intermittent autofocus 

procedure.  The “XY” mode sets the autofocus to be made after a fixed distance across the sample, 

whilst the “Time” mode sets the autofocus to be made after a fixed time. 

o XY – Tick the box for “XY”, and type in 

the desired distance (in micrometers, µm) 

between autofocus operations. 

 

This mode is useful when the sample has 

a very gradual change in focus across its 

surface, and it is not necessary to 

autofocus at every map position. 

 

 

 

 

o Time – Tick the box for “Time”, and type 

in the desired time (in seconds, s) 

between autofocus operations. 

 

This mode is useful when the sample 

may slow move out of focus due to 

temperature fluctuations, and it is not 

necessary to autofocus at every point. 

 

 

 

3.5.8.3. Turning On Autofocus 

In Acquisition > Options, select the appropriate mode from the “Autofocus” drop down box (see 

section 3.5.4.8.1, page 40). 

Click [OK].  Autofocus is now active. 

The Autofocus indicator icon is displayed in the 

Status Bar. 

3.5.8.4. Setting the Autofocus Offset 

In Acquisition > Options, type in the desired offset for the Autofocus position.  A negative offset means 

that the focus will be moved upwards (e.g., analysis will be made higher in the sample than the 
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autofocus position); a positive offset means that the focus will be moved downwards (e.g., analysis 

will be made lower in the sample than the autofocus position). See section 3.5.4.8.2, page 40, for 

further information. 

3.5.8.5. Turning Off Autofocus 

In Acquisition > Options select “Off” from the “Autofocus” drop down box (see section 3.5.4.8.3, page 

40). 

Click [OK].  Autofocus is now inactive. 

The Autofocus indicator icon is no longer displayed in the Status Bar. 

3.5.9. Extra Images 

The “Extra Images” dialog window allows extra images to be recorded using other detector devices on 

the system (such as the Autofocus “reflection” pin diode detector – see section 3.5.8, page 59).  

There are two main modes: 

o Image – this allows for stand alone images to be recorded using the signal from the 

additional detector.  The dimensions of the image (in X, Y and/or Z axes) and the number of 

image pixels are defined in the “Extra Images” dialog window. 

o Map – this allows signal from the additional detector to be recorded simultaneously with a 

multidimensional spectral array measurement (such as a Raman XY surface map).  The 

dimensions of the image (in X, Y and/or Z axes) and the number of data points are taken 

from the “Mapping Properties” dialog window (see section 4.5.5, page 97) and do not need 

to be set in the “Extra Images” dialog window. 

3.5.9.1. What are Extra Images For? 

The “Extra Images” function can be useful to obtain additional information about a sample which 

wouldn’t normally be possible on a Raman microscope. 

One typical example is to create a map of the sample’s surface topography (roughness).  This can be 

done by using information obtained during the Autofocus procedure (see section 3.5.4.8, page 39).  If 

the Autofocus procedure is used for a Raman XY map of the surface at each measurement point in 

the map the software has calculated a focus position based on an autofocus signal. These two values 

(focus position and signal) directly reflect the topography of the sample.  The “Extra Images” function 

allows the topography image to be created simultaneously with the Raman map. 
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3.5.9.2. Setting Up an Image Acquisition 

Tick the axis boxes to activate the X, Y and Z axes 

as required. 

Set the image dimensions (in micrometers, µm) 

using the “From” and “To” boxes, and number of 

image pixels using the “Size” boxes. 

 

 

 

 

 

Select the signal source (additional detector) which 

will be used to create the image, by ticking the 

“Image” box(es) in the “Sources” section.. 

The most common sources are as follows: 

o Reflection – autofocus pin diode detector. 

o Z – Z-axis position of the piezo/Z motor. 

Other sources may be visible in this dialog window, 

depending on the configuration of your system. 

 

 

Click [Image] to start the acquisition. 

3.5.9.3. Setting Up a Map Acquisition 

Select the signal source (additional detector) which 

will be used to create the mapped image by ticking 

the “Map” box(es) in the “Sources” section. 

Nothing needs to be set or adjusted in the “Image” 

section of the dialog window.  Note that if all three 

image axes (X, Y and Z) are unticked, then the 

[Image] button will be greyed out.  This button is 

not used for map acquisition. 
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Click [Close] to close the “Extra Images” dialog 

window. 

Set up the Raman multidimensional spectral array 

measurement in the normal way using the “Map 

Properties” dialog window (see section 4.5.5, page 

97) 

Start the Raman multidimensional spectral array 

measurement in the normal way using the 

“Mapping Acquisition” icon (  /  ).  An 

additional map image (or images) will be displayed 

as the Raman map proceeds. 

3.5.10. Auto Exposure 

The Auto Exposure function calculates the necessary acquisition time to acquire a spectrum with a 

maximum signal level specified by the user.  It is useful to ensure a good quality spectrum is acquired 

regardless of the inherent signal strength of the sample. 

The Auto Exposure function initially acquires a test spectrum with a fast ‘test’ acquisition time, and 

calculates the maximum signal level in the spectrum.  Based on this data a new ‘final’ acquisition time 

is calculated to yield a maximum signal equal to the specified ‘desired intensity’, and the acquisition is 

made.  ‘Minimum’ and ‘Maximum’ acquisition times are also set by the user, to prevent the software 

attempting an infinitely short or long measurement. 

 

Test exposure time (s) 

Set the initial test acquisition time, in seconds (s).  Typically an acquisition time between 0.3s and 1s 

is suitable, although it can be increased if most samples are very weak Raman scatterers. 

Minimum exposure time (s) 

Set the minimum acquisition time which can be selected by the software for the final measurement.  

Typically an acquisition time between 0.1s and 0.5s is suitable. 

Maximum exposure time (s) 

Set the maximum acquisition which can be selected by the software for the final measurement. 

For weak Raman scatterers the final acquisition time required to reach the ‘Desired intensity’ may 

exceed the ‘Maximum exposure time’.  In this case the final acquisition time will be equal to the 

‘Maximum exposure time’ and the achieved intensity may be less than the ‘Desired intensity’. 
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Desired intensity (cnt) 

Set the desired maximum signal level (in counts, cnt) for the final spectrum, ensuring that it is below 

the saturation point of the detector being used.  Remember that the larger the desired intensity the 

longer the measurement will take, but the better the spectrum quality. 

For weak Raman scatterers the ‘Desired intensity’ may not be achieved because the final acquisition 

time required to reach this intensity would need to exceed the ‘Maximum exposure time’.  In this the 

‘Maximum exposure time’ is used. 

3.5.10.1. Turning the Auto Exposure Function On and Off 

The Auto Exposure function is turned on and off 

using the “Autoexposure” drop down box in 

Acquisition > Options – see section 3.5.4.12, page 

42. 

When Auto Exposure is active, the Acquisition 

Time section in the Control Panel is set to “Auto” 

and greyed out. 

 

3.5.11. Heat Detector 

For peltier cooled (liquid nitrogen free) detectors, the “Heat Detector” function will switch off the peltier 

cooling and allow the detector to warm up to room temperature. 

Cooling can be restarted either by setting the temperature in Acquisition > Detector (see section 

3.5.7.2, page 59), or by exiting and restarting LabSpec 5. 

3.6. Video 

The Video menu allows configuration of the instrument’s video camera(s), set up of video image 

scaling and the laser spot marker position, and (when multiple cameras are present) selection of the 

active camera. 

 

 

 

Video camera configuration 

Laser spot marker position  and video image scaling and  

List of installed cameras 



 

 

 

_________________________________________________________________________________

 

CAUTION: CHANGING PARAMETERS A

CAMERA(S) TO CEASE WORKING, OR TO WORK INCORRECT

THE VIDEO MENU WHEN INSTRUCTED

OF ITS REPRESENTATIVES. 

_____________________________________________________________________________

3.6.1. Video Camera Configuration

The dialog windows for “Source”, “Format” and “Offsets” allow the configuration of the video 

camera(s) to be set up, or modified.

installed on the instrument. 

Please consult your local HORIBA Scientific engineer or representative to find out more details about 

the configuration options available for the cameras on you

3.6.2. Laser Spot Marker Position and Video Image Scaling

The “Laser Position” and “Image Scale” options allow the 

video image, and the scaling of the video images to be set.

3.6.2.1. Laser Position 

Click on Video > Laser position to set the position of the green laser s

3.6.2.1.1. Setting the Laser Spot Marker Position

Acquire a video image, using the video icon (

 / ).  Ensure that the objective selected in the 

Control Panel (see section 

corresponds to the objective being used on the 

microscope. 

 

 

Click on Video > Laser position.  
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_________________________________________________________________________________

HANGING PARAMETERS ACCESSED THROUGH THE VIDEO MENU COULD CAUSE THE

OR TO WORK INCORRECTLY.  YOU SHOULD ONLY MODIF

MENU WHEN INSTRUCTED TO DO SO BY A TRAINED ENGINEER FROM HORIBA

_____________________________________________________________________________

Video Camera Configuration 

The dialog windows for “Source”, “Format” and “Offsets” allow the configuration of the video 

camera(s) to be set up, or modified.  The dialog windows will vary depending to the specific camera(s) 

Please consult your local HORIBA Scientific engineer or representative to find out more details about 

available for the cameras on your system. 

Laser Spot Marker Position and Video Image Scaling 

The “Laser Position” and “Image Scale” options allow the position of the laser spot marker on the 

video image, and the scaling of the video images to be set. 

> Laser position to set the position of the green laser spot marker on the video image.

Setting the Laser Spot Marker Position 

Acquire a video image, using the video icon (

Ensure that the objective selected in the 

section 9.7, page 234) 

corresponds to the objective being used on the 
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_________________________________________________________________________________ 

MENU COULD CAUSE THE VIDEO 

OU SHOULD ONLY MODIFY PARAMETERS IN 

HORIBA SCIENTIFIC OR ONE 

_________________________________________________________________________________ 

The dialog windows for “Source”, “Format” and “Offsets” allow the configuration of the video 

The dialog windows will vary depending to the specific camera(s) 

Please consult your local HORIBA Scientific engineer or representative to find out more details about 

position of the laser spot marker on the 

pot marker on the video image. 



 

 

 

 

Drag the green laser spot marker to the desired 

position on the video image, or type the desired 

coordinates into the “Center X” and “Center Y” 

boxes.  

 

 

 

Click [OK].  The laser spot marker is now 

repositioned. 

Note that this process is objective specific 

laser spot marker position should be set for each 

objective on the microscope. 

3.6.2.2. Video Image Scale

Click on Video > Image scale to open the “Image scale” dialog window.

A resizeable scale box will additionally appear on the video image.

known size, and the known values used to scale the video image.  

3.6.2.2.1. Setting the Video Image Scale

Acquire a video image, using the video icon 

 / ).  Ensure that the objective selected in the 

Control Panel (see section 

corresponds to the objective being used on the 

microscope. 

Click on Video > Image scale to open the “Image 

scale” dialog window. 
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Drag the green laser spot marker to the desired 

position on the video image, or type the desired 

coordinates into the “Center X” and “Center Y” 

.  The laser spot marker is now 

bjective specific – the 

laser spot marker position should be set for each 

Video Image Scale 

open the “Image scale” dialog window. 

A resizeable scale box will additionally appear on the video image.  The scale box can be 

known size, and the known values used to scale the video image.   

 

the Video Image Scale Using the “1” “2” Corner Positions 

Acquire a video image, using the video icon (

.  Ensure that the objective selected in the 

section 9.7, page 234) 

corresponds to the objective being used on the 

> Image scale to open the “Image 
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Ensure the “Size X” and “Size Y” boxes are ticked. 

 

 

 

 

 

Drag the scale box to cover a large proportion of 

the video image.  

Move a small, easily recognisable feature of the 

sample so that it is positioned exactly at the top, 

left hand corner of the scale box. Dust particles on 

the Silicon calibration sample are ideal for this, but 

any sample with recognisable features can be 

used. 

 

 

 

Click [1].  The scale values in the “Size X” and 

“Size Y” boxes are cleared. 

 

 

 

 

Using the joystick move the XY stage so that the 

feature is positioned exactly at the bottom, right 

hand corner of the scale box. 

 

 

 

 

 



 

 

 

 

Click [2].  The scale values in the “Size X” and 

“Size Y” boxes are set according to the distance 

moved by the XY stage. 

 

 

 

 

Click [Scale XY] to register the video scale.

 

Note that this process is objective 

video image scale should be set for each objective 

on the microscope. 

3.6.2.2.2. Setting the Video Image Scale Manually

Acquire a video image, using the video icon 

 / ).  Ensure that the objective se

Control Panel (see section 

corresponds to the objective being used on the 

microscope. 

Click on Video > Image scale to open the “Image 

scale” dialog window. 

 

 

Ensure the “Size X” and “Size Y” boxes are ticked 

as appropriate.  With this procedure it is possible to 

scale just one dimension (X or 

dimension(s) to be scaled must be ticked.

 

 

 

Drag the scale box (in X and/or Y dimensions, as 

appropriate) to match a feature of known size.  

Typically this will be a graticule scale bar, but any 

sample feature of precisely known size

used. 

LabSpec 5

 

.  The scale values in the “Size X” and 

“Size Y” boxes are set according to the distance 

the video scale. 

Note that this process is objective specific – the 

video image scale should be set for each objective 

Setting the Video Image Scale Manually 

Acquire a video image, using the video icon (

.  Ensure that the objective selected in the 

section 9.7, page 234) 

the objective being used on the 

Click on Video > Image scale to open the “Image 

Ensure the “Size X” and “Size Y” boxes are ticked 

as appropriate.  With this procedure it is possible to 

scale just one dimension (X or Y) if desired.  The 

dimension(s) to be scaled must be ticked. 

(in X and/or Y dimensions, as 

appropriate) to match a feature of known size.  

Typically this will be a graticule scale bar, but any 

sample feature of precisely known size can be 
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In the “Size X” and/or “Size Y” boxes type in the 

size of the feature to which the scale box has been 

match 

 

 

 

 

Click [Scale XY] to register the video scale.

 

If only one dimension (X or Y) has been scaled in 

this manner, ensure that the other dimension is 

scaled using a similar process.  Both dimensions 

(X and Y) must be scaled to have correctly scaled 

video images. 

Note that this process is objective specific 

video image scale should be set for each objective 

on the microscope. 

3.6.2.2.3. Setting the Scanner Scale

The Scanner Scale function is used to set the scan 

range of the confocal LineScan mirror.

Acquire a video image, using the 

 / ).  Ensure that the objective selected in the 

Control Panel (see section 

corresponds to the objective being used on the 

microscope. 

Turn on the laser and/or open the shutter, so that 

the laser beam is visible in the video image. 

Click on Video > Image scale to open the “Imag

scale” dialog window. 
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In the “Size X” and/or “Size Y” boxes type in the 

size of the feature to which the scale box has been 

the video scale.  

If only one dimension (X or Y) has been scaled in 

other dimension is 

scaled using a similar process.  Both dimensions 

(X and Y) must be scaled to have correctly scaled 

Note that this process is objective specific – the 

video image scale should be set for each objective 

ting the Scanner Scale 

function is used to set the scan 

range of the confocal LineScan mirror. 

Acquire a video image, using the video icon (

).  Ensure that the objective selected in the 

Control Panel (see section 9.7, page 234) 

corresponds to the objective being used on the 

Turn on the laser and/or open the shutter, so that 

the laser beam is visible in the video image.  

> Image scale to open the “Image 
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If the system has a software controlled motori

Scanner, tick the “Scanner” box to start the 

Scanner motorized mirrors; otherwise ensure that 

the scanner is started using the switch on the 

instrument control unit.  The lase

be rastored on the sample in the Y direction.

 

 

Drag the scale box (in the Y dimension) to match 

the scan height of the rastored laser beam

Click [Scanner] to register the video scale.

 

Note that this process is objective specific 

video image scale should be set for each objective 

on the microscope. 

3.6.3. List of Installed Cameras

A list of all installed cameras is displayed at the bottom of the 

camera is denoted by a tick next to its name

started with the camera icon (

3.6.3.1. Selecting a Camera

The currently active camera is denoted by a tick 

video read out is started with the camera icon

To change the active camera, click on the camera 

name listed in the Video menu. 
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tware controlled motorized 

ick the “Scanner” box to start the 

; otherwise ensure that 

the scanner is started using the switch on the 

.  The laser beam will now 

be rastored on the sample in the Y direction. 

Drag the scale box (in the Y dimension) to match 

of the rastored laser beam. 

the video scale.  

Note that this process is objective specific – the 

video image scale should be set for each objective 

List of Installed Cameras 

A list of all installed cameras is displayed at the bottom of the Video menu.  The currently acti

next to its name – this camera will be used when the video read out is 

 / ). 

Selecting a Camera 

ve camera is denoted by a tick next to its name – this camera will be used when the 

video read out is started with the camera icon (  / ). 

click on the camera 
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this camera will be used when the video read out is 

this camera will be used when the 
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3.7. Setup 

The Setup menu provides access to some specific functions for hardware control. 

 

3.7.1. Instrument Calibration 

The “Instrument Calibration” dialog window allows the user to perform a manual calibration of the 

spectrometer, and provides additional useful information and control for general maintenance of the 

system. 

 

3.7.1.1. Calibration Options 

The “Calibration Options” section displays the maximum signal level of the active spectrum, and the 

relative intensity of the next three spectra displayed in the spectrum window. 

In the example shown right, the active spectrum 

(—) has a maximum intensity of 20027.50 counts, 

whilst the second spectrum (—) has a maximum 

intensity of 12105.90 counts, which is 60.45% of 

the active spectrum intensity. 

 

 

3.7.1.2. Pixel 

Tick the “Set Unit to Pixel” to display spectra with X axis units of detector pixels, rather than the units 

selected in Options > Unit.  This can be useful to locate the position of a hot pixel on the detector. 

0

5 000

10 000

15 000

20 000

In
te

n
si

ty
 (

cn
t)

500 600

Raman Shift (cm
-1

)



LabSpec 5 user manual 

 

 

 

 

Page | 74  

 

 

Click on [Show Central Pixel] to mark the central pixel position on the spectrum. 

3.7.1.3. Calibration 

Click on [Show Diode] to move the spectrometer to the pre-set internal diode position.  This position 

allows the internal reference diode to pass through the spectrometer and confocal optics onto the 

sample.  The internal reference diode can be used for back alignment of the spectrometer and optics. 

Tick the “Open Shutter” box to force the detector shutter open, so that the internal reference diode 

spot can be viewed on the sample. 

3.7.1.4. Motor Calibration 

The “Motor Calibration” section allows the reference positions of the instrument’s motors to be set.  

The most common use of this section is to perform a manual calibration of the spectrometer (“spectro” 

motor). 

_________________________________________________________________________________ 

 

CAUTION: CHANGING PARAMETERS IN THE “MOTOR CALIBRATION” SECTION COULD CAUSE THE INSTRUMENT 

TO CEASE WORKING, OR TO WORK INCORRECTLY.  YOU SHOULD ONLY MODIFY PARAMETERS IN THE “MOTOR 

CALIBRATION” SECTION AFTER TRAINING BY A TRAINED ENGINEER FROM HORIBA SCIENTIFIC OR ONE OF ITS 

REPRESENTATIVES. 

_________________________________________________________________________________ 

 

For a step by step guide to manual calibration of the spectrometer please see section 10, page 248. 

Motor 

Select the motor to be calibrated from the “Motor” drop down box. 

Position 

The current position of the selected motor is 

displayed in motor step units. 

Click on the left hand ar row to sequentially move 

the motor position to lower position.  The position 

will be reduced by the increment shown in the 

“Inc.” box. 

Click on the right hand arrow to sequentially move 

the motor position to higher position.    The position 

will be increased by the increment shown in the 

“Inc.” box. 

Grating 

The selected diffraction grating (see section 9.6.1, 

page 232) is displayed. 
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Zero: 

The “Zero” number is the motor step position for 

the end (zero) position of the motor. 

For the spectrometer, “Zero” corresponds to the 

motor step position at which the diffraction grating 

is at zero order (=0 nm). 

Koeff: 

The “Koeff” number relates the function of the 

motor to its step size. 

For the spectrometer, “Koeff” corresponds to the 

number of nanometers (nm) travelled per motor 

step. 

Apply 

Click [Apply] to register a change in the “Zero” or 

“Koeff” values. 

3.7.2. Instrument Init 

Clicking on Setup > Instrument Init will re-initialize the instrument.  This means that all motor positions 

will be returned to their reference position, and then sent to the positions indicated in the software. 

3.7.3. ICS Filters 

Clicking on Setup > ICS Filters opens the ICS Filters dialog window. This allows a specific filter set to 

be specified so that an appropriate “HORIBA ICS” intensity correction factor will be applied for 

measurements made with this filter set.  Full information about automatic intensity correction and the 

“HORIBA ICS” correction factor can be found in section 3.5.4.14, page 43. 

  

3.7.3.1. Selecting a Specific Filter for Intensity Correction 

Click on Setup > ICS Filters to open the ICS Filters 

dialog window. 
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Select the required laser injection/rejection filter 

from the “Injection/Rejection” section, or a 

combination of photoluminescence (PL) filters from 

the “PL” section. 

Note that an intensity correction factor must have 

been created for the specified filter combination, 

otherwise an error message similar to that shown 

right will be displayed when an acquisition is 

started.  Click on [OK] or [Cancel] to clear the 

message, and start the acquisition.  Remember 

that in this case the spectrum will be uncorrected.  

The error message will only be shown once during 

a LabSpec session – if LabSpec is closed and then 

re-opened, the message will be displayed again if 

intensity correction is activated when no intensity 

correction factor has been created. 

3.8. LabAssistant 

The LabAssistant menu is the interface for the LabSpec 5 user assistance module, and allows 

definition and use of hardware/software templates and the GO! (Guided Operation) Wizard. 

3.8.1. LabAssistant Templates 

The LabAssistant templates provide enhanced template control compared with the Options > 

Template function (see section 3.4.6, page 29).  It is recommended that the LabAssistant function is 

used in preference to Options > Template. 

Templates allow you to save a specific instrument configuration and measurement set up.  The 

template can be recalled and applied as required.  Templates are useful when you wish to make a 

number of sample types, each of which requires a specific measurement configuration.  In this case, a 

number of templates can be set up allowing you to quickly recall the desired configuration without 

needing to set each parameter individually. 

To learn more about the various options shown in the template dialog window please consult the 

relevant section of this manual. 

3.8.1.1. Default Templates 

Hover the mouse over LabAssistant > Default 

templates to see a list of default templates installed 

with the system. 

Click on the desired template name to open the 

template dialog window. 
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Note that all modules and accessories active on 

the system will be visible within the “Template” 

window.  Depending on your instrument 

configuration the “Template” window you see may 

vary from that shown here. 

 

 

 

 

 

Click [Apply] to apply the current template – 

motorized hardware changes will be made 

automatically; manual hardware changes will 

prompt for you to change the hardware. 

3.8.1.2. Custom Templates 

Hover the mouse over LabAssistant > Custom 

templates to see a list of user defined custom 

templates installed with the system.  Please see 

below for details about creating (section 3.8.1.3, 

page 78) and managing (section 3.8.1.4, page 79) 

custom templates. 

Click on the desired template name to open the 

template dialog window. 

Note that all modules and accessories active on 

the system will be visible within the “Template” 

window.  Depending on your instrument 

configuration the “Template” window you see may 

vary from that shown here. 

 

 

 

 

 

Click [Apply] to apply the current template – 

motorized hardware changes will be made 
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automatically; manual hardware changes will 

prompt for you to change the hardware. 

3.8.1.3. Create Template 

To create a new user defined custom template 

click on LabAssistant > Create template. 

The template dialog window will be opened, 

showing a default configuration. 

 

 

 

 

 

 

Click on [Current] to import the current instrument 

configuration and measurement set up into the 

Template. 

Click [Apply] to apply the current template – 

motorized hardware changes will be made 

automatically; manual hardware changes will 

prompt for you to change the hardware. 

3.8.1.3.1. Saving a Template 

To save the template, type a name into the “Name” 

box, and click [Save]. 

 

 

 

 

 

 

The template will be saved (in .tpl format) in a 

designated folder according to the user’s profile 

(see section 3.4.5, page 25).  The folder name will 

be the user’s log-in name. 
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If “Profiles...” is not active, or if a guest user is 

logged in the template will be saved into a folder 

named Guest. 

3.8.1.3.2. Opening an Existing Template 

To open an existing template click [Load].  A file 

browse window will be opened. 

 

 

 

 

Locate the template to be opened, and click 

[Open]. 

Note that even if a template has been opened from 

another user’s folder, the save location will default 

to the current user’s folder.  This ensures that 

templates created by another user cannot be 

overwritten or modified, except by the original 

creator. 

3.8.1.4. Manage Templates 

Click on LabAssistant > Manage templates to open the “Manage Templates” dialog window, and 

organize the templates.  The log-in name of the current user is shown at the top of the window.  If 

user “Profiles...” are not active, or if a guest user is logged in, the log-in name will be “Guest”. 

3.8.1.4.1. Available Templates 

A list of all templates available to the current user 

is shown in this box. 

Click on a template name, and then click [Show] to 

open the template dialog window to view the 

template configuration. 

Click on [Import] to import a template from another 

user’s folder into the current user’s template 

location. 

 

 



 

 

 

 

3.8.1.4.2. Custom Templates M

A list of templates which will be displayed in 

LabAssistant > Custom templates 

box. 

Click on a template name, and then click 

open the template dialog window to view the 

template configuration. 

 

 

 

 

3.8.1.4.3. Organizing the Templates

Templates can be organized according to the user’s preference.

Show a Template in the Custom Templates Menu

To make an available template show in 

LabAssistant > Custom templates, 

template in the “Available templates” box.

 

 

 

 

 

 

Click on the “transfer” button. 

The selected template is now copied to the Custom 

Templates Menu box. 
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om Templates Menu 

A list of templates which will be displayed in 

> Custom templates is shown in this 

Click on a template name, and then click [Show] to 

open the template dialog window to view the 

ing the Templates 

d according to the user’s preference. 

Show a Template in the Custom Templates Menu 

To make an available template show in 

> Custom templates, click on the 

template in the “Available templates” box. 

The selected template is now copied to the Custom 
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Modify the Display Position of a Template

To change the display position of a template name 

in the LabAssistant > Custom templates menu, 

click on the template name (in the Custom 

templates menu box) which is to be moved.

Click on the “Move Up” or “Move Down” buttons to 

move it up or down in the list displ

Custom templates menu box. 

 

 

Remove a Template from the Custom Templates Menu

To remove a template from the 

Custom templates menu, click on the template 

name (in the Custom templates menu box) which 

is to be removed. 

 

 

 

 

 

Click on the “Remove” button. 

The template name is removed from the Custom 

Templates Menu box.  Note that this action does 

not actually delete the template.  It is still listed in 

the Available Templates box. 
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Modify the Display Position of a Template 

the display position of a template name 

> Custom templates menu, 

click on the template name (in the Custom 

templates menu box) which is to be moved. 

Click on the “Move Up” or “Move Down” buttons to 

move it up or down in the list displayed in the 

Remove a Template from the Custom Templates Menu 

a template from the LabAssistant > 

Custom templates menu, click on the template 

lates menu box) which 

The template name is removed from the Custom 

Templates Menu box.  Note that this action does 

not actually delete the template.  It is still listed in 
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3.8.2. G.O. (Guided Operation Wizard) 

The Guided Operation (GO!) wizard is intended to assist less experienced users, who may not be 

familiar with the technical configuration of a Raman system, and may not understand how key 

hardware and software parameters affect the measurement result. 

The GO! wizard leads the user through the experiment set up with a series of questions, and provides 

helpful, real life hints as to which option should be chosen.  At the end the chosen parameters are 

applied, and the measurement is then made. 

3.8.2.1. Using the Guided Operation Wizard 

Click on LabAssistant > G.O. to open the GO! 

Wizard start up window. 

Click [Start GO] to start the wizard with the first 

question. 

 

 

 

Hover the mouse over the HINTS panel to view 

hints about the choice of parameter.  In some 

cases additional information can be accessed 

using the hyperlinks within the hint text. 

Move the mouse away from the HINTS panel to 

hide the hint text, and select the parameter listed in 

the GO! dialog window. 

 

 

 

 

3.9. Scripts 

The Scripts menu offers Visual Basic Scripting (VBS) functionality for LabSpec 5, which allows 

specific hardware control, data acquisition and data analysis functions to be written by the user. 

 

Open the VBS options and management window 

Script menu 
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The VBS functionality and command set is not included in this manual, and users are referred to the 

document “LabSpec_5_Activex-VBS_documentation.pdf” located in the folder C:\Program 

Files\NGSLabSpec\. 

3.9.1. Script Options and Management Window 

Click on Scripts > Options to open the script options and management dialog window. 

3.9.1.1. Scripts 

The “Scripts” section allows VBS scripts (in .vbs 

format) to be loaded and edited. 

Multiple scripts can be loaded, and are displayed 

in the “Script:” drop down box.  Use the drop down 

box to select a loaded script. 

The file path of the selected script is displayed in 

the “Path:” section. 

 

 

Load a Script 

Click on the “Add Script to List” button to load a 

VBS script into the “Script:” drop down box. 

Remove a Script 

Click on the “Remove Script from List” button to 

remove a VBS script from the “Script:” drop down 

box. 

Configure a Script 

Certain VBS scripts have a configuration interface 

where specific properties can be set.  Click on the 

“Configure Script” button to open the selected 

script’s configuration window. 

If there are no configuration parameters for the 

selected script, a warning message will be 

displayed.  Click [OK] or [Cancel] to clear the 

message. 
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Start Script 

Click on the “Start Script” button to run the selected 

VBS script. 

Open Script in Editor 

Click on the “Open Script in Editor” button to open 

the selected VBS script in an editor window.  See 

section 3.9.1.1.1, page 84). 

3.9.1.1.1. Editing Scripts 

VBS scripts can be edited directly in LabSpec 5 

using the script editor tool.  To launch the script 

editor, click on the “Open Script in Editor” button in 

the script options and management dialog window. 

If a script is selected it will be opened in the editor 

window.  If there are no scripts loaded into the 

“Script Options and Management” dialog window 

the editor window will be blank, allowing direct 

coding of a new script.  

 

 

 

Start a Script 

Click on the “Start Script” button to run the VBS 

script displayed in the editor window. 

Stop a Script 

Click on the “Stop Script” button to stop a VBS 

script which is running. 

Create a New Script 

Click on the “New Script” button to open a blank 

VBS script in the editor window.  

Save a Script As 

Click on the “Save Script As” button to save the 

current VBS script with a new name.  The standard 

Windows file save dialog window will be opened. 

Save a Script 

Click on the “Save Script” button to save the 

current VBS script with its existing name.  No file 

save dialog window will be displayed. 
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3.9.1.2. Menu 

The “Menu” section allows scripts loaded in the 

script options and management window to be 

displayed in the Scripts menu, from where they can 

be run through a single mouse click. 

Scripts which are shown in the Scripts menu will be 

displayed in the “Menu” drop down box. 

 

 

 

Add a Script to the Scripts Menu 

Select a loaded VBS script in the “Script:” drop 

down box, and click on the “Add To Menu” button 

to display the script name in the Scripts menu. 

Remove a Script from the Scripts Menu 

Select a script from the “Menu” drop down box, 

and click on the “Remove From Menu” button to 

remove the script name from the Scripts menu. 

 

 

 

 

 

3.9.1.3. Acquisition Trigger 

Click [Set] to set the current script (displayed in the 

Script drop down box) to be used as a trigger 

script.  A trigger script is one which will be applied 

immediately before or after an acquisition. 
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3.9.1.4. Motors 

Click on [Configure] to open the Script Motors 

dialog window. 

 

 

 

 

 

3.9.1.4.1. Script Motors Dialog Window 

The Script Motors dialog window allows external 

motors not usually controlled by LabSpec 5 to be 

controlled using a VBS script. 

Up to five motors can be configured.  Click [Add] 

to open a standard file open dialog window to 

browse for a script. 

Type in the motor name, unit of motor movement 

(such as ‘steps’ or ‘micrometers’), and maximum 

and minimum motor values. 

Click [Remove] to remove a script from the list. 

3.9.2. Script Menu 

A list of VBS script names can be displayed in the Scripts menu.  Clicking on a script name will 

automatically run the script. 

To add and remove scripts from the Scripts menu please see section 3.9.1.2, page 85. 

3.10. Window 

The Window menu allows fast arrangement and selection of the data display windows in LabSpec 5.  

This menu item is only active and visible when data is open. 

 

 

Window display mode 

List of current display windows 



 

 

 

3.10.1. Window display mode

Cascade 

Click on Cascade to display all open data windows 

in cascade mode.  The windows can still be 

manually positioned and sized. 

 

 

 

 

 

 

Tile 

Click on Tile to display all open data

mode – in this mode, the windows will be 

positioned and sized so that all open windows are 

visible.  The windows can still be manually 

positioned and sized. 

 

 

 

 

 

3.10.2. List of current display windows

The list of current display windows shows all

window title is ticked in the list. 

To activate a window, left click the window title in 

the list.  This window title will now be ticked.
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Window display mode 

Click on Cascade to display all open data windows 

in cascade mode.  The windows can still be 

 

Click on Tile to display all open data windows in tile 

in this mode, the windows will be 

positioned and sized so that all open windows are 

visible.  The windows can still be manually 

List of current display windows 

The list of current display windows shows all current data windows open in LabSpec 5.  The active 

To activate a window, left click the window title in 

the list.  This window title will now be ticked. 
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current data windows open in LabSpec 5.  The active 



 

 

 

 

3.11. Help 

The Help menu provides access to the 

installed version of LabSpec 5.  In addition it is possible to se

graphical user interface (GUI). 

 

3.11.1. Help Topics 

Click on Help > Help Topics to display the 

LabSpec 5 context help. 

 

 

 

 

3.11.2. Language 

Click on Help > Language to select a language for 

the LabSpec 5 graphical user interface (GUI).

 

 

3.11.3. About LabSpec...

Help > About LabSpec... displays information 

about the installed version of LabSpec 5

individual modules (.dll files). 

This information can be useful for troubleshooting, 

and it is advised that you make a note of the 

LabSpec version number (i.e., 5.XX.YY) prior to 

contacting HORIBA Scientific with regard to the 

software. 

Click [OK] to close the information window.

LabSpec 5

 

provides access to the LabSpec 5 context help files and useful information about the 

.  In addition it is possible to select a language for the 

p Topics to display the 

lect a language for 

graphical user interface (GUI). 

About LabSpec... 

> About LabSpec... displays information 

LabSpec 5 and its 

an be useful for troubleshooting, 

and it is advised that you make a note of the 

LabSpec version number (i.e., 5.XX.YY) prior to 

contacting HORIBA Scientific with regard to the 

to close the information window.  
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lect a language for the LabSpec 5 



 

 

 

4. Icon Bar 

The Icon Bar located beneath the Menu Bar provides access to either standard Windows functions 

(such as File Open, File Save) or to 

icons can also be activated using keyboard shortcuts 

description of each icon, below.  

installed and configured hardware/software options for your instrument.

The image below shows all of the

in your software. 

Big icons 

Small icons 

 

4.1. Icon View and Grouping

Please note that there are two icon views 

the descriptions that follow, the “Big

4.1.1. Switching Icon View

To switch the icon view, right click on the icon tool 

bar.  The current icon view will be

Click on the desired icon view (“Small icon” or “Big 

icon”). 

 

The icon view will switch to the selected view.

 

 

 

4.1.2. Icon Grouping 

The icons are grouped according to general functionality

o Delete data 

o Data management 

o Cursors and data information

LabSpec 5

 

located beneath the Menu Bar provides access to either standard Windows functions 

(such as File Open, File Save) or to specialized data acquisition/analysis modules and options.

icons can also be activated using keyboard shortcuts – these shortcuts are indicated in the 

description of each icon, below.  The Icon Bar(s) will only show icons which apply to the correctly 

installed and configured hardware/software options for your instrument. 

The image below shows all of the standard icons, but be aware that some of these may not be visible 

Icon View and Grouping 

icon views used in LabSpec 5, called “Big icon” and “Small 

criptions that follow, the “Big icon” will be displayed first, followed by the “Sm

Switching Icon View 

To switch the icon view, right click on the icon tool 

bar.  The current icon view will be ticked. 

(“Small icon” or “Big 

The icon view will switch to the selected view. 

The icons are grouped according to general functionality: 

Cursors and data information 
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located beneath the Menu Bar provides access to either standard Windows functions 

ed data acquisition/analysis modules and options.  Some 

se shortcuts are indicated in the 

show icons which apply to the correctly 

ut be aware that some of these may not be visible 

 

 

con” and “Small icon”.  In 

will be displayed first, followed by the “Small icon”. 
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o Data acquisition 

o Data processing and analysis 

o Stop active function 

 

Each group separated indicated by a thick vertical 

bar on its left hand edge (indicated right with    ). 

Sub-sections within a group are separated by a 

thin vertical bar (indicated right with    ). 

4.1.2.1. Moving Icon Groups 

Icon groups can be moved by clicking and 

dragging on the thick vertical bar to the left hand 

side of the group. When the cursor changes to a 

double headed arrow the icon group can be 

dragged to a new position on the icon bar. 

4.2. Delete Data Icon 

4.2.1. Delete 

      

Close the currently active data file from LabSpec.  If the file has been modified since the last save, a 

standard Windows dialog window will prompt the user to save the file. 

This icon closes data displayed within LabSpec, but does not delete saved data from the computer 

hard drive. 

4.3. Data Management Icons 

4.3.1. Open 

      

Open a previously saved data file using a standard Windows dialog window.  See section 3.1.1.1, 

page 10, for full details concerning available file formats. 

This icon can be activated with the <CTRL>+O keyboard shortcut. 
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4.3.2. Save 

      

Save the data file currently active in LabSpec 5.  See section 3.1.1.1, page 10, for full details 

concerning available file formats and options for saving. 

This icon can be activated with the <CTRL>+S keyboard shortcut. 

4.3.3. Print 

      

Print the current data window using the Print Template.  Full information about using and setting up 

the Print Template can be found in section 3.1.2.1, page 13. 

This icon can be activated with the <CTRL>+P keyboard shortcut. 

4.3.4. Help 

      

Activates the context help function.  When clicked 

this icon will be locked down.  To release, click on 

the icon again. 

The standard cursor will change to the “help” 

cursor – click on any icon to view its context help 

file. 

4.4. Cursors and Data Information Icons 

4.4.1. Scale Normalization 

      

Rescale the active window so that all data is visible.  In normal operation all axes are affected, but 

note that an axis with scaling set to “Freeze” or “Fixed” will not be rescaled. To rescale an axis ensure 

that “Freeze” or “Fixed” scaling is turned off (see section 8.1, page 205). 

This icon can be activated using the right mouse click menu “Rescale” item (see section 8.3, page 

210) or with the <CTRL>+N keyboard shortcut, 
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4.4.2. Intensity Normalization 

      

Rescale the intensity axis of the active window.  Note that if the intensity axis has scaling set to 

“Freeze” or “Fixed” will not be rescaled. To rescale an axis ensure that “Freeze” or “Fixed” scaling is 

turned off (see section 8.1, page 205). 

4.4.3. Center Cursors 

      

Center the active cursor(s) in the active window. 

This function is useful when cursors are not visible in a window, because their position lies outside the 

range of the window.  Click on this icon and the cursor(s) will be immediately visible in the center of 

the window. 

This icon can also be activated by using the right mouse click menu “Center cursor” (see section 8.7, 

page 213). 

4.4.4. Data Range 

      

Open the “Data Range” dialog window, which displays information about the number of data points 

and maximum and minimum values for the active data.  Typical information includes maximum and 

minimum values for the spectrum axis, intensity axis, XYZ spatial axes, and colors.  The exact 

categories which are displayed depend on the specific ‘type’ of the selected data. 

See section 3.3.2, page 20, for full information. 

This icon can be activated with the <CTRL>+D keyboard shortcut, or through the Data > Data range... 

menu item. 

4.4.5. Information 

      

Open the parameters information dialog window. 

This icon can be activated with the <CTRL>+I keyboard shortcut.  
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4.4.5.1. Parameters Information 

The “Parameters Information” dialog window contains a wide range of information relating to the 

acquisition and processing of the active data.  For example, it displays hardware set up (e.g., laser 

wavelength, confocal hole, diffraction grating and objective), acquisition parameters (e.g., acquisition 

time, number of accumulations, intensity correction), custom information provided by the operator 

(such as operator name, laser power, sample name), and a history of data processing steps made on 

the data. 

Hardware, acquisition and processing history information is automatically filled in by LabSpec 5.  

Custom information needs to be filled in by the operator. 

For information regarding the parameters displayed in the “Parameters Information” window, please 

see the relevant section of this manual. 

Please note that the parameters displayed in the “Parameters Information” window will depend on the 

specific instrument configuration.  The image below shows a typical view of the “Parameters 

Information” window, but be aware that some of these may not be visible in your software. 

 

The information displayed in the “Parameters Information” window is useful to confirm how a specific 

measurement was made, and whether the data being viewed has been processed in some way. 

Note that the parameters information is only retained when data is saved in a LabSpec file format – 

see section 3.1.1.1, page 10, for full information about available file formats.  Data saved in LabSpec 

4 (previous generation) format may not retain information about all parameters. 
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4.4.5.2. Acquisition Parameters Information 

The “Acq” tab of the “Parameters Information” 

dialog window displays information relating to the 

hardware and software configuration used for the 

acquisition of the active data. 

 

 

 

 

 

4.4.5.3. Custom Parameters Information 

The “Custom Parameters” tab allows you to add 

specific information to a data file’s “Parameters 

Information”.   

The Date field is automatically filled at the time of 

acquisition.  The other fields are blank by default, 

but can be filled by the operator if desired. 

 

 

 

 

The Custom Parameters information tab can also be accessed through Acquisition > Custom info.  In 

this case, the “Acq” and “History” tabs are not displayed. 

For full information about using the Custom Parameters information window and how to customize it, 

please see section 3.5.1, page 30. 
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4.4.5.4. History Information 

The “History Parameters” tab shows data 

processing operations made to the file since its 

acquisition. 

The “Operation” field shows what processing 

function has been applied, and the “Param” field 

shows (where applicable) what parameters have 

been used for that function. 

 

 

4.5. Data Acquisition Icons 

4.5.1. Spectrum RTD (Real Time Display) 

      

Start a spectrum RTD acquisition. 

The spectrum real time display (RTD) provides a continuous spectrum readout of the detector.  There 

is no accumulating or averaging of the spectrum – each spectrum displayed is replaced by the next.  

The acquisition time for each spectrum is set by the user in the Control Panel (see section 9.9.1, page 

235). 

Spectrum RTD is only possible in a single spectral window range – see section 3.5.6.1, page 50.  

Extended range RTD measurements (in either multiwindow or auto scanning modes) are not possible.  

Autofocus and auto exposure modes will not be active for a spectrum RTD measurement, even if they 

are activated in Acquisition > Options. 

The spectrum RTD is useful to adjust the fine focus of the sample to optimise Raman signal, and to 

monitor whether a sample is degrading or burning.  Normally the RTD acquisition time should be kept 

small in order to allow fast and continuous spectrum read out.  Typical values are in the range 0.2s–

2s. 

To adjust the RTD acquisition time simply type the desired time (in seconds) into the box, and press 

<enter ����   >. 
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4.5.2. Detector Image RTD (Real Time Display) 

      

Start a Detector Image RTD acquisition. 

The Detector Image Real Time Display (RTD) provides a continuous full image readout of the CCD 

array detector – it is typically only used for diagnostic and maintenance purposes. 

The readout properties are set in Acquisition > RTD – see section 3.5.3, page 33. 

4.5.3. Spectrum Acquisition 

      

Start a spectrum acquisition. 

The spectrum acquisition will provide full accumulation and averaging of the spectral data, over a user 

specified range.  For more information about setting up the measurement please see information in 

this manual relating to: 

Acquisition options section 3.5.4, page 34 

Auto save  section 3.5.5, page 47 

Extended range  section 3.5.6, page 49 

Autofocus  section 3.5.8, page 59 

Auto exposure  section 3.5.10, page 65 

 

This mode is used to acquire a good quality spectrum of a sample over a user defined spectral range. 

4.5.4. Mapping Acquisition 

      

Start a multidimensional spectral array acquisition, such as time profiles, Z (depth) profiles, 

temperature profiles, XY maps, XZ and YZ slices, and XYZ datacubes. 

Mapping acquisition will include full accumulation of the spectral data, over a user specified range.  

For more information about setting up the measurement please see information in this manual relating 

to: 

Acquisition options section 3.5.4, page 34 

Auto save  section 3.5.5, page 47 

Extended range  section 3.5.6, page 49 

Autofocus  section 3.5.8, page 59 

Auto exposure  section 3.5.10, page 65 

Mapping properties section 4.5.5, page 97 
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4.5.5. Mapping Properties 

      

Opens the Mapping Properties dialog window. 

The Mapping Properties dialog window allows the properties of a multidimensional spectral array 

acquisition to be set.  This includes measurements such as time profiles, Z (depth) profiles, 

temperature profiles, XY maps, XZ and YZ slices, and XYZ datacubes. 

4.5.5.1. Mapping Properties Dialog Window 

The Mapping Properties dialog window allows the user to define the acquisition properties of a 

multidimensional spectral array acquisition.  The properties which can be set include number of data 

points, start and stop positions, and step size.  Properties are set independently for each dimension 

(such as X, Y or Z axes, time, temperature etc). 

 

4.5.5.2. Setting the Mapping Properties 

The Mapping Properties dialog window displays the following information: 

Dimension 

The available array dimensions which can be used 

for multidimensional spectral array acquisitions are 

shown. 

The active dimensions which will be used for the 

acquisition are shown and ticked.  Inactive 

dimensions which are available but will not be used 

for the acquisition are shown and unticked. 

Dimensions can be added (see section 4.5.5.4, 

page 101), deleted (section 4.5.5.5, page 101) and 

moved (see section 4.5.5.3, page 99). 

Array Size 

The number of data points which will be acquired. 

Note that the “Array Size” is directly linked to the “Increment”.  If the “Increment” is modified, the 

“Array Size” will be automatically adjusted. 



 

 

 

 

From 

The start position/value of the array.  The units are as indicated in the “Unit” 

dimensions defined on the video image, the “From” value is automatically filled in.

To 

The end position/value of the array.

dimensions defined on the video image, the “To” value is automatically filled in.

Increment 

The step size within the array.  The units are as indicated in the “Unit” 

be set if the box is ticked.  If it is unticked 

the “Array Size”, “From” and “To” values.

Note that the “Increment” is directly linked to the “Array Size”.  If the “Array Size” is modified, 

“Increment” will be automatically adjusted.

Formula 

Set a formula to describe a non-linear array (i.e., an array with non

A formula can only be set if the “Formula” field is ticked

and “Increment” fields will be deactivated and greyed out.

The formula is an arithmetic function of 

takes numerical values ranging from 0 (the first position in the array)

position in the array). 

As an example, the formula ‘(x * 

Unit 

This field displays the default unit for the dimension.  Typically this will be micrometers (µm) for X, Y 

and Z spatial dimensions, seconds (s) for time, and degrees Celsius (

dimension is added to the Mapping Parameters dialog window, the “Unit” field can be set by the user.

Relative 

This tick box controls whether the “From” and “To” positions are absolute, or relative to the current 

position. 

If “Relative” is ticked the “From” and “To” positions 

are relative to the current position

For example, if the current X position of the

motorized XY sample stage is

ranging “From”=-30 µm “To”=+20 µm wi

acquired from +20 µm to +70 µm (i.e., [+

to [+50+20] µm) 
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the array.  The units are as indicated in the “Unit” 

dimensions defined on the video image, the “From” value is automatically filled in.

the array.  The units are as indicated in the “Unit” 

dimensions defined on the video image, the “To” value is automatically filled in. 

within the array.  The units are as indicated in the “Unit” field.  The “Increment” can

If it is unticked the increment will be automatically calculated according to 

the “Array Size”, “From” and “To” values. 

Note that the “Increment” is directly linked to the “Array Size”.  If the “Array Size” is modified, 

“Increment” will be automatically adjusted. 

linear array (i.e., an array with non-uniform increment).

the “Formula” field is ticked.  If “Formula” is active, then the “From”, “To”, 

d “Increment” fields will be deactivated and greyed out. 

is an arithmetic function of x, where x is the measurement position within the array, and 

takes numerical values ranging from 0 (the first position in the array) to [Array Size 

* x) + 10’ will yield measurements at points 10, 11, 14, 19, 26...

unit for the dimension.  Typically this will be micrometers (µm) for X, Y 

nsions, seconds (s) for time, and degrees Celsius (
o
C) for temperature.  If a custom 

dimension is added to the Mapping Parameters dialog window, the “Unit” field can be set by the user.

This tick box controls whether the “From” and “To” positions are absolute, or relative to the current 

the “From” and “To” positions 

e current position. 

For example, if the current X position of the 

d XY sample stage is +50 µm, a line 

0 µm “To”=+20 µm will be 

0 µm (i.e., [+50-30] µm 
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the array.  The units are as indicated in the “Unit” field.  For X and Y 

dimensions defined on the video image, the “From” value is automatically filled in. 

The units are as indicated in the “Unit” field.  For X and Y 

.  The “Increment” can only 

the increment will be automatically calculated according to 

Note that the “Increment” is directly linked to the “Array Size”.  If the “Array Size” is modified, the 

uniform increment). 

.  If “Formula” is active, then the “From”, “To”, 

is the measurement position within the array, and 

Array Size – 1] (the last 

+ 10’ will yield measurements at points 10, 11, 14, 19, 26... 

unit for the dimension.  Typically this will be micrometers (µm) for X, Y 

C) for temperature.  If a custom 

dimension is added to the Mapping Parameters dialog window, the “Unit” field can be set by the user. 

This tick box controls whether the “From” and “To” positions are absolute, or relative to the current 



 

 

 

If “Relative” is unticked the 

positions are absolute. 

For example, if the current X position of the

motorized XY sample stage is +5

with “From” and “To” values of -3

will be acquired from -30 µm to +20 µm.

 

 

Always Show XY Parameters 

This tick box controls whether the X and Y 

parameters” is unticked the X and Y dimensions will 

within LabSpec 5. 

Use SWIFT for XY Mapping 

This tick box controls whether the SWIFT

fast mapping mode is used for XY mapping.  When 

“Use SWIFT for XY mapping” is ticked

be acquired in the SWIFT™ mode

for acquisition times ranging from <1ms through to 

1s.  When the box is unticked, the map will be 

acquired in the standard ‘point by point’ mode, 

which is suitable for acquisition times greater than 

0.5s. 

Use external trigger for CCD 

This tick box controls whether an external trigger is 

used to activate spectrum acquisition in a time 

profile.  It will only be displayed if the “Time” 

dimension is active (with no other dimensions also 

active), and if the CCD has been configured for 

triggered analysis. 

 

Minimum measurement time 

This field displays an approximate minimum measurement time for a measurement as set in the 

Mapping Properties window.  It is calculated by multiplying the total number of data points by the total 

acquisition time per point (including a theoretical CCD electronic activation/readout time).  Note that 

the actual measurement time is likely to be longer than the displayed value, since there may also be 

stage movement and other factors which will also contribute to 

4.5.5.3. Acquisition Order of an Array Measurement

The data acquisition order within a 

vertical order of the dimensions listed within the Mapping Properties dialog window.
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the “From” and “To” 

For example, if the current X position of the 

d XY sample stage is +50 µm, a line set 

30 µm and +20 µm 

0 µm to +20 µm. 

the X and Y dimensions are shown at all times.  If “Always show XY 

the X and Y dimensions will only be visible when a Video image is open 

This tick box controls whether the SWIFT™ ultra-

fast mapping mode is used for XY mapping.  When 

“Use SWIFT for XY mapping” is ticked the map will 

mode, which is suitable 

for acquisition times ranging from <1ms through to 

When the box is unticked, the map will be 

uired in the standard ‘point by point’ mode, 

which is suitable for acquisition times greater than 

This tick box controls whether an external trigger is 

to activate spectrum acquisition in a time 

profile.  It will only be displayed if the “Time” 

dimension is active (with no other dimensions also 

active), and if the CCD has been configured for 

This field displays an approximate minimum measurement time for a measurement as set in the 

Mapping Properties window.  It is calculated by multiplying the total number of data points by the total 

time per point (including a theoretical CCD electronic activation/readout time).  Note that 

the actual measurement time is likely to be longer than the displayed value, since there may also be 

stage movement and other factors which will also contribute to the total measurement time.

Acquisition Order of an Array Measurement 

The data acquisition order within a multidimensional spectral array measurement is dependent on the 

f the dimensions listed within the Mapping Properties dialog window.
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.  If “Always show XY 

only be visible when a Video image is open 

This field displays an approximate minimum measurement time for a measurement as set in the 

Mapping Properties window.  It is calculated by multiplying the total number of data points by the total 

time per point (including a theoretical CCD electronic activation/readout time).  Note that 

the actual measurement time is likely to be longer than the displayed value, since there may also be 

the total measurement time. 

measurement is dependent on the 

f the dimensions listed within the Mapping Properties dialog window. 
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In the first example shown right, “Y” is the top 

dimension, with “X” listed below it.  This means 

that the array data will be acquired in the following 

order:  

Y1 

  X1, X2, X3, X4  �   Xn 

Y2 

  X1, X2, X3, X4  �   Xn 

� 

Yn 

  X1, X2, X3, X4....Xn 

 

By modifying the order of the dimensions in the list 

(see section 4.5.5.6, page 102) it is possible to 

adjust the data acquisition order. 

 

 

In this case the order has been modified so that “X” 

is now the top dimension, and “Y” is below it. The 

acquisition order will now be:  

X1 

  Y1, Y2, Y3, Y4  �   Yn 

X2 

  Y1, Y2, Y3, Y4  �   Yn 

� 

Xn 

  Y1, Y2, Y3, Y4....Yn 

 

In the third example shown right, “Z” is the top 

dimension, with “Y” listed below it, and “X” below 

that.  This means that the array data will be 

acquired in the following order:  

Z1 

  Y1 

    X1, X2, X3, X4  �   Xn 

Z2 

  Y2 

    X1, X2, X3, X4  �   Xn 

� 

Zn 

  Yn 

    X1, X2, X3, X4....Xn 

 



 

 

 

4.5.5.4. Adding New Array Dimensions to the 

To add a new array dimension to the list in the 

Mapping Properties dialog window, right click on 

the list of dimensions, and select “Insert”.

 

 

 

Select the required dimension from the list shown 

in the Devices dialog window, and click 

Note that all motorized devices correctly configured 

on your instrument will be shown in this list.

 

 

 

The selected dimension is now displayed in the 

Mapping Properties dialog window, and is 

immediately available to be configured within a 

multidimensional spectral array measurement.

 

 

4.5.5.5. Deleting Array Dimensions from the Mapping Properties Dialog Window

To delete a dimension from the list in 

Properties dialog window, right click on the 

dimension to be deleted, and select “Remove”.

 

 

 

The selected dimension will be removed from the 

list. 

Note that the dimension can be a

again by re-inserting it from the list of available 

devices – see section 4.5.5.4, page 
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Adding New Array Dimensions to the Mapping Properties Dialog Window

To add a new array dimension to the list in the 

Mapping Properties dialog window, right click on 

s, and select “Insert”. 

the required dimension from the list shown 

in the Devices dialog window, and click [OK]. 

d devices correctly configured 

will be shown in this list. 

The selected dimension is now displayed in the 

Properties dialog window, and is 

immediately available to be configured within a 

measurement. 

Deleting Array Dimensions from the Mapping Properties Dialog Window

To delete a dimension from the list in the Mapping 

Properties dialog window, right click on the 

dimension to be deleted, and select “Remove”. 

The selected dimension will be removed from the 

Note that the dimension can be added to the list 

inserting it from the list of available 

, page 101. 
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Mapping Properties Dialog Window 

Deleting Array Dimensions from the Mapping Properties Dialog Window 



 

 

 

 

4.5.5.6. Changing the Acquisition Order of an Array Measurement

To adjust the order of dimensions listed in the 

Mapping Properties dialog window 

the dimension which is to be moved.

Select “Up” to move the dimension further up in the 

list. 

 

 

 

Select “Down” to move the dimension further down 

in the list. 

 

 

4.5.6. Extended Range Acquisition

      

Opens the Extended Range dialog window

The Extended Range dialog window controls the spectral range which will be analysed during a 

spectrum (  /  ) or multidimensional spectral array

4.5.7. Video 

      

Opens the video window and commences live read out of the video camera.  On automated systems 

(such as the XploRA™, LabRAM ARAMIS and automated LabRAM HR) the appropriate optics for 

using the video camera will also be moved into position.

4.5.7.1. Stopping the Video Read Out

To stop the video read out, click on the 

button in the icon bar.  

The image currently visible will be captured and 

displayed as a snapshot.  This snapshot image 

can be saved if desired.  See section 

LabSpec 5

 

Changing the Acquisition Order of an Array Measurement 

To adjust the order of dimensions listed in the 

pping Properties dialog window right click on 

the dimension which is to be moved. 

Select “Up” to move the dimension further up in the 

Select “Down” to move the dimension further down 

Extended Range Acquisition 

Opens the Extended Range dialog window (see section 3.5.6, page 49). 

The Extended Range dialog window controls the spectral range which will be analysed during a 

multidimensional spectral array (  /  ) acquisition. 

Opens the video window and commences live read out of the video camera.  On automated systems 

, LabRAM ARAMIS and automated LabRAM HR) the appropriate optics for 

using the video camera will also be moved into position. 

Stopping the Video Read Out 

To stop the video read out, click on the [Stop] 

will be captured and 

displayed as a snapshot.  This snapshot image 

section 3.1.1, page 

LabSpec 5 user manual 

 

Page | 102  

The Extended Range dialog window controls the spectral range which will be analysed during a 

Opens the video window and commences live read out of the video camera.  On automated systems 

, LabRAM ARAMIS and automated LabRAM HR) the appropriate optics for 
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10, for more information about options for saving 

video images. 

The video read out can be configured using the 

Video menu – see section 3.6, page 66. 

4.5.8. Extended Video 

      

Opens the Extended Video dialog window. 

The Extended Video module allows the acquisition of large area video images by montaging single 

video images. 

It is a useful tool to obtain large area images with high magnification objectives.  Typically high 

magnification objectives only have a small field of view (e.g., ~60 µm x 60 µm for a 100x objective), 

whilst low magnification objectives offer larger views (e.g., ~600 µm x 600 µm for a 10x objective) but 

at low resolution.  With the Extended Video module, the high resolution capability of high 

magnification objectives can be used without limit over the area which can be viewed. 

This module is only available for systems equipped with a motorized XY sample stage. 

4.5.8.1. Extended Video Dialog Window 

The Extended Video dialog window allows the user to define the acquisition properties of an extended 

video image acquisition, and provides information about the composition of the final image. 
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4.5.8.1.1. Setting the Extended Video Properties 

The Extended Video dialog window has the following sections: 

Minimum Image Size (µm) 

The minimum image size required for the extended video image, defined in micrometers (µm) for the 

X and Y dimensions. 

Note that because of the size of individual images and the way they overlap in the montage process 

the final image may be larger than the dimension set here.  The actual size of the extended image to 

be acquired is shown in the “Total Size” section. 

Maximum Size (pixels) 

The maximum pixel size of the final image, defined in pixels for the X and Y dimensions. 

This control is useful to reduce the file size of the final montaged image.  If this image comprises a 

large number of individual images its raw pixel size will be very large, and will result in a large image 

file.  Reducing this total pixel size to a more appropriate level will result in a small/medium image file. 

Note that as the maximum pixel size is decreased both the file size and image quality are reduced; as 

the maximum pixel size is increased both the file size and image quality are improved.  The maximum 

pixel size possible is limited according to the native pixel size of an individual image and the number 

of single images contributing to the final extended video image. 

Smooth Stitching 

When “Smooth Stitching” is ticked, the montage process will include a large overlap between each 

adjacent image.  This is useful to reduce the affect of non-uniform white light illumination on the 

sample. 

Note that when “Smooth Stitching” is used, the number of images used to create the extended video 

image is increased, and more time will be required to complete the image. 

Number of Images 

Displays the number of individual images in the X and Y dimensions required to create the specified 

extended video image. 

Total Size 

Displays the actual image size (in micrometers, µm) that will be recorded. 

Note that because of the size of individual images and the way they overlap in the montage process 

the final image may be larger than the dimension set in the “Minimum Image Size (µm)” section. 
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4.5.8.2. Acquiring an Extended Video Image 

To acquire an extended video image click on the 

Extended Video icon in the icon bar. 

Set the required minimum image size (in 

micrometers, µm) for the X and Y dimensions, and 

the desired maximum pixel size of the final 

extended video image. 

Ensure the “Smooth Stitching” box is ticked, so that 

the default smooth montaging mode is used.  This 

mode can be deactivated by unticking the box, but 

after doing this the final image quality may not be 

so good. 

 

 

 

Click on [Start Video] to start the measurement. 

The resulting extended video image can be saved 

if desired.  See section 3.1.1, page 10, for more 

information about options for saving video images. 

4.5.9. MultiPoint 

      

Opens the MultiPoint dialog window. 

The MultiPoint module allows automatic acquisition of Raman spectra at multiple positions.  Each 

position can be set in X, Y, and Z dimensions. 

This module is only available for systems equipped with motorized XY and Z sample stages. 

 

4.5.9.1. MultiPoint Dialog Window 

The MultiPoint dialog window allows the user to define a list of measurement positions, and start the 

MultiPoint acquisition. 
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4.5.9.1.1. Using the MultiPoint Dialog Window 

The MultiPoint dialog window has the following sections: 

Clear List 

Click on [Clear List] to clear all the points from the 

currently displayed list.  

Open List 

Click on [Open List] to open a previously saved 

list of multipoint positions (in .mpl format). A 

standard Windows open dialog window will be 

displayed. 

Save List 

Click on [Save List] to save the currently displayed 

list of multipoint positions (in .mpl format).  A 

standard Windows save dialog window will be 

displayed. 

List Description/Name 

Type a description or name for the list in the box. 
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MultiPoint List 

Displays the current multipoint positions. 

The list contains the following information for each 

multipoint position: 

“Comment” - description or identifier 

“X” – X axis stage position (in micrometers, µm) 

“Y” – Y axis stage position (in micrometers, µm) 

“Z” – Z axis stage position (in micrometers (µm) 

“Use” – when ticked this position will be included in 

the MultiPoint acquisition.  When unticked this 

position will be skipped during the MultiPoint 

acquisition. 

Add Point 

Click on [Add Point] to add the current XYZ 

position to the MultiPoint list. 

Acquisition 

Click on [Acquisition] to start the MultiPoint 

acquisition.  

Save Options 

Click on [Save Options] to set up the autosave 

procedure for the MultiPoint acquisition.  See 

section 4.5.9.2, page 108, for further information 

about the save options. 

When the “Save Spectra” box is ticked spectra will 

be automatically saved during the MultiPoint 

acquisition.  If the “Save Spectra” box is unticked 

spectra will not be saved automatically, but will be 

available to be saved manually at the end of the 

MultiPoint acquisition. 

 

 

 

 

 

 

 



 

 

 

 

4.5.9.2. Save Options 

The MultiPoint Save Options dialog window is used to configure the autosave options for a MultiPoint 

acquisition. 

Format 

Select from the “Format” drop down box which file 

format is to be used to save the MultiPoint spectra.  

For more information about the available file 

formats see section 3.1.1.1, page 

 

 

 

 

 

 

Folder 

Type in the root folder where the data is to be 

saved, or click on the browse [...]

the folder using the standard Windows browse 

dialog window. 

If the “Date” box is ticked, an additional folder will 

be created in the root folder, labelled DD.MM.YY 

which indicates the day (DD), month (MM) and 

year (YY) according to the computer’s clock.

date format (e.g., YY.MM.DD or DD.MM.YY) can 

be adjusted by editing the “Date”

LabSpec 5

 

The MultiPoint Save Options dialog window is used to configure the autosave options for a MultiPoint 

 

Select from the “Format” drop down box which file 

o be used to save the MultiPoint spectra.  

For more information about the available file 

, page 10. 

Type in the root folder where the data is to be 

[...] button to locate 

the folder using the standard Windows browse 

, an additional folder will 

be created in the root folder, labelled DD.MM.YY 

which indicates the day (DD), month (MM) and 

year (YY) according to the computer’s clock.  The 

date format (e.g., YY.MM.DD or DD.MM.YY) can 

be adjusted by editing the “Date” text box. 
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If the “List Description” tick box is ticked an 

additional folder will be created within the root 

directory (if “Date” is unticked) or within the “Date” 

folder (if “Date” is ticked).  The folder will be 

labelled according to the list description/name set 

in the MultiPoint Parameters dialog window. 

Note that if the “\” symbol is removed from the 

“Folder” text box the date or description label will 

be appended to the root folder name.  If the “\” 

symbol is removed from the “Date” text box, the 

description label will be appended to the date 

folder name. 

In the example shown right, data will be saved in: 

C:\Data\DD.MM.YY\description\ 

 

In the example shown right, data will be saved in: 

C:\Data-DD.MM.YY-description\ 

 

File 

Type in the file name which will be used for each 

MultiPoint spectrum which is to be saved. 

If the “Comment” tick box is ticked the file name 

will be appended with the comment specified in the 

MultiPoint Parameters dialog window. 

If the “Count” tick box is ticked the file name will be 

appended with an integer number, starting with the 

number displayed. 

 

When both “Comment” and “Count” are ticked a 

seperator can be specified 
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4.5.9.3. Creating a MultiPoint List 

To create a MultiPoint list file, open the MultiPoint 

Parameters dialog window by clicking on the 

MultiPoint icon. 

If there is already a MultiPoint list displayed, click 

on [Clear List] to clear the display.  This allows a 

new list to be created. 

Type in a description/name for the list. 

 

 

Use the video camera and XYZ motorized sample 

stage to locate a desired position to be added to 

the MultiPoint list. 

Click on [Add Point] to add the X, Y and Z 

coordinate positions (in micrometers, µm) to the 

MultiPoint list. 

Click on the “Comment” field and type in a 

comment/description for the MultiPoint position. 

Repeat the process for additional MultiPoint 

positions as desired. 

When the MultiPoint list is complete, set the save 

options if desired (by clicking on [Save Options]) 

and tick the “Save Spectra” box to activate the 

MultiPoint autosave function.  See section 4.5.9.2, 

page 108, for further information about the save 

options. 

The MultiPoint list can be saved (in .mpl format) by 

clicking on [Save List]. A standard Windows save 

dialog window will be opened. 

Set the acquisition parameters in the normal 

manner.  For more information about setting up the 

measurement please see information in this 

manual relating to: 

Acquisition options section 3.5.4, page 34 

Auto save  section 3.5.5, page 47 

Extended range  section 3.5.6, page 49 

Autofocus  section 3.5.8, page 59 

Auto exposure  section 3.5.10, page 65 
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Click on [Acquisition] to start the MultiPoint 

acquisition. 

4.5.9.4. Coordinate Positions Used for MultiPoint Acquisition 

The coordinate positions used in the MultiPoint list are taken directly from the XYZ Coords section in 

the Control Panel (see section 9.10, page 237). 

The MultiPoint list is only valid if the sample’s position on its holder (e.g., microscope slide) and XY 

motorized sample stage remains unchanged between defining the list and starting the MultiPoint 

acquisition. 

Similarly, the list is only valid if the XYZ Coord values are not reset to 0 µm in the XYZ Coords section 

in the Control Panel (see section 9.10, page 237). 

4.5.10. DuoScan 

      

Opens the DuoScan™ XY Scanning dialog window. 

The XY Scanning dialog window is used to activate the DuoScan™ laser scanning module, and 

allows the size of the scanning area to be set.  The minimum time required for the laser spot to cover 

the specified area will be displayed. 

 

Zone 

Select the type of zone used to define the DuoScan™ scan area from the “Zone” drop down box. 

o Rectangle – this allows the user to set a free rectangular area centered around the central 

laser spot position, according to the dimensions (in micrometers, µm) set in the “Width” and 

“Height” boxes. 

o Mapping Pixel – the scan area is set according to the pixel size specified in the Mapping 

Properties dialog window (see section 4.5.5, page 97).  The “Width” and “Height” boxes will 

be inactive and greyed out, since the values are taken directly from the Mapping Properties 

dialog window.  Note that if SWIFT™ ultra-fast Raman mapping is activated (see section 



 

 

 

 

4.5.5.1, page 97), the “Width” value will be

scanning in the X direction does not require DuoScan™ scanning in the X (width) direction.

o Video Cursor – the scan area is set according to the dimensions and position of the 

Rectangular Mapping cursor (see section 

“Width” and “Height” boxes wil

directly from the video Rectangular Mapping cursor.

 

Width and Height 

Type in the desired DuoScan™ area width and height, in micrometers (µm).  These boxes will only be 

active when the DuoScan™ area 

out and inactive. 

Start 

Click on [Start] to start the DuoScan™ mirrors scanning the defined area.  When DuoScan™ is 

active, this button will be changed to 

Stop 

Click on [Stop] to stop the DuoScan™ mirrors scanning the defined area.  When DuoScan™ is 

inactive, this button will be changed to 

4.5.10.1. Using DuoScan™ 

The DuoScan™ scanning mirrors can be used to acquire an average spectrum from an area of the 

sample (Scanning Mode), or to move the laser spot to specific positions on the sample surface (Point 

Mode). 

4.5.10.1.1. Scanning Mode 

In Scanning Mode DuoScan™ is used to create a 

laser macro-spot by rapidly scanning the l

across a rectangular area.  The macro

used for standard spectrum and multidimensional 

spectral array data acquisition. 

 

Click on the DuoScan icon to open the DuoScan™ 

XY Scanning dialog window. 

Select the type of zone used to 

from the “Zone” drop down box, and set the scan 

area size in the appropriate way.

o Rectangle – this allows the user to set a 

free rectangular area centered around 

the central laser spot position, according 

to the dimensions (in micrometers

set in the “Width” and “Height” boxes.
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, the “Width” value will be set to 0, because SWIFT™’s continuous 

scanning in the X direction does not require DuoScan™ scanning in the X (width) direction.

the scan area is set according to the dimensions and position of the 

Rectangular Mapping cursor (see section 5.19, page 188) on the video window.

“Width” and “Height” boxes will be inactive and greyed out, since the values are taken 

directly from the video Rectangular Mapping cursor. 

in the desired DuoScan™ area width and height, in micrometers (µm).  These boxes will only be 

active when the DuoScan™ area zone is set to Rectangle.  In other cases the boxes will be greyed 

to start the DuoScan™ mirrors scanning the defined area.  When DuoScan™ is 

active, this button will be changed to [Stop]. 

to stop the DuoScan™ mirrors scanning the defined area.  When DuoScan™ is 

inactive, this button will be changed to [Start]. 

 

The DuoScan™ scanning mirrors can be used to acquire an average spectrum from an area of the 

ample (Scanning Mode), or to move the laser spot to specific positions on the sample surface (Point 

In Scanning Mode DuoScan™ is used to create a 

spot by rapidly scanning the laser spot 

across a rectangular area.  The macro-spot can be 

used for standard spectrum and multidimensional 

icon to open the DuoScan™ 

Select the type of zone used to define the area, 

, and set the scan 

area size in the appropriate way. 

this allows the user to set a 

free rectangular area centered around 

the central laser spot position, according 

to the dimensions (in micrometers, µm) 

set in the “Width” and “Height” boxes. 

LabSpec 5 user manual 

 

Page | 112  

set to 0, because SWIFT™’s continuous 

scanning in the X direction does not require DuoScan™ scanning in the X (width) direction. 

the scan area is set according to the dimensions and position of the 

) on the video window.  The 

l be inactive and greyed out, since the values are taken 

in the desired DuoScan™ area width and height, in micrometers (µm).  These boxes will only be 

zone is set to Rectangle.  In other cases the boxes will be greyed 

to start the DuoScan™ mirrors scanning the defined area.  When DuoScan™ is 

to stop the DuoScan™ mirrors scanning the defined area.  When DuoScan™ is 

The DuoScan™ scanning mirrors can be used to acquire an average spectrum from an area of the 

ample (Scanning Mode), or to move the laser spot to specific positions on the sample surface (Point 
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o Mapping Pixel – the scan area is set 

according to the pixel size specified in 

the Mapping Properties dialog window 

(see section 4.5.5, page 97).  The 

“Width” and “Height” boxes will be 

inactive and greyed out, since the values 

are taken directly from the Mapping 

Properties dialog window.  Note that if 

SWIFT™ ultra-fast Raman mapping is 

activated (see section 4.5.5, page 97), 

the “Width” value will be set to 0, 

because SWIFT™’s continuous scanning 

in the X direction does not require 

DuoScan™ scanning in the X (width) 

direction. 

 

o Video Cursor – the scan area is set 

according to the dimensions and position 

of the Rectangular Mapping cursor (see 

section 5.19, page 188) on the video 

window.  The “Width” and “Height” boxes 

will be inactive and greyed out, since the 

values are taken directly from the video 

Rectangular Mapping cursor. 

 

Click [Start] to activate the DuoScan™ scanning 

mirrors.  

If the scan area has been set greater than the 

maximum allowable dimensions a warning 

message will be displayed.  This shows the 

maximum negative and positive displacement 

possible for the selected objective.  The area size 

set in the “Height” and “Width” boxes, or defined 

according to the map pixel, or defined by the 

rectangular video cursor, must not be greater than 

the total displacement.  In the example shown 

right, the maximum displacement is -10 µm to 

+10 µm, meaning a total displacement of 20 µm. 

The Raman measurement (spectrum or 

multidimensional spectral array) can now be set up 

and acquired in the normal way.  Remember that 

the spectrum recorded will be an average 

spectrum from the scanned area. 

Click [Stop] to stop the DuoScan™ scanning 

mirrors. 
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4.5.10.1.2. Point Mode 

When DuoScan™ is used in Point Mode, it is 

possible to move the laser spot to any position on 

the sample surface, within the maximum possible 

scan displacement.  In this mode DuoScan™ can 

be used as a substitute to the standard motorized 

stage for point-by-point XY mapping 

(multidimensional spectral array acquisition) – this 

function is particularly useful when it is not possible 

to move the sample underneath the laser beam, or 

ultra-fine step size is required (down to 

DuoScan™’s minimum step size of 50 nm). 

To use DuoScan™ in Point Mode the scanning 

mirrors must be static.  To confirm this, open the 

DuoScan™ XY scanning dialog window by clicking 

on the DuoScan icon. 

If the DuoScan™ mirrors are scanning, the [STOP] 

button will be active.  Click on [STOP] to stop the 

DuoScan™ scanning, and then click [CLOSE] to 

close the dialog window. 

 

 

 

Set the DuoScan™ module as the active XY stage 

using the ‘switch stage’ icon in the XYZ Coord 

section of the Control Panel (see section 9.10.2, 

page 238). 

The laser spot position can now be controlled by 

inputting XYZ coordinates in the XYZ Coord 

section of the Control Panel (see section 9.10, 

page 237), or by acquiring a Raman XY map 

(multidimensional spectral array) in the standard 

way.  In both cases, the laser spot is now moved 

across the sample using the DuoScan™ mirrors.  

The sample does not move. 
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4.6. Data Processing and Analysis Icons 

4.6.1. Spectral ID Search 

      

Launch the ‘one click’ Spectral ID database search for the active spectrum. 

Clicking on this icon will initiate the following processes: 

o Export the active spectrum in Grams .spc format 

o Open Spectral ID 

o Load the exported spectrum into Spectral ID 

o Run a full spectrum matching search through the active databases 

o Report the list of matching spectra, with match quality scores 

Please see the HORIBA Scientific manual “Using the Spectral ID Database Software with LabSpec 5”  

and full documentation provided with the Spectral ID database software for more information about 

Spectral ID and how it can be used and configured. 

4.6.1.1. Configuring LabSpec 5 for Correct Spectral ID Searching 

The export procedure for the ‘one click’ Spectral ID search is defined by the options set in the File > 

Save As dialog window for a Grams .spc file. 

To ensure the ‘one click’ Spectral ID search performs correctly please complete the following set up 

procedure in LabSpec 5: 

o Open a spectrum in any format 

o Click on File > Save As 

o Select “Grams (.spc)” from  the “Save as 

Type” drop down box 

o Tick the box for “Even spaced” 

o Click [Cancel]  

 

 

 

If the “Even spaced” box is not ticked, the Spectral ID search will not be performed correctly, and 

spurious results may be displayed. 
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4.6.2. Baseline Correction 

.....  

Opens the Baseline dialog window. 

Baseline correction allows a high background in a spectrum to be subtracted, to yield a spectrum with 

a flat, zero baseline.  The correction can be applied to a single spectrum or a multidimensional 

spectral array of spectra (including time profiles, Z (depth) profiles, temperature profiles, XY maps, XZ 

and YZ slices, and XYZ datacubes). 

The example shown right illustrates a spectrum 

before and after baseline correction. 

 

 

 

 

 

 

 

 

 

 

 

4.6.2.1. Baseline Dialog Window 

The Baseline dialog window allows the baseline correction to be configured and performed. 
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Options 

Set the parameters for the baseline.  Please see 

section 4.6.2.1.1, page 118, for information about 

the individual parameters and their affect on the 

baseline correction. 

 

Sub 

Click on [Sub] to subtract the current baseline from 

the active spectrum. 

Clear 

Click on [Clear] to clear the current baseline from 

the active spectrum. 

Convert 

Click on [Convert] to convert the active spectrum 

to the displayed baseline curve.  This function is 

useful to save a baseline curve in a standard 

spectrum file format.  

Note that the active spectrum will be overwritten by 

the baseline curve.  Make sure that the file is 

saved with a different name to ensure the original 

spectrum data is not permanently overwritten and 

lost. 

Auto 

Click on [Auto] to automatically fit a baseline to the 

active spectrum (based on the parameters set in 

the “Options” section) and subtract it. 

Fit 

Click on [Fit] to automatically fit a baseline to the 

active spectrum (based on the parameters set in 

the “Options” section).  The best fit baseline curve 

will be displayed on the spectrum.  It can be 

subtracted by clicking on [Sub]. 

Copy 

Click on [Copy] to copy the displayed baseline 

curve to the baseline clipboard.  

Paste 

Click on [Paste] to paste a baseline curve from the 

baseline clipboard onto the active spectrum. 
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4.6.2.1.1. Baseline Correction Options 

The Baseline options control the parameters of the baseline that will be used for baseline correction. 

 

Type 

Select the algorithm used to define the baseline 

curve. 

o Polynom: fits a polynomial curve through 

the baseline points set on the spectrum.  

The degree of the polynomial is set in the 

“Degree” drop down box. 

 

 

 

o Lines: fits a straight line between 

baseline points set on the spectrum. 

 

 

 

Degree 

Select the degree of polynomial equation used to 

create the baseline curve – this option is only used 

when the baseline “Type” is set to “Polynom”. 

In general the higher the degree the more 

adaptable the baseline curve will be to strangely 

shaped, non-uniform backgrounds. 
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Attach 

Select the “Attach” mode for manual definition of 

baseline points used to define the baseline curve. 

o No: baseline points are set at the exact 

intensity and spectral position (cm
-1

 or 

nm) specified by the user. 

 

 

 

o Yes: baseline points are forced to sit on 

the spectrum, at the spectral position 

(cm
-1

 or nm) specified by the user. 

 

 

 

The “Attach” mode is particularly important when 

defining a baseline to be used for correction of 

multidimensional spectral array data.  In this case, 

“Attach” should be set to “Yes” to ensure that the 

baseline points will adapt to the varying intensities 

of the spectra within the multidimensional spectral 

array. 

Style 

Set the display style of the baseline curve.  The 

colour, width and line style of the baseline curve 

can be set using the “Style” drop down box. 

4.6.2.2. Setting a Baseline for Baseline Correction of a Single Spectrum 

Select the spectrum which is to be baseline 

corrected. 

Click on the Baseline icon to open the Baseline 

dialog window. 

 

 

 



 

 

 

 

Select the baseline parameters within the “Options” 

section.  See section 4.6.2.1.1, page 

details about the Baseline Correction Options.

The options can be modified at

the process of creating the baseline 

displayed baseline will immediately update.

 

 

 

 

Click on [Fit] to fit a baseline curve to the 

spectrum. 

Baseline points can be manually inserted, adjusted 

and removed by using the “Add baseline 

icon (see section 5.14, page 181

baseline points” icon (see section 

in the Graphical Manipulation Toolbar.

o Click on the “Add baseline points” icon

 

 

The cursor will change from the 

cursor to the Add Baseline Points cursor

 

Left click on the spectrum to add a 

baseline point to the displayed baseline 

curve.  If there is no baseline curve on 

the spectrum the first left mouse click in 

this mode will create the baseline.

 

Hover the cursor over an existing 

baseline point.  When the cursor changes 

from the Add Baseline Points cursor

the Adjust Baseline Points cursor

click to drag the baseline point to a new 

position. 

 

o Click on the “Remove baseline points” 

icon.  

 

Hover the cursor over an existing 

baseline point.  When the cursor changes 

from the mouse cursor 

Baseline Points cursor, left click to delete 

LabSpec 5

 

Select the baseline parameters within the “Options” 

, page 118, for full 

details about the Baseline Correction Options. 

The options can be modified at any point during 

the process of creating the baseline – the 

displayed baseline will immediately update. 

to fit a baseline curve to the 

Baseline points can be manually inserted, adjusted 

and removed by using the “Add baseline points” 

181) and “Remove 

section 5.15, page 182) 

in the Graphical Manipulation Toolbar. 

Click on the “Add baseline points” icon.   

will change from the mouse 

cursor to the Add Baseline Points cursor.  

click on the spectrum to add a 

baseline point to the displayed baseline 

curve.  If there is no baseline curve on 

the spectrum the first left mouse click in 

ill create the baseline. 

over an existing 

baseline point.  When the cursor changes 

Add Baseline Points cursor to 

the Adjust Baseline Points cursor, left 

click to drag the baseline point to a new 

“Remove baseline points” 

Hover the cursor over an existing 

baseline point.  When the cursor changes 

mouse cursor to the Remove 

, left click to delete 
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the baseline point from the baseline 

curve. 

 

The entire baseline can be cleared by 

clicking on [Clear].  

When the baseline curve is completed click [Sub] 

to subtract it from the spectrum. 

4.6.2.3. Setting a Baseline for Baseline Correction of a Multidimensional Spectral Array 

The procedure as outlined above (section 4.6.2.2, page 119) should be followed, but the baseline 

curve should be created on the SpIm (spectral image) window. 

In general it is useful to have the “Attach” mode set to “Yes” when applying a baseline to the SpIm 

window, since this ensures the baseline points can adapt to the varying intensities typical in a 

multidimensional spectral array. 

Individual spectra within a multidimensional spectral array can be baseline corrected by applying the 

correction to the individual spectrum displayed in the Point window. 

When the baseline has been subtracted, ensure 

the corrected spectrum is re-inserted into the 

spectral array by clicking on the ‘blue arrow’ icon 

displayed in the point window, or click [Correct] in 

the Map Analysis dialog window (see section 4.6.9, 

page 148).  This must be done before the 

map/profile cursor is moved. 

4.6.3. Spectral Normalization and Correction 

      

Opens the Correction dialog window. 

The correction functions allow spectra to be normalized and zeroed, and for a substrate/contaminant 

spectrum to be automatically subtracted. 

4.6.3.1. Correction Dialog Window 

The Correction dialog window allows the user to apply spectral normalization and correction to both 

single spectra, and multidimensional spectral arrays. 



 

 

 

 

 

Normalize 

Click on [Normalize] to normaliz

so that the total area, sum or maximum signal

the spectrum is 100.  If the “Limits” tick box is 

ticked, the normalization will only be applied within 

the displayed limits.  In this case,

be normalized so that the area, sum, or maximum 

signal within the limits is 100.  The limits can be 

adjusted by typing values in the “Limits” boxes, or 

adjusting the cursor positions in the “Corrector” 

window.  

The normalization mode can be selected from the 

“Normalization” section of the dialog window.

Zero 

Click on [Zero] to automatically subtract a constant 

intensity value from the active spectrum 

multidimensional spectral array, 

intensity pixel is at zero.  When applied to a 

multidimensional spectral array, each spectrum in 

the array is zeroed independently.

Get 

Click on [Get] to load the active spectrum in the 

main LabSpec 5 graphical user interface (GUI) into

the “Corrector” window. 

Delete 

Click on [Delete] to clear the “Corrector” window, 

and remove the corrector spectrum displayed 

there. 

LabSpec 5

 

 

normalize each spectrum 

, sum or maximum signal of 

he “Limits” tick box is 

ation will only be applied within 

the displayed limits.  In this case, the spectrum will 

, sum, or maximum 

within the limits is 100.  The limits can be 

adjusted by typing values in the “Limits” boxes, or 

adjusting the cursor positions in the “Corrector” 

be selected from the 

of the dialog window. 

to automatically subtract a constant 

intensity value from the active spectrum or 

, so that the lowest 

When applied to a 

, each spectrum in 

the array is zeroed independently. 

to load the active spectrum in the 

graphical user interface (GUI) into 

to clear the “Corrector” window, 

and remove the corrector spectrum displayed 
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Subtract 

Click on [Subtract] to subtract the corrector 

spectrum (displayed in the “Corrector” window) 

from the active spectrum or 

spectral array. 

Multiply 

Click on [Multiply] to multiply the active spectrum 

or multidimensional spectral array

spectrum (displayed in the “Corrector” window).

Correct 

Click on [Correct] to correct the active spectrum or 

multidimensional spectral array for the contribution 

of the corrector spectrum (displayed in the 

“Corrector” window).  The intensity of the corrector 

spectrum will be automatically adjusted before 

subtraction to best fit the spectrum.

If the “Limits” tick box is ticked 

intensity adjustment will be calculated only within 

the displayed limits.  The limits can be adjusted by 

typing values in the “Limits” boxes, or adjusting the 

cursor positions in the “Corrector

This function is useful if a substrate, 

contaminant spectrum needs to be removed from a 

sample spectrum. 

Threshold 

Click on [Threshold] to threshold the active 

multidimensional spectral array.  The threshold 

function will be applied to any 

array which has a maximum intensity 

the most intensity spectrum in the array) 

the displayed threshold value set

Threshold” section.  

The threshold function will convert the spectrum to 

have zero intensity throughout its spectral range.
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subtract the corrector 

spectrum (displayed in the “Corrector” window) 

pectrum or multidimensional 

to multiply the active spectrum 

multidimensional spectral array by the corrector 

spectrum (displayed in the “Corrector” window). 

to correct the active spectrum or 

for the contribution 

of the corrector spectrum (displayed in the 

“Corrector” window).  The intensity of the corrector 

spectrum will be automatically adjusted before 

the spectrum. 

he “Limits” tick box is ticked the corrector 

intensity adjustment will be calculated only within 

the displayed limits.  The limits can be adjusted by 

typing values in the “Limits” boxes, or adjusting the 

cursor positions in the “Corrector” window. 

nction is useful if a substrate, diluent or 

contaminant spectrum needs to be removed from a 

to threshold the active 

spectral array.  The threshold 

be applied to any spectra within the 

array which has a maximum intensity (relative to 

the most intensity spectrum in the array) less than 

set in the “Limits and 

The threshold function will convert the spectrum to 

have zero intensity throughout its spectral range. 
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Corrector Window 

The current corrector spectrum will be displayed in 

the Corrector window.  Click on 

active spectrum in the main LabSpec 5

user interface (GUI) into the “Corrector” window.  

Click on [Delete] to clear the “Corrector” window, 

and remove the corrector spectrum displayed 

there. 

The spectrum in the Corrector window can b

manipulated using the stand

Manipulation Toolbar icons – see 

165.  

 

If the cursors are not visible in the Corrector 

window click on the Center Cursors icon in the Icon 

bar. 

Limits and Threshold 

Set the limits for Normalize and Correct functions 

ticking the “Limits” tick box, and typing the

(minimum) and “To” (maximum) 

The limits can also be set by adjusting the position 

of the cursors in the Corrector window.  As the 

cursors are moved the “From” and “To” values 

shown in the “Limits and Threshold” section are 

continuously updated. 

Set the threshold value by typing in the desired 

level (in percent, %) in the “Threshold

Normalization 

Select the normalization mode for the 

function. 

o {Sum} – normalize so that the sum of t

spectrum intensity is 100

o {Area} – normalize so that the area 

spectrum is 100 

o {Max} – normalize to the maximum 

intensity point in the spectrum.
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The current corrector spectrum will be displayed in 

the Corrector window.  Click on [Get] to load the 

LabSpec 5 graphical 

user interface (GUI) into the “Corrector” window.  

to clear the “Corrector” window, 

and remove the corrector spectrum displayed 

in the Corrector window can be 

manipulated using the standard Graphical 

see section 5, page 

If the cursors are not visible in the Corrector 

Cursors icon in the Icon 

e and Correct functions 

ticking the “Limits” tick box, and typing the “From” 

 limit values. 

The limits can also be set by adjusting the position 

of the cursors in the Corrector window.  As the 

cursors are moved the “From” and “To” values 

shown in the “Limits and Threshold” section are 

Set the threshold value by typing in the desired 

eshold %” box. 

ation mode for the Normalize 

e so that the sum of the 

spectrum intensity is 100 

e so that the area of the 

e to the maximum 

intensity point in the spectrum. 
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4.6.4. Smoothing 

      

Opens the Filtration dialog window. 

The smoothing or filtration functions allow spectra to be smoothed, converted to first and second 

derivative functions, or despiked.  Typically these functions allow spectral quality to be improved after 

acquisition. 

4.6.4.1. Filtration Dialog Window 

The Filtration dialog window allows the smoothing and processing functions to be configured and 

performed on both single spectra, and multidimensional spectral arrays. 

 

4.6.4.1.1. Denoise 

The Denoise function is a unique noise reduction algorithm which can be used to significantly 

enhance spectrum quality without losing subtle spectral information. 

Standard smoothing functions can result in loss of peak shape and position, and subtle features (such 

as weak shoulders on a strong band) can be lost. The Denoise function ensures that all this important 

information is retained, whilst still reducing noise in the spectrum. 

The spectra shown right illustrate the effect of the 

Denoise function. 

 

 

 

 

 

 



 

 

 

 

Two main Denoise algorithms are available from the “Denoise” drop down box:

o Standard: recommended for spectra with signal to noise 

o Lite: recommended for very noisy spectra with signal to noise 

In addition, both algorithms can be used with an integrated De

(also known as cosmic rays).  See also section 

spike filter options in LabSpec 5.

Note that the Denoise function can be automatically applied to all acquired data through the 

Acquisition > Options dialog window 

Denoise function automatically appli

applied again through the Filtration dialog window.

Using the Denoise Function 

Select the desired Denoise algorithm from the 

“Denoise” drop down box.  

 

 

 

 

 

Click [Apply] to apply the Denoise algorithm to 

active spectrum. 

4.6.4.1.2. Matrix Operations 

The functions described below require the 

“Degree”, “Size”, and “Height” values to be set

the drop down boxes, as described in the text.

Smooth 

Click on [Smooth] to apply 

smoothing function to the active spectrum.  

Savitsky-Golay smoothing fits a polynomial 

function of a specified “Degree” through a range 

(“Size”) of adjacent pixels, and

pixels with the polynomial curve.  The window 

where this operation is applied is moved across the 

entire spectrum. The “Degree” and “Size” must be 

set to an appropriate level. 

Typically the smaller the “Degree” and 

“Size” the more significant the smoothing.  Note 

that in some cases smoothing can remove or alter 

LabSpec 5

 

Denoise algorithms are available from the “Denoise” drop down box: 

Standard: recommended for spectra with signal to noise ≥ 20 

Lite: recommended for very noisy spectra with signal to noise ≤ 20 

In addition, both algorithms can be used with an integrated Despike function to remove random spikes 

(also known as cosmic rays).  See also section 3.5.4.7, page 37, for more information about other 

. 

Note that the Denoise function can be automatically applied to all acquired data through the 

> Options dialog window – see section 3.5.4.15, page 46. If a spectrum has had the 

Denoise function automatically applied through Acquisition > Options, it cannot have the function 

applied again through the Filtration dialog window. 

Select the desired Denoise algorithm from the 

apply the Denoise algorithm to the 

The functions described below require the 

“Degree”, “Size”, and “Height” values to be set in 

, as described in the text. 

to apply a Savitsky-Golay 

smoothing function to the active spectrum.   

Golay smoothing fits a polynomial 

function of a specified “Degree” through a range 

, and replaces those 

pixels with the polynomial curve.  The window 

where this operation is applied is moved across the 

The “Degree” and “Size” must be 

the “Degree” and the larger 

e significant the smoothing.  Note 

that in some cases smoothing can remove or alter 
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features in a spectrum.  Smoothing should be used 

with care. 

Der1 

Click on [Der1] to convert the active spectrum to 

its first derivative function.  At each pixel position 

the derivative is calculated using a defined range 

(“Size”) of pixels either side of it. 

Der2 

Click on [Der2] to convert the active spectrum to 

its second derivative function. At each pixel 

position the second derivative is calculated using a 

defined range (“Size”) of pixels either side of it. 

Median 

Click on [Median] to apply a non-linear median 

smoothing function to the active spectrum.  

Median smoothing replaces a spectrum pixel 

intensity value by the median of intensity values 

within a defined range (“Size”) either side of it.  

This replacement process is repeated for all pixels 

in the spectrum. 

Typically the larger the “Size” the more significant 

the median smoothing.  Note that in some cases 

median smoothing can remove or alter features in 

a spectrum.  Median smoothing should be used 

with care. 

Despike 

Click on [Despike] to remove random spikes (also 

known as cosmic rays) from a spectrum. 

A spike is calculated as a pixel which has an 

intensity greater than the average spectrum 

intensity + “Height”. 

The Despike function removes the spike and 

replaces it with a weighted average of the 

surrounding pixels. 

Note that in some cases the Despike function can 

remove or alter features in a spectrum, particularly 

when the spectrum is comprised of very sharp 

peaks.  Despike should be used with care. 

Please also see section 3.5.4.7, page 37, for more 

information about other spike filter options in 

LabSpec 5. 
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4.6.5. Fourier Transform 

      

Opens the Fourier Transform dialog window. 

The Fourier Transform function allows smoothing of a spectrum based on direct Fourier data 

transformation, applying filter and apodization functions.  The spectrum is converted into its real and 

imaginary Fourier functions, which essentially represents the spectrum as a combination of wave 

patterns of varying frequency.  Smoothing can be applied by removing high frequency contribution 

(corresponding to noise) and leaving medium and low frequency contribution (corresponding to 

Raman peaks). 

The Fourier Transform smoothing function can be performed on both single spectra, and 

multidimensional spectral arrays. 

4.6.5.1. Fourier Transform Dialog Window 

The Fourier Transform dialog window displays the Fourier functions of the active spectrum, and 

provides Apodization and Filter options for the transformation. 

 

Fourier Data 

The Fourier Data window displays the real and 

imaginary Fourier functions of the active spectrum. 

The red cursor can be used to set the high 

frequency limit – frequencies above the limit 

position will be removed from the spectrum.   

Typically the lower the cursor position the more 

smoothing is applied.  At position 0 the spectrum is 

fully smoothed (to a flat line).  At position 100 the 

spectrum is fully unsmoothed. 
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Limit 

The Limit allows manual control of the “limit” cursor 

displayed in the Fourier Data window.  Type in the 

required cursor position value (ranging between 0 

and 100) and click on [Go]. 

Apod. 

Select the type of apodization to be used in the 

Fourier transformation from the “Apod.” drop down 

box.  The apodization reaches zero at the Limit 

position.  

Four modes are available: 

o No: no apodization 

o Line: linear apodization function 

o Sqrt: parabolic apodization function 

o Cos: cosine apodization function 

Filter 

Select whether a filter will be used for the Fourier 

transformation, using the “Filter” drop down box. 

Two modes are available: 

o No: no filter 

o Traffic: traffic filter 

OK 

Click [OK] to permanently apply the smoothing to 

the active spectrum, and close the Fourier 

Transform dialog window.  

Cancel 

Click [Cancel] to close the Fourier Transform 

without applying the smoothing.  The original 

spectrum will be left unchanged. 

 

4.6.5.2. Using the Fourier Tranform Function to Smooth a Spectrum 

Select a spectrum to be smoothed. 

Open the Fourier Transform dialog window by 

clicking on the Fourier Transform icon in the Icon 

Bar. 
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The real and imaginary Fourier functions of the 

active spectrum are displayed in the Fourier Data 

window. 

 

 

 

 

Select the Apodization and Filter functions to be 

used from the “Apod.” and “Filter” drop down 

boxes. 

Set the limit for high frequency contribution which 

will be removed from the spectrum.  The spectrum 

is continuously updated allowing the degree of 

smoothing to be monitored.  The limit can be set in 

two ways: 

o Click and drag the red cursor in the 

Fourier Data window. 

 

 

 

 

 

 

 

 

o Type in the required limit into the “Limit” 

box, and click [Go]. 

When the desired smoothing is achieved, click 

[OK] to permanently apply the smoothing to the 

active spectrum and close the Fourier Transform 

dialog window.  Alternatively click [Cancel] to 

close the dialog window without applying any 

smoothing to the spectrum.  The spectrum will be 

left unchanged. 
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4.6.6. Math 

      

Opens the Math dialog window. 

Arithmetic functions can be applied to the intensity values of an active spectrum. Additionally, the 

Extended Range spectral acquisition “Combine data” function can be applied post-acquisition through 

the Math dialog window. 

The Math functions can be performed on both single spectra, and multidimensional spectral arrays. 

4.6.6.1. Math Dialog Window 

The Math dialog window contains text input boxes so that arithmetic functions can be created, and 

then applied to the active data. 

 

Const+ 

The “Const+” function adds a constant intensity 

value to all pixels in the active spectrum.  

Type in the desired constant, and click on the 

adjacent [Go] button to apply the function to the 

active spectrum.  A positive constant will be added 

to the spectrum intensity values; a negative 

constant will be subtracted from the spectrum 

intensity values. 
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The example right shows the result of applying 

“Const+”=1200 to a spectrum. 

 

 

 

 

 

 

 

 

 

 

The “Const+” function can also be applied using 

the “Add Constant” icon in the Graphical 

Manipulation toolbar – see section 5.8, page 171. 

 

Const* 

The “Const*” function multiplies all pixel intensity 

values in the active spectrum by a constant value. 

Type in the desired constant, and click on the 

adjacent [Go] button to apply the function to the 

active spectrum.  A constant greater than zero will 

increase the spectrum intensity; whilst a constant 

less than zero will decrease the spectrum intensity. 
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The example right shows the result of applying 

“Const*”=2.5 to a spectrum. 

 

 

 

 

 

 

 

 

 

 

The “Const*” function can also be applied using 

the “Multiply by Constant” icon in the Graphical 

Manipulation toolbar – see section 5.9, page 172. 

Func 1 and Func 2 

The “Func 1” and “Func 2” sections allow arithmetic functions to be created by the user, and applied 

to the active spectrum. 

The terminology used for these functions are as follows: 

o x and y refer to the intensity values of spectra which are open in LabSpec 5.  x is the active 

data file, and y is the other data file open in LabSpec 5.  In the event that there is more than 

one spectrum which could be used for y a message box will ask for the y spectrum to be 

chosen from a list. 

o a, b and c refer to the values of the first, second and third axes of the active data file. 

o Standard arithmetic functions are also possible, including +, -, *, /, ^, exp, log, sin, asin, 

cos, acos, tan, atan, abs, sqrt etc. 

As an example, if “Func 1” = x + y, x refers to the intensity value at each pixel of the active spectrum, 

and y refers to the intensity value at each pixel of another open spectrum.  Assume the two spectra 

have values as follows (where a represents the spectral axis): 

a �  1 2 3 4 5 6 7 8 ... 
x �  10 12 15 25 22 13 10 7 ... 
y �  1 2 3 2 1 1 4 3 ... 
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applying the function x + y to this data will result in the following values: 

a �  1 2 3 4 5 6 7 8 ... 
x ����  11 14 18 27 23 14 14 10 ... 
y �  1 2 3 2 1 1 4 3 ... 

 

As another example, if “Func 1” = x + 2*a, x refers to the intensity value of each pixel of the active 

spectrum, and a refers to the first axis (i.e., the spectral axis, with units Raman shift, cm
-1

) value of 

each pixel.  Assume the data has the following values: 

a �  1 2 3 4 5 6 7 8 ... 
x �  10 12 15 25 22 13 10 7 ... 

 

applying the function x + 2*a to this data will result in the following values: 

a �  1 2 3 4 5 6 7 8 ... 
x ����  12 16 21 33 32 25 24 23 ... 

 

Type in the desired arithmetic function for either 

“Func 1” or “Func 2”, select the appropriate active 

spectrum (corresponding to x in the function), and 

click on the adjacent [Go] button. 

If there are multiple options for the spectrum y, a 

“Select Y” message box will ask for the desired 

spectrum to be selected.  Click on the desired 

spectrum and then click [OK] to complete the 

arithmetic procedure. 

 

 

 

Combine 

The “Combine” function allows individual spectral 

windows in an Extended Range spectrum 

acquisition to be glued together to yield a single 

spectrum.  This process can also be applied 

automatically during an Extended Range 

acquisition (see section 3.5.6, page 49). 

Equally, the “Combine” function can be used to 

create an average spectrum from all open spectra. 

Set the options as desired:  

o Adjust intensity levels: if this box is ticked 

the baselines of the individual spectral 

windows will be adjusted prior to gluing, 
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to yield a seamless final spectrum.  See 

section 3.5.6.3, page 53, for full 

information about this mode. 

o Remove combined datas: if this box is 

ticked the individual spectra or spectral 

windows will be deleted after 

combination, leaving only the single 

combined spectrum on screen. 

Click on the adjacent [Go] button to apply the 

“Combine” process. 

4.6.7. Peak Searching and Fitting 

      

Opens the Peaks dialog window. 

The Peak Searching and Fitting module allows peaks in a spectrum to be automatically labelled by 

their position, and full peak fitting can be carried out to fully characterise peak parameters such as 

position, amplitude, full width at half maximum height (FWHM) and area.  Overlapping peaks can be 

fully deconvoluted through the peak fitting routine. 

The Peak Searching and Fitting functions can be performed on both single spectra, and 

multidimensional spectral arrays. 

4.6.7.1. Peaks Dialog Window 

The Peaks dialog window allows the peak searching, labelling and fitting processes to be configured 

and applied, and displays the peak parameters after fitting. 
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Peak Options 

Select the appropriate function to be used for peak 

fitting from the “Function” drop down box.  Three 

default functions are provided: 

o Gaussian 

o Lorentzian 

o Mixed Gaussian-Lorentzian 

Other functions can be defined by clicking on 

[Functions...] in the Peaks dialog window – see 

4.6.7.5, page 145, for full information. 

If “Use area” is ticked the peak fitting routines will 

also calculate the area of the peak(s).  When “Use 

area” is unticked only the default peak parameters 

will be calculated.  These are peak position, 

amplitude (i.e., maximum height), full width at half 

maximum height (FWHM) and (for mixed 

Gaussian-Lorentzian functions) the degree of 

Gaussian contribution. 

Search Options 

Set the parameters used for automatic peak 

searching and identification.  The search routine 

locates local intensity maxima, and assigns these 

as peaks. 

A local maximum must be greater than a certain 

percentage of the maximum intensity in the whole 

spectrum.  The “Level (%)” parameter defines this 

percentage of maximum spectral intensity.  

Typically, as the “Level (%)” is increased, only the 

most intense peaks will be identified.  If low 

intensity peaks need to be identified “Level (%)” 

should be reduced. 

A local maximum is assumed to exist within a finite 

number of adjacent data points.  The “Size (pnt)” 

parameter defines this number.  Typically, as the 

“Size (pnt)” is increased, only peaks which are 

widely separated will be identified.  If close lying 

peaks need to be identified “Size (pnt)” should be 

reduced. 

The “Level (%)” and “Size (pnt)” values can be set 

by typing a value in the appropriate box, or using 

the appropriate scroll bar.  The peak labelling 

displayed on the active spectrum will update 

continuously, so that the result can be monitored. 
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Fitting Options 

Set the parameters used for the peak fitting 

routine.  This routine uses a Levenberg-Marquardt 

non-linear peak fit algorithm, and iteratively adjusts 

all peak parameters to minimise the standard error. 

The maximum number of iterations can be set by 

typing an appropriate number in the “Iteration” box.  

Typically the larger the iteration number the more 

accurate the final fit result will be, but the longer 

the process will take. 

The algorithm can be set to miss out data points 

within the spectrum, in order to speed up the 

process.  “Skip (pnt)” is used to define how many 

points are missed. 

o “Skip (pnt)” = 0, all data points are used 

for the fitting. 

o “Skip (pnt)” = 1, every second data point 

is used for the fitting routine. 

o “Skip (pnt)” = 2, every third data point is 

used for the fitting routine. 

Typically as “Skip (pnt)” is increased the fit results 

will be less accurate, but the process will be faster. 

The “Error” box displays the Standard Error 

between the fit result and the raw data.  The 

smaller the Standard Error the more accurate the 

fit result. 

If the “Baseline” box is ticked the peak fitting 

routine will additionally fit the specified baseline.  

The baseline must be specified first, using the 

Baseline dialog window – see section 4.6.2.1, 

page 116. 

Search 

Click on [Search] to start the automatic peak 

searching and identification routine. 

Adjust the “Size (pnt)” and “Level (%)” to control 

the searching and identification procedure – see 

above for more information about these 

parameters. 

Approx 

Click on [Approx] to run the peak approximation 

routine, which can be used to estimate the initial 

peak parameters prior to fitting.  Only the peak 

position and width parameters are adjusted. 
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The peak approximation is a useful function to 

assist in complex peak fitting procedures.  Running 

the peak approximation routine prior to full fitting 

ensures that the starting parameters are realistic 

and close to their true values.  This reduces the 

possibility of the peak fitting routine locating an 

incorrect solution. 

Fit 

Click on [Fit] to run the peak fitting routine, which 

can be used to calculate peak position, amplitude, 

full width at half maximum height (FWHM), 

Gaussian contribution and area.  

The peak fitting routine can only be used if peaks 

have been located in the spectrum.  Peaks can be 

located automatically using the [Search] button, or 

manually by using the “Add peak” icon in the 

Graphical Manipulation toolbar (see section 5.10, 

page 173). 

Init 

Click on [Init] to restore peak parameters in the 

SpIm window of a multidimensional spectral array 

to the initial values before the peak approximation 

[Approx] or fitting [Fit] routines were run. 

Clear 

Click on [Clear] to clear all peaks from the active 

spectrum. 

Convert 

Click on [Convert] to convert the active spectrum 

to the sum of the displayed peaks.  This function is 

useful to save a theoretical peak fit solution in a 

standard spectrum file format.  

Note that the active spectrum will be overwritten by 

the sum of the displayed peaks.  Make sure that 

the file is saved with a different name to ensure the 

original spectrum data is not permanently 

overwritten and lost. 

Peaks... 

Click on [Peaks...] to open the Peak Parameters 

dialog window, to view and manually set peak 

position, amplitude, full width at half maximum 

height (FWHM), Gaussian contribution and area 

values for all peaks labelled on a spectrum.  
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See section 4.6.7.2, page 139, for more 

information. 

Variables...  

Click on [Variables...] to open the Peak Variables 

dialog window, to view and set initial values and 

maximum/minimum values for variables within the 

peak fitting routine. 

See section 4.6.7.3, page 141 for more 

information.  

Options... 

Click on [Options...] to open the Peak Options 

dialog window, to view and set display options for 

the peak labelling and fitting. 

See section 4.6.7.4, page 144, for more 

information. 

Functions... 

Click on [Functions...] to open the Peak Functions 

dialog window, to view and create user defined 

peak shape functions. 

See page 4.6.7.5, page 145, for more information. 

4.6.7.2. Peak Parameters Dialog Window 

The Peak Parameters dialog window displays peak position, amplitude, full width at half maximum 

height (FWHM), Gaussian contribution and area for all peaks labelled on a spectrum.  The 

parameters can be manually adjusted and fixed so that the parameter is not varied during the fitting 

routine. 

The Peak Parameters dialog window for individual spectra (e.g., Spectrum window, or Point window 

of a multidimensional spectral array) has the following appearance: 

 

The Peak Parameters dialog window for multidimensional spectral arrays (e.g., the SpIm window of a 

multidimensional spectral array) has the following appearance: 
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Each row displays the parameters for a single peak: 

o p – peak position, in units as displayed on the spectrum’s X axis, typically Raman shift 

(cm
-1

) or nanometers (nm). 

o a – peak amplitude, in units as displayed on the spectrum’s Y axis, typically counts (cnt), or 

counts per second (cnt/s). 

o w – peak full width at half maximum height (FWHM) in units as displayed on the spectrum’s 

X axis, typically Raman shift (cm
-1

) or nanometers (nm). 

o g – Gaussian contribution in a mixed Gaussian-Lorentzian function.  The value of Gaussian 

contribution varies from 0 (no Gaussian contribution, fully Lorentzian) through to 1 (fully 

Gaussian).  The g column is only displayed when a mixed Gaussian-Lorentzian function is 

selected for peak fitting in the main Peaks dialog window (see section 4.6.7.1, page 135). 

o Formula – the function used for the peak fitting, as selected in the main Peaks dialog 

window (see section 4.6.7.1, page 135).  “Gauss()” = Gaussian, “Loren()” = Lorentzian, 

“GaussLoren()” = mixed Gaussian-Lorentzian. 

o Area – the area of the peak, in area units based on the units displayed on the spectrum’s X 

and Y axes.  The Area column is only displayed if the “Use area” box is ticked in the main 

Peaks dialog window (see section 4.6.7.1, page 135). 

o Fix - the “Fix” tick boxes to the right of each of the p, a, w and g parameters allows a 

parameter to be fixed.  A fixed parameter will not be varied during the peak fitting routine.  

When a box is ticked the parameter is fixed. When a box is unticked the parameter will be 

varied during the fitting routine. 

o Map – the “Map” tick boxes (which are only displayed for the SpIm window of a 

multidimensional spectral array) to the right of each of the p, a, w, g and Area parameters 

allows a profile or map image to be generated based on the parameter.  For example, it is 

possible to create an image based on peak position, illustrating how the peak position varies 

across the map area.  To display a profile/image based on a peak parameter tick the 

appropriate box and click [Apply].  A new map profile/image will be created.  To close the 

map profile/image, untick the box and click [Apply]. 

Copy 

Click on [Copy] to copy the parameters displayed 

in the Peak Parameters dialog window.  

Parameters which have been copied can be 

pasted into other programmes (such as Microsoft 

Office) or into the Peak Parameters dialog window. 

This function can be used to copy peak parameters 

from one spectrum and paste them to another 

spectrum (using [Paste]). 
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Paste 

Click on [Paste] to paste parameters in the Peak 

Parameters dialog window.  

This function can be used to paste peak 

parameters copied (using [Copy]) from one 

spectrum to another. 

Apply 

Click on [Apply] to update the peak(s) displayed 

on the spectrum according to parameters in the 

Peak Parameters dialog window. 

This button must be used when parameters are 

manually adjusted in the Peak Parameters dialog 

window.  The peaks displayed on the spectrum will 

not reflect the new parameters until [Apply] is 

clicked. 

4.6.7.3. Peak Variables Dialog Window 

The Variables dialog window displays the initial parameters used in the peak fitting procedure, and 

the minimum and maximum values they can take during the fitting procedure.  In most cases the 

default values are suitable for general peak fitting routines, but in specific cases the initial parameters 

and their minimum and maximum values can be manually adjusted as required. 

 

The Variables dialog shows the initial (“init”) values, and minimum (“Min”) / maximum (“Max”) values 

for each parameter: 

o p – peak position, in units as displayed on the spectrum’s X axis, typically Raman shift 

(cm
-1

) or nanometers (nm).  In the example shown above, the initial value of p is the X axis 

position (“x”) at which the peak is initially located or positioned, and the position can be 

varied from p-5 to p+5 during the fitting procedure. 

o w – peak full width at half maximum height, in units as displayed on the spectrum’s X axis, 

typically Raman shift (cm
-1

) or nanometers (nm). In the example shown above, the initial 

value of w is 3, and width can be varied from 0.001 to 200 during the fitting procedure. 

o a – peak amplitude, in units as displayed on the spectrum’s Y axis, typically counts (cnt), or 

counts per second (cnt/s).  In the example shown above, the initial value of a is the Y axis 

position (“y”) at which the peak is initially located or positioned, and the amplitude can be 

varied from 0 to the maximum Y axis value (“maxy”) during the fitting procedure. 



 

 

 

 

o b, c, d – parameters within the Gaussian/Lorentzian equations.  In the example shown 

above, the initial values of 

of the maximum Y axis value (“

maximum Y axis value (“maxy”) during the fitting procedure.

o g – Gaussian contribution in a mixed Gaussian

above, the initial value of 

Gaussian contribution, fully Lorentzian) through to 1 (fully Gaussian) during the fitting 

procedure. 

 

If “Copy” is ticked for a parameter the “m

peak in the Peak Parameters dialog window.  This allows “min” and “max” parameters to be set 

individually for each peak.  Note that

automatically located using [Search]

Manipulation toolbar (see section 

 

4.6.7.3.1. Setting the Init, Min and Max Values in the Variables Dialog Window

Left click in the desired parameter “init”, “min” or “max” box and insert the desired value.  Add 

information for each parameter as required.

 

 

4.6.7.3.2. Adding Parameters 

Additional categories can be added by right 

clicking on one of the parameter name boxes and 

selecting “Insert row”.  

 

 

 

 

A new row will be inserted above the selected 

position, and will display the same name 

“min” and “max” values as the original 
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parameters within the Gaussian/Lorentzian equations.  In the example shown 

above, the initial values of b, c and d are 0, and they can be varied from either the inverse 

of the maximum Y axis value (“-maxy”) or the minimum Y axis value 

maximum Y axis value (“maxy”) during the fitting procedure. 

Gaussian contribution in a mixed Gaussian-Lorentzian function.  In

above, the initial value of g is 0.5, and the Gaussian contribution can be varied from 0 (no 

Gaussian contribution, fully Lorentzian) through to 1 (fully Gaussian) during the fitting 

for a parameter the “min” and “max” values will be displayed individually for each 

peak in the Peak Parameters dialog window.  This allows “min” and “max” parameters to be set 

individually for each peak.  Note that the “Copy” box must be ticked before the peaks are 

[Search] or manually located using the “Add peak” icon in the Graphical 

section 5.10, page 173). 

Setting the Init, Min and Max Values in the Variables Dialog Window 

Left click in the desired parameter “init”, “min” or “max” box and insert the desired value.  Add 

parameter as required. 

 to the Variables Dialog Window 

Additional categories can be added by right 

clicking on one of the parameter name boxes and 

A new row will be inserted above the selected 

position, and will display the same name and “init”, 

as the original parameter. 
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parameters within the Gaussian/Lorentzian equations.  In the example shown 

they can be varied from either the inverse 

value (“miny”), to the 

Lorentzian function.  In the example shown 

, and the Gaussian contribution can be varied from 0 (no 

Gaussian contribution, fully Lorentzian) through to 1 (fully Gaussian) during the fitting 

in” and “max” values will be displayed individually for each 

peak in the Peak Parameters dialog window.  This allows “min” and “max” parameters to be set 

before the peaks are 

or manually located using the “Add peak” icon in the Graphical 

Setting the Init, Min and Max Values in the Variables Dialog Window 

Left click in the desired parameter “init”, “min” or “max” box and insert the desired value.  Add 



 

 

 

Double click on the parameter name box to allow 

the name to be edited.  Type in the desir

category name. 

 

 

 

 

Click on any other parameter name

the new name. 

 

 

 

 

The name given to the new parameter must 

exactly match the name used in definition of 

functions in the Peak Functions dalog window (see 

section 4.6.7.5, page 145).  The “init”, “min” and 

“max” values must be set to appropriate values.

4.6.7.3.3. Deleting Parameters from the Variables Dialog Window

Parameters can be deleted by right clicking on the 

parameter name boxes which is to be deleted and 

selecting “Remove row”. 

 

 

 

 

The parameter will be deleted from the Variables 

dialog window. 
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name box to allow 

the name to be edited.  Type in the desired 

parameter name box to register 

The name given to the new parameter must 

exactly match the name used in definition of 

functions in the Peak Functions dalog window (see 

).  The “init”, “min” and 

o appropriate values. 

Deleting Parameters from the Variables Dialog Window 

Parameters can be deleted by right clicking on the 

parameter name boxes which is to be deleted and 

The parameter will be deleted from the Variables 
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4.6.7.4. Peak Options Dialog Window 

The Peak Options dialog window allows control of the display options for the peak labelling and fitting. 

 

The following peak labelling and fitting display components can be controlled: 

Text 

Click on the Text “Style” drop down box to set the font, font style, font size and font color used to 

display the peak position on the spectrum.  If “Show” is ticked the peak position will be displayed on 

the spectrum.  Note that if “Use data style” is ticked the colour will be set to match the spectrum color.  

If “Use data style” is unticked the colour will be set according to the selection made in the “Style” drop 

down box. 

Arrow 

Click on the Arrow “Style” drop down box to set the colour, width and line style for the arrow marker 

indicating the peak position.  If “Show” is ticked the arrow marker will be displayed on the spectrum.  

Note that if “Use data style” is ticked the colour will be set to match the spectrum color.  If “Use data 

style” is unticked the colour will be set according to the selection made in the “Style” drop down box.   

Shape 

Click on the Shape “Style” drop down box to set the colour, width and line style for the individual peak 

shape(s) displayed on the spectrum.  If “Show” is ticked the peak shape(s) will be displayed on the 

spectrum. Note that if “Shape multicolor” is ticked the colour will be automatically selected from a 

default palette; in this case, when multiple shapes are displayed on a single spectrum each shape will 

be a different color.  If “Shape multicolor” is unticked the colour will be set according to the selection 

made in the “Style” drop down box; in this case, when multiple shapes are displayed on a single 

spectrum each shape will be the same colour. 

Sum 

Click on the Sum “Style” drop down box to set the colour, width and line style for the sum spectrum 

(i.e., the combination spectrum created by summing all the peak shapes displayed).  If “Show” is 

ticked the sum spectrum will be displayed on the spectrum. 

Residual 

Click on the Residual “Style” drop down box to set the colour, width and line style for the residual 

spectrum (i.e., the difference between the sum spectrum and the raw data).  If “Show” is ticked the 

residual spectrum will be displayed on the spectrum. 
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Format 

Click on the Format left hand “Style” drop down 

box to set the number of display characters for the 

peak position value. 

 

 

 

 

 

Click on the Format right hand “Style” drop down 

box to set the number of decimal places to be 

displayed for the peak position value. 

 

 

 

 

 

Use data style 

When “Use data style” is ticked the display color of the peak label text and arrow marker will be set to 

match the spectrum color.  If “Use data style” is unticked the color will be set according to the 

selection made in the respective “Style” drop down box. 

Shape multicolor 

If “Shape multicolor” is ticked the individual peak shape display colour will be automatically selected 

from a default palette; in this case, when multiple shapes are displayed on a single spectrum each 

shape will be a different color.  If “Shape multicolor” is unticked the colour will be set according to the 

selection made in the “Style” drop down box; in this case, when multiple shapes are displayed on a 

single spectrum each shape will be the same colour. 

Attach arrow 

If “Attach arrow” is ticked the peak arrow marker will be positioned immediately above the peak.  If 

“Attach arrow” is unticked the peak arrow marker will be positioned at the top of the spectrum window. 

4.6.7.5. Peak Functions Dialog Window 

The Peak Functions dialog window allows custom peak fitting formulae to be defined, so that shapes 

other than the default Gaussian, Lorentzian and mixed Gaussian-Lorentzian can be used.  For 

example, with the Peak Functions dialog window peak shapes such as Voigt or asymmetric Gaussian 

can be used. 
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To define a custom peak shape formula type the shape name in a “Name” text box, and input the 

formula in the “Formula” text box.  The name will be displayed in the main “Functions” drop down box 

in the main Peaks dialog window. 

Any parameter can be used, but it must also be defined as a parameter in the Peak Variables dialog 

window (see section 4.6.7.3, page 141). Note that certain parameters are predefined: 

o p – peak position, in units as displayed on the spectrum’s X axis, typically Raman shift 

(cm
-1

) or nanometers (nm). 

o a – peak amplitude, in units as displayed on the spectrum’s Y axis, typically counts (cnt), or 

counts per second (cnt/s). 

o w – peak full width at half maximum height (FWHM) in units as displayed on the spectrum’s 

X axis, typically Raman shift (cm
-1

) or nanometers (nm). 

 

 

4.6.8. Profile 

      

Opens the Profile dialog window. 

The Profile dialog window displays an intensity profile across an image (such as optical image, or two 

dimensional Raman mapped image). 
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Profile 

The “Profile” window displays the image intensity 

profile at the cursor position.  The scales for the X 

and Y axes are taken directly from the image itself.  

The profile is created in either a horizontal (X axis) 

or vertical (Y axis) direction in the image, 

depending on the selection made in the drop down 

box: 

o Hor – horizontal (X axis) 

o Ver – vertical (Y axis) 

Corr 

Click on [Corr] to modify the image based on 

manipulation made to the profile.  For example, if 

the profile displayed in the Profile dialog window is 

smoothed, clicking on [Corr] will apply the same 

smoothing function to the entire image in the 

horizontal or vertical dimensions (according to the 

selection of “Hor” or “Ver” in the drop down box). 

4.6.8.1. Displaying an Intensity Profile from an Image 

To display an intensity profile from an image (such 

as optical image, or two dimensional Raman 

mapped image) open the image file. 

In the case of a two dimensional Raman mapped 

image click on the image window (either “Map” or 

“Score”).  Select the component from which the 

profile is to be created, using the tags in the right 

hand Data bar (see section 6.3, page 199). 

Ensure the cursor mode in the image window is set 

to “Cross” (right click and select “Cursor”, and then 

choose “Cross” from the Style drop down box). 

Open the Profile dialog window by clicking on the 

Profile icon in the Icon bar. 

Position the cursor at the point of the image from 

where the profile is to be created. 
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Select “Hor” or “Ver” from the drop down box in the 

Profile dialog window to create an intensity profile 

in the horizontal (X axis) direction or vertical (Y 

axis) direction respectively. 

The profile is displayed in the Profile dialog 

window.  Standard data processing functions (such 

as smoothing, peak fitting or baselining) and 

copy/paste functions can be used with this profile. 

 

Click [Close] to close the Profile dialog window. 

4.6.9. Map Analysis 

      

Opens the Map Analysis dialog window. 

The Map Analysis dialog window displays the positions and settings for the “Red”, “Green” and “Blue” 

cursors which are used to create intensity profiles and images from multidimensional spectral arrays 

(including time profiles, Z (depth) profiles, temperature profiles, XY maps, XZ and YZ slices, and XYZ 

datacubes).  The positions and settings can also be manually configured in this dialog window. 

 

Use 

If the “Use” box is ticked for a set of cursors (“Red”, “Green” or “Blue”) then a profile or image will be 

generated displaying the average intensity between the two cursors.  The cursor positions are set by 

clicking the “Red”, “Green” or “Blue” cursor icons in the left hand Graphical Manipulation bar (see 

section 5.2, page 166) and dragging the cursors to the desired positions on either the “SpIm” or 

“Point” windows, or by typing in desired values into the “From” and “To” boxes in the Map Analysis 

dialog window. 

Note that if “Use” is unticked for all three cursors and “Green/Blue” is also unticked, the “Map” window 

will not be displayed.  To redisplay the “Map” window make sure that at least one of the “Use” boxes 

are ticked, or that the “Green/Blue” box is ticked. 
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Baseline 

If the “Baseline” box is ticked for a set of cursors (“Red”, “Green” or “Blue”) then the cursor region is 

first baselined before calculation of the average intensity between the cursors.  This mode is useful to 

ensure that the image created truly reflects peak intensity and not general background intensity 

(perhaps from fluorescence or photoluminescence). 

From and To 

Displays the beginning (“From”) and end (“To”) spectral positions for a set of cursors (“Red”, “Green” 

or “Blue”).  These can be manually adjusted by typing in desired values and clicking [OK]. 

Green/Blue 

If the “Green/Blue” box is ticked an additional profile/image is displayed, showing the ratio of average 

intensities of the “Green” and “Blue” cursors (i.e., [IntensityGREEN] / [IntensityBLUE]).  This display is 

useful to visualize a change in peak ratios within a multidimensional spectral array. 

To remove the “Green/Blue” intensity profile/image untick the box. 

Spectrum 

If the “Spectrum” box is ticked the “Point” window is displayed, showing the spectrum at the current 

cursor position. 

Note that if the “Spectrum” box is unticked, the “Point” window will not be displayed.  To redisplay the 

“Point” window tick the “Spectrum” box. 

In the event that the “Point” window is accidentally deleted within the main LabSpec 5 graphical user 

interface (GUI), use the following procedure to re-display the window: 

o open the Map Analysis dialog window 

o untick the “Spectrum” box 

o click [OK] 

o re-open the Map Analysis dialog window 

o tick the “Spectrum” box 

o click [OK] 

o the Point window is now displayed in the main LabSpec 5 graphical user interface (GUI) 

Correct 

Click on [Correct] to update the multidimensional 

spectral array with the “Point” spectrum after it has 

been processed/modified in some way (for 

example, smoothing or baselining). 

The “Point” window only displays data held within 

the multidimensional spectral array, so if the 

spectrum in the “Point” window is modified it is 

necessary to update the actual data in the array by 

clicking on [Correct].  If this is not done, when the 

cursor on the profile/image is moved the 

modifications will be lost – the next time the 

spectrum is displayed in the “Point” window it will 

return to its original form. 
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Load 

Click on [Load] to load a cursor parameters file (in 

.ngp format) so that a previously saved 

configuration of the Map Analysis dialog window 

can be recalled and applied. 

Save 

Click on [Save] to save a cursor parameters file (in 

.ngp format) so that the current configuration of the 

Map Analysis dialog window can be saved, and 

recalled at any time. 

Convert 

Click on [Convert] to convert an existing image file 

into the LabSpec 5 multidimensional spectral array 

format, including “SpIm”, “Point” and “Map” 

windows.  

4.6.10. Create Spectral Profile 

      

Opens the Spectral Profile dialog window. 

The Spectral Profile dialog window allows a 1D multidimensional spectral array to be created from 

individual spectra, and for spectra to be added to, deleted from, and inserted into an existing 1D 

multidimensional spectral array.  This function is useful to create profiles from spectra where there is 

sequential change in some experimental parameter (e.g., reaction temperature, or concentration). 

Name 

Type the desired name for a new profile in the 

“Name” text box before clicking on [New] to create 

the profile. 

 

 

 

 

 

New 

Click on [New] to create a new spectral profile, 

using the active spectrum as the first spectrum in 

the profile.  
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If the “Multi” function is active (see section 3.4.2, 

page 23) then all open spectra will be added to the 

spectral profile when it is created.  In this case, the 

active spectrum will be added first, followed by all 

other open spectra in the order they appear within 

the right hand Data bar. 

See section 4.6.10.1, page 152, for further 

information. 

Add 

Click on [Add] to add the active spectrum to the 

end of the spectral profile. 

See section 4.6.10.2, page 153, for further 

information. 

Insert 

Click on [Insert] to add the active spectrum to the 

spectral profile at the position shown by the cursor 

in the “Map” window. 

See section 4.6.10.3, page 153, for further 

information. 

Delete 

Click on [Delete] to delete a spectrum from the 

spectral profile.  The spectrum at the position 

shown by the cursor in the “Map” window will be 

deleted. 

See section 4.6.10.4, page 154, for further 

information. 

XYZ 

Click on [XYZ] to rotate an XYZ multidimensional 

spectral array so that the data is formatted in the 

default Z.Y.X format (e.g., a Z-stack of YX maps).  

See section 4.5.5.3, page 99, for information about 

controlling the acquisition order for 

multidimensional spectral arrays. 
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4.6.10.1. Creating a New Spectral Profile 

Using File > Open menu, or the Open icon (  / 

 ) open the individual spectra which are to be 

used to create the spectral profile. 

Open the Spectral Profile dialog window by clicking 

on the Create Spectral Profile icon. 

Type into the “Name” text box a name for the new 

profile. 

 

 

 

 

 

Select the first spectrum to be added to position 1 

in the new profile, and click [New] to create the 

profile.  The new profile will be created in two 

ways, depending whether the “Multi” function is 

active (see section 3.4.2, page 23): 

o “Multi” active: the active spectrum will be 

added to position 1 in the profile, followed 

by all other open spectra, in the order 

they appear within the right hand Data 

bar. 

o “Multi” inactive: the active spectrum will 

be added to position 1 in the profile.  No 

other spectra will be added to the profile.  

Additional spectra can be added to the 

profile using the [Add] button (see 

section 4.6.10.2, page 153) or [Insert] 

button (see section 4.6.10.3, page 153). 

When the profile is created, the standard “SpIm”, 

“Point” and “Map” windows associated with a 

multidimensional spectral array will be displayed.  

The profile can now be analysed in the normal 

way, using cursors and modelling. 

 

 

 



 

 

 

The profile will be created with each spectru

assigned to an integer value on the X axis

X axis label is set to “Points”

scaling and axis label use the Data Range dialog 

window, accessed through the Data

menu, the Data Range icon (

the keyboard short cut <CTRL>

3.3.2, page 20, for more information

Data Range dialog window. 

Save the spectral profile (in .ngc format) by 

activating the “SpIm” window and using the 

Save As menu, or the Save icon (

4.6.10.2. Adding Spectra to a Spectral Profile

To add a spectrum into an existing Spectral Profile, 

use File > Open menu, or the Open icon 

 /  ), or the keyboard short cut 

open the spectrum which is to be added.

Select the spectrum, and click on 

automatically add the spectrum at the end of the 

spectral profile.  For example, if the profile already 

has spectra at positions 1, 2 and 3, a new 

spectrum added to the profile will be at position 4.

4.6.10.3. Inserting Spectra into a Spectral 

To insert a spectrum into an existing Spectral 

Profile, use File > Open menu, or the Open 

(  /  ), or the keyboard short cut 

to open the spectrum which is to be inserted.

In the profile “Map” window, activate the c

select the position at which the new spectrum is to 

be inserted. 

 

 

 

Select the spectrum which is to be inserted, and 

click on [Insert] to insert it at the position indicate

by the cursor. 

In a default spectral profile, the other spectra 

originally at and above this position will be shifted 
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The profile will be created with each spectrum 

assigned to an integer value on the X axis, and the 

X axis label is set to “Points”.  To modify the 

use the Data Range dialog 

Data > Data Range 

 /  ), or by using 

<CTRL>+D.  See section 

information about the 

Save the spectral profile (in .ngc format) by 

activating the “SpIm” window and using the File > 

Save As menu, or the Save icon (  /  ). 

Adding Spectra to a Spectral Profile 

To add a spectrum into an existing Spectral Profile, 

> Open menu, or the Open icon   (

, or the keyboard short cut <CTRL>+O to 

the spectrum which is to be added. 

lick on [Add] to 

automatically add the spectrum at the end of the 

spectral profile.  For example, if the profile already 

has spectra at positions 1, 2 and 3, a new 

spectrum added to the profile will be at position 4. 

Inserting Spectra into a Spectral Profile 

To insert a spectrum into an existing Spectral 

> Open menu, or the Open on       

), or the keyboard short cut <CTRL>+O 

um which is to be inserted. 

In the profile “Map” window, activate the cursor and 

which the new spectrum is to 

Select the spectrum which is to be inserted, and 

to insert it at the position indicated 

In a default spectral profile, the other spectra 

originally at and above this position will be shifted 
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upwards in the profile.  For example, if spectra A, B 

and C are currently at positions 1, 2 and 3 in a 

profile of form 1A, 2B, 3C, when 

inserted at position 2, the new profile will take the 

form 1A, 2D, 3B, 4C. 

In a spectral profile where the scale has been 

manually modified using the Data Range dialog 

window (see section 3.3.2, page 

last positions of the profile will remain fixed.  The 

positions of spectra within the profile will be 

adjusted when a spectrum is inserted.  For 

example, if spectra A, B and C are currently at 

positions 1, 2 and 3 in a manually scaled

form 1A, 2B, 3C, when spectrum D is inserted at 

position 2, the new profile will ta

1.66D, 2.33B, 3C.  If necessary the profile can be 

rescaled using the Data Range dialog window after 

the spectrum has been inserted. 

4.6.10.4. Deleting Spectra from a Spectral Profile

In the profile “Map” window, activate the cursor and 

select the position from which a spectrum is to be 

deleted. 

 

 

 

Click on [Delete] to delete the spectrum from the 

position indicated by the cursor position.

In a default spectral profile, the other spectra 

above this position will be shifted downwards in the 

profile.  For example, if spectra A, B, C and D are 

currently at positions 1, 2, 3 and 4 in a profile of 

form 1A, 2B, 3C, 4D, when spectrum B is deleted, 

the new profile will take the form 1A, 2C, 3D.

In a spectral profile where the scale has been 

manually modified using the Data Range dialog 

window (see section 3.3.2, page 

last positions of the profile will remain fixed.  The 

positions of spectra within the profile will be 

adjusted when a spectrum is deleted.  For 

example, if spectra A, B, C and D are currently at 

positions 1, 2, 3 and 4 in a manually scaled profile 

of form 1A, 2B, 3C, 4D when spectrum B is 
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upwards in the profile.  For example, if spectra A, B 

and C are currently at positions 1, 2 and 3 in a 

profile of form 1A, 2B, 3C, when spectrum D is 

inserted at position 2, the new profile will take the 

In a spectral profile where the scale has been 

manually modified using the Data Range dialog 

, page 20), the first and 

last positions of the profile will remain fixed.  The 

a within the profile will be 

adjusted when a spectrum is inserted.  For 

example, if spectra A, B and C are currently at 

manually scaled profile of 

C, when spectrum D is inserted at 

, the new profile will take the form 1A, 

If necessary the profile can be 

rescaled using the Data Range dialog window after 

 

Deleting Spectra from a Spectral Profile 

In the profile “Map” window, activate the cursor and 

select the position from which a spectrum is to be 

to delete the spectrum from the 

position indicated by the cursor position. 

profile, the other spectra 

above this position will be shifted downwards in the 

profile.  For example, if spectra A, B, C and D are 

currently at positions 1, 2, 3 and 4 in a profile of 

form 1A, 2B, 3C, 4D, when spectrum B is deleted, 

ake the form 1A, 2C, 3D. 

In a spectral profile where the scale has been 

manually modified using the Data Range dialog 

, page 20), the first and 

last positions of the profile will remain fixed.  The 

positions of spectra within the profile will be 

adjusted when a spectrum is deleted.  For 

pectra A, B, C and D are currently at 

positions 1, 2, 3 and 4 in a manually scaled profile 

of form 1A, 2B, 3C, 4D when spectrum B is 
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deleted, the new profile will take the form 1A, 2.5C, 

4D.  If necessary the profile can be rescaled using 

the Data Range dialog window after the spectrum 

has been deleted. 

4.6.11. Modelling 

      

Opens the Model dialog window. 

The Model dialog window is used to set up and perform a direct classical least squares (DCLS) 

modelling procedure on multidimensional spectral arrays (including time profiles, Z (depth) profiles, 

temperature profiles, XY maps, XZ and YZ slices, and XYZ datacubes) using a set of reference 

component spectra.  This procedure is used to identify the distribution of the reference component 

spectra within the spectral array to create a profile/image based on the component distribution.  The 

component spectra can be either manually selected (from previously saved spectra, or from within the 

spectral array) or automatically created by LabSpec 5 using a clustering algorithm. 

4.6.11.1. The DCLS Modelling Procedure 

At each position within the multidimensional spectral array the DCLS modelling procedure finds a 

linear combination of the reference component spectra which best fits the raw data.  The resulting 

profile/image is created by showing the contribution (‘score’) of each component (‘loading’) as a 

profile/image. 

For example, if there are three loadings (A, B, and C) with scores (x, y and z) the sum, S, of the linear 

combination is represented by: 

S = [ x * A ] + [ y * B ] + [ z * C ] 

A, B, C are the loadings, e.g., reference spectra of pure components. 

x, y, z are the scores, e.g., the ‘amount’ of each loading necessary so that S matches the raw data. 

 

Normalized Modelling 

When the modelling procedure is normalized (i.e., the “Normalize” box is ticked prior to performing the 

modelling procedure), the reference component spectra (loadings) are normalized before the 

modelling procedure takes place. 

The scores are normalized so that the combination of all scores adds to 100%.  If normalization is 

turned off after normalized modelling has been performed, the scores are shown as their true values. 

Unnormalized Modelling 

When the modelling procedure is unnormalized (i.e., the “Normalize” box is unticked prior to 

performing the modelling procedure), the reference component spectra (loadings) are used with their 

raw intensities during the modelling procedure.  Unnormalized modelling must be used if quantitative 

analysis is required, since the actual intensity of each reference component spectrum relates directly 

to the its concentration. 
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The scores are shown as their true values.  If normalization is turned on after unnormalized modelling 

has been performed, the scores are displayed as normalized values so that the combination of all 

scores adds to 100%. 

4.6.11.2. The “Create” Clustering Procedure 

The “Create” clustering procedure automatically identifies a number of reference component spectra 

(loadings) using a factor analysis algorithm.  This algorithm searches the entire multidimensional 

spectral array and locates a number of clusters of similar spectra, where the average of each cluster 

is as different from the other cluster averages as possible.  The number of clusters is specified in the 

“Factors” drop down box. 

Once the average spectra have been identified in this way they are used as loadings in the DCLS 

modelling procedure, as described above (section 4.6.11.1, page 155). 

4.6.11.3. The Model Dialog Window 

The Model dialog window allows reference component spectra to be manually added to the modelling 

procedure, in addition to automatic generation of component spectra with subsequent modelling using 

the “Create” clustering procedure.  The display mode of the modelling result can also be configured 

through the dialog window. 

 

Name 

Type in a name in the “Name” text box for each reference component spectrum to be used in the 

modelling procedure, prior to clicking on [Get] to start the modelling.  See section 4.6.11.4, page 158, 

for more information about how to use the modelling procedure. 

Factors 

Select the number of factors to be automatically created using the “Create” clustering procedure.  See 

section 4.6.11.5, page 162, for more information about how to use the automatic “Create” clustering 

procedure. 

Thr(%) 

Type in a value (in percent, %) in the “Thr(%)” text box to set the intensity threshold for the automatic 

“Create” clustering procedure.  The threshold ensures that low intensity spectra will be excluded from 

the “Create” clustering procedure – spectra with a maximum signal level less than the threshold value 

(in percent, %) of the highest signal intensity within the entire spectra array will be ignored. 
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Allow Negative Scores 

If “Allow negative scores” is ticked the scores for the loadings can take both positive and negative 

values.  If it is unticked the scores for the loadings can only take positive values.  See section 

4.6.11.1, page 155, for an explanation of the modelling procedure, and what the ‘scores’ and 

‘loadings’ are. 

Show Error Map 

If “Show error map” is ticked an additional score profile/image will be displayed based on the error 

between the sum of the linear combination and the raw data.  Regions of high error (bright intensity) 

indicate a bad fit, and could be caused by a missing reference component spectrum. 

To remove the error profile/image untick the “Show error map” box. 

Model Sum 

If “Model sum” is ticked the sum of the linear combination will be displayed in the “Point” window, in 

addition to the score/loading information.  Select the colour for the sum spectrum from the drop down 

box. 

Error Text 

Select the text colour from the drop down box for the error value displayed in the “Point” window. 

Normalize Model 

The normalization mode for the modelling procedure can be controlled using the “Normalize model” 

tick box.  See section 4.6.11.1, page 155, for more information about the modelling procedure and 

normalization. 

Get 

Click on [Get] to load the currently active spectrum 

as a reference component spectrum and start the 

modelling procedure.  See section 4.6.11.4, page 

158, for more information about how to use the 

modelling procedure. 

Get All 

Click on [Get All] to load in multiple model spectra 

saved from a previous modelling procedure, and 

start a new modelling procedure using them.  This 

function is useful to apply a modelling procedure to 

a spectral array using identical reference 

component spectra used for previous spectral 

array modelling. 

See section 4.6.11.4.1, page 161, for more 

information about using the [Get All] button to start 

a modelling procedure with previously saved 

reference component spectra. 
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Create 

Click on [Create] to start the automatic “Create” 

clustering procedure and subsequent modelling.  

See 4.6.11.5, page 162, for more information 

about how to use the automatic “Create” clustering 

procedure 

4.6.11.4. How to Model a Multidimensional Spectral Array 

The DCLS modelling procedure can be used with any multidimensional spectral array (including time 

profiles, Z (depth) profiles, temperature profiles, XY maps, XZ and YZ slices, and XYZ datacubes).  

The procedure described here assumes that a spectral array file is currently open, with the “SpIm”, 

“Point” and “Map” windows visible. 

Open the Model dialog window by clicking on the 

Modelling icon. 

Select whether loading scores can take both 

positive and negative values, or just positive values 

using the “Allow negative scores” tick box.  If 

“Allow negative scores” is ticked the scores for the 

loadings can take both positive and negative 

values.  If it is unticked the scores for the loadings 

can only take positive values.  See section 

4.6.11.1, page 155, for an explanation of the 

modelling procedure, and what the ‘scores’ and 

‘loadings’ are.  In general “Allow negative scores” 

should be unticked, and it is recommended that it 

is ticked for specialized analysis only. 

Select the normalization mode of the modelling 

procedure, by either ticking or unticking the 

“Normalize model” box.  For general analysis of the 

spectral array, and characterisation of component 

distribution normalized modelling will be suitable.  

If quantitative analysis of component distribution 

within the spectral array is required, unnormalized 

modelling must be used.  See section 4.6.11.1, 

page 155, for more information about the 

normalization modes. 

Select a spectrum which is to be used as a 

reference component spectrum in the modelling 

procedure.  The spectrum can be selected in two 

ways: 

o Locate a ‘pure’ reference component 

spectrum from within the spectral array 

using the cursor in the “Map” window.  
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Click on the “Point” window to select the 

spectrum. 

o Open an existing spectrum file (saved in 

any standard LabSpec spectrum format) 

using File > Open, or the Open icon (

 /  ), or the keyboard short cut 

<CTRL>+O.  Click on the spectrum 

window and select the spectrum.  If 

multiple spectra are opened, ensure the 

correct spectrum is selected. 

In the Model dialog window type in a name for the 

reference component spectrum in the “Name” text 

box.  This step is not essential, but good naming of 

reference component spectra can assist analysis 

and understanding of the results obtained at the 

end of the modelling procedure.  If a name is not 

needed, then ensure the “Name” text box is blank 

– delete any entry which is already present. 

 

Click on [Get] in the Model dialog window.  The 

selected spectrum will be loaded, and the 

modelling procedure will be started.  Two new 

windows will be created in addition to the standard  

“SpIm”, “Point” and “Map” windows:  

o “Scores” window – displays the 

profile/image based on the loading 

scores calculated by the modelling 

procedure. 

o “Model” window – displays the reference 

component spectra used by the 

modelling procedure. 

Note that the cursors displayed in the “Map” and 

“Score” windows are linked, and both will move 

when one is manipulated with the mouse.  
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Repeat the process to add more reference 

component spectra to the modelling procedure, by 

selecting (one at a time) additional spectra and 

clicking on [Get] for each spectrum.  The “Score” 

and “Model” window will update each time. 

 

 

 

 

 

 

Continue until all necessary reference component 

spectra have been included in the model for the 

spectral array. 

The error profile/map can be used to check that 

there are no regions of high error, which often 

indicates that a further reference component 

spectrum is necessary.  The error profile/map can 

be activated by ticking the “Show error map” box.  

It will be displayed as another colored image in the 

“Score” window. 

 

 

 

Once the modelling procedure has been 

completed the “Point” window displays the 

following spectra: 

o Raw data:  ——— 

o Sum: *  ——— 

o Components: 
+
  ——   ——   —— 

In addition, in the top right hand corner of the 

window a summary of the modelling result is 

displayed.  This shows the contribution of each 

reference component spectrum, and the error.
‡
  

The contribution is displayed as actual score (if 

“Normalize model” is unticked) or as relative 

percent (if “Normalize model” is ticked). 
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[*]   Sum spectrum will only be displayed if “Model sum” is 

ticked, and its color will be according to the color drop down 

box. 

[
+
]   Components will be sequentially colored using a default 

palette.  The first three components are displayed as red, 

green, and blue. 

[
‡
]   The display color of the error text will be according to the 

“Error text” color drop down box. 

The modelling results can be saved with the 

spectral array data by activating the “SpIm” window 

and saving the file in LabSpec 5 .ngc format.  The 

save dialog window is accessed using 

File > Save As..., clicking on the Save icon (  / 

 ), or using the keyboard shortcut <CTRL>+S.  

When the spectral array file is next opened the 

“Score” and “Model” windows will also open. 

4.6.11.4.1. Using a Previously Saved Set of Reference Component Spectra 

The How to Model a Multidimensional Spectral Array procedure outlined above is based on each 

reference component spectrum being selected and modelled individually, on a one by one basis.  It is 

also possible to recall a previously used set of reference component spectra, and load all spectra 

simultaneously.  This is useful if you wish to model a number of spectral arrays in exactly the same 

way, using exactly the same reference component spectra. 

Saving the Reference Component Spectra 

To save a set of reference component spectra associated with a multidimensional spectral array 

model, activate the “Model” window, and save the reference component spectra as a single file (in 

.ngs or .tsf formats) using File > Save All. 

Opening and Loading the Reference Component Spectra 

The procedure described here assumes that a spectral array file is currently open, with the “SpIm”, 

“Point” and “Map” windows visible. 

Open the single file (in .ngs or .tsf format) containing the reference component spectra  using File > 

Open, the Open icon (  /  ), or the keyboard short cut <CTRL>+O.  The spectra will be opened 

within a “Model” window. 

Open the Model dialog window by clicking on the 

Modelling icon. 

Activate the “Model” window, and click on [Get All] 

in the Model dialog window.  

The modelling procedure will be launched using all 

of the reference component spectra.  The “Score” 

and “Model” windows will be created once the 

modelling procedure is completed. 
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4.6.11.5. How to Automatically Create a Model for a Multidimensional Spectral Array 

The procedure described here assumes that a spectral array file is currently open, with the “SpIm”, 

“Point” and “Map” windows visible. 

Open the Model dialog window by clicking on the 

Modelling icon. 

Select whether loading scores can take both 

positive and negative values, or just positive values 

using the “Allow negative scores” tick box.  If 

“Allow negative scores” is ticked the scores for the 

loadings can take both positive and negative 

values.  If it is unticked the scores for the loadings 

can only take positive values.  See section 

4.6.11.1, page 155, for an explanation of the 

modelling procedure, and what the ‘scores’ and 

‘loadings’ are.  In general “Allow negative scores” 

should be unticked, and it is recommended that it 

is only ticked for specialized analysis only. 

 

Select the normalization mode of the modelling 

procedure, by either ticking or unticking the 

“Normalize model” box.  For general analysis of the 

spectral array, and characterisation of component 

distribution normalized modelling will be suitable.  

If quantitative analysis of component distribution 

within the spectral array is required, unnormalized 

modelling must be used.  See section 4.6.11.1, 

page 155, for more information about the 

normalization modes. 

 

Type in a generic name for the component spectra 

in the “Name” text box.  The created component 

spectra will be labelled sequentially in the form 

name_1, name_2 etc. This step is not essential, 

but good naming of reference component spectra 

can assist analysis and understanding of the 

results obtained at the end of the modelling 

procedure.  If a name is not needed, then ensure 

the “Name” text box is blank – delete any entry 

which is already present. 
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Type in a value (in percent, %) in the “Thr(%)” text 

box to set the intensity threshold for the “Create” 

clustering procedure.  The threshold ensures that 

low intensity spectra will be excluded from the 

“Create” clustering procedure – spectra with a 

maximum signal level less than the threshold value 

(in percent, %) of the highest signal intensity within 

the entire spectra array will be ignored.  For 

general analysis 10% is suitable, but the value 

should be adjusted as required. 

 

Select from the “Factors” drop down box the 

number of component spectra which are to be 

created using the clustering algorithm. 

Note that the number of component spectra should 

be chemically meaningful.  If in doubt, start with a 

small number, and increase it if the modelling 

results do not look correct. 

 

 

Click on [Create] to start the “Create” clustering 

procedure, and subsequently launch the modelling 

procedure using the created component spectra.  

The “Score” and “Model” windows showing the 

results will be created once the modelling 

procedure has been completed.  

The modelling results can be saved with the 

spectral array data by activating the “SpIm” window 

and saving the file in LabSpec 5 .ngc format.  The 

save dialog window is accessed using 

File > Save As..., clicking on the Save icon (  / 

 ), or using the keyboard shortcut <CTRL>+S.  

When the spectral array file is next opened the 

“Score” and “Model” windows will also open. 
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4.7. Stop Active Function Icon 

4.7.1. Stop Active Function 

      

Stop the current software function (including data acquisition and data processing). 
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5. Graphical Manipulation Toolbar 

The Graphical Manipulation toolbar located on the left hand side of the LabSpec 5 graphical user 

interface (GUI) provides access to a range of spectrum manipulation and analysis functions. 

This is an active toolbar, and its appearance and content will update according to the currently 

selected window.  For example, the options appearing in this toolbar when a spectrum is active will 

differ from those appearing when a video image is active. 

Note that when clicked an icon will be locked 

down.  Only one icon can be active and locked 

down at a time. 

At the end of each icon’s description, a list of windows where the icon is available in the Graphical 

Manipulation toolbar is given.  The possible windows are as follows: 

Spectrum 

The spectrum display window for individual spectra acquired using the real time display (RTD) 

acquisition (  /  ) and spectrum acquisition (  /  ) modes. 

Video 

The video display window for optical images acquired with the integrated microscope camera(s). 

SpIm 

The overlay of all spectra within a multidimensional spectral array. 

Point 

The spectrum at the current cursor position within a multidimensional spectral array. 

Map 

The cursor intensity profile/image display created from a multidimensional spectral array. 

Score 

The score profile/image created by DCLS modelling of a multidimensional spectral array 

Model 

The reference component spectra used for DCLS modelling of a multidimensional spectral array. 

5.1. Pointer 

 

Activates the cursor (pointer) so that individual X axis and/or Y axis values can be read from the 

window.  The cursor values will be displayed in the Status bar (see section 7.5, page 202). 

The cursor can be configured using the Cursor dialog window, by right clicking and selecting “Cursor” 

- see section 8.11, page 219.  A number of cursor modes are available: 
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Spectrum, SpIm, Point, Model windows 

o Line – single vertical line cursor, displaying the X axis position (S) of the cursor and the 

intensity (I) of the spectrum at the cursor position. 

o Cross – cross hair cursor, displaying the X axis position (S) and Y axis position (I) of the 

cursor. 

o Level – cross hair cursor which tracks the intensity of the spectrum, displaying the X axis 

position (S) and Y axis position (I) of the cursor.  In this case, the Y axis position is 

equivalent to the spectrum intensity at the cursor position. 

o Double – two vertical cursors, displaying the X axis position (S) of each cursor and the width 

between the two cursors (W). 

o Peak – three linked vertical cursors, the central one locking to the maximum intensity pixel in 

a peak, and the outer two locking to the pixels closest to the full width at half maximum 

height (FWHM) of the peak.  The Peak cursor displays the X axis position (S), intensity (I) 

and approximate full width at half maximum height (W) of the peak at the cursor position. 

Video, Map, Score windows 

o Cross – cross hair cursor, displaying the X axis position (X) and Y axis position (Y) of the 

cursor, and pixel intensity (I) at the cursor position.  For the Map and Score windows, the 

spectrum associated with the cursor position will be displayed in the Point window. 

o Rect – rectangular cursor (resizeable by left clicking and dragging the drag points), 

displaying the X axis position (X) and Y axis position (Y) of the bottom, right hand corner of 

the rectangular cursor.  For the Map and Score windows, the average spectrum from within 

the rectangle is displayed in the Point window. 

Left click to position the cursor at any point on the 

spectrum/profile/image, or alternatively left click 

and drag to move the cursor to the desired 

position. 

If one or both of the cursors are not visible on the 

spectrum/image, do one of the following: 

o Click on the “Center Cursors” icon in the 

Icon bar– see 4.4.3, page 92. 

 

o Right click and select “Center cursor”. 

Available for: Spectrum, Video, Model 

5.2. Map Analysis Cursors (SpImRed, SpImGreen, SpImBlue) 

           

Activates the map analysis cursors, allowing profiles/images corresponding to the average intensity 

between the cursor pairs to be generated for multidimensional spectral arrays.  Three map analysis 

cursor pairs are available:  Red (SpImRed), Green (SpImGreen) and Blue (SpImBlue). 



 

 

 

Left click to position the closest cursor 

the click position, or alternatively left click and drag 

to move the closest cursor to the desired position.

Note that the map analysis cursors can be set to 

have a fixed width.  To do this, right click and 

select “Red cursor”, “Green cursor” or “Blue cursor” 

and tick “Fixed width”.  When the cursors have a 

fixed width, left click and drag to scroll the two 

cursors along the spectrum.  In this case, it is not 

possible to individually position each cursor in the 

pair. 

If one or both of the cursors are not visible on the 

spectrum/image, do one of the following:

o Click on the “Center Cursors

Icon bar– see 4.4.3, page 

 

o Right click and select “Center

The map analysis cursors should be operated in “Double” mode 

“Green cursor” or “Blue cursor”, and select “Double” from the “Style” drop down box.

The Map Analysis cursors should be used in conjunction with the Map Analysis dialog window

section 4.6.9, page 148. 

Available for: SpIm, Point 

5.3. Remove Spike 

 

Activates a spike removal tool, allowing random spikes (also known as cosmic rays) to be manually 

removed from a spectrum. 

When this icon is active, the mouse cursor 

changes to the Remove Spike cursor.
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Left click to position the closest cursor of the pair at 

the click position, or alternatively left click and drag 

to move the closest cursor to the desired position. 

Note that the map analysis cursors can be set to 

ixed width.  To do this, right click and 

select “Red cursor”, “Green cursor” or “Blue cursor” 

“Fixed width”.  When the cursors have a 

fixed width, left click and drag to scroll the two 

In this case, it is not 

to individually position each cursor in the 

If one or both of the cursors are not visible on the 

spectrum/image, do one of the following: 

Cursors” icon in the 

, page 92. 

Center cursor”. 

The map analysis cursors should be operated in “Double” mode – right click and select “Red cursor”, 

“Green cursor” or “Blue cursor”, and select “Double” from the “Style” drop down box.

The Map Analysis cursors should be used in conjunction with the Map Analysis dialog window

a spike removal tool, allowing random spikes (also known as cosmic rays) to be manually 

When this icon is active, the mouse cursor 

cursor. 
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right click and select “Red cursor”, 

“Green cursor” or “Blue cursor”, and select “Double” from the “Style” drop down box. 

The Map Analysis cursors should be used in conjunction with the Map Analysis dialog window- see 

a spike removal tool, allowing random spikes (also known as cosmic rays) to be manually 



 

 

 

 

Left click the Remove Spike cursor 

the spectrum to remove it. 

 

 

 

 

 

 

 

 

 

 

 

Note that if used on a true Raman peak the Remove Spike tool will modify the peak shape and 

intensity; it should only be used on spikes, 

Please see the following sections for other spike removal tools available in 

Spike Filter  section 3.5.4.7

Despike  section 4.6.4.1.2

Denoise  section 3.5.4.15

 

Available for: Spectrum, Point, Model

5.4. Correct Shape 

 

Activates a pencil drawing tool, allowing manual modification of spectral features.

When this icon is active, the mouse cursor 

changes to the Correct Shape cursor.

Left click and drag the Correct 

draw the new spectrum shape as desired.

Available for: Spectrum, Point, Model

 

LabSpec 5

 

cursor on a spike in 

Note that if used on a true Raman peak the Remove Spike tool will modify the peak shape and 

intensity; it should only be used on spikes, and should be used with care. 

Please see the following sections for other spike removal tools available in LabSpec 5

3.5.4.7, page 37 

4.6.4.1.2, page 126 

3.5.4.15, page 46, and section 4.6.4.1.1, page 125

Spectrum, Point, Model 

tool, allowing manual modification of spectral features.

When this icon is active, the mouse cursor 

hape cursor.  

orrect Shape cursor to 

draw the new spectrum shape as desired. 

Spectrum, Point, Model 
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Note that if used on a true Raman peak the Remove Spike tool will modify the peak shape and 

LabSpec 5: 

125 

tool, allowing manual modification of spectral features. 

1 500

1 500



 

 

 

5.5. Zoom 

 

Activates the Zoom cursor, allowing a small area of a spectrum/profile/image to be studied in det

This icon can be activated with the 

When this icon is active, the mouse cursor 

changes to the Zoom cursor.  

Left click and drag the Zoom cursor to select the 

area which will be displayed in the window.

 

 

 

 

 

 

 

 

 

 

 

To rescale the window do one of the following:

o Click on the “Scale Normalizati

the Icon bar– see 4.4.1

 

o Use the <CTRL>+N keyboard short cut 

for “Scale Normalization”.

 

o Right click and select “Rescale”

 

Available for: Spectrum, Video, SpIm, Point, Map, Score, Model
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, allowing a small area of a spectrum/profile/image to be studied in det

This icon can be activated with the <CTRL>+M keyboard shortcut. 

When this icon is active, the mouse cursor 

oom cursor to select the 

area which will be displayed in the window. 

rescale the window do one of the following: 

Click on the “Scale Normalization” icon in 

4.4.1, page 91. 

+N keyboard short cut 

“Scale Normalization”. 

Right click and select “Rescale” 

Spectrum, Video, SpIm, Point, Map, Score, Model 

500 1 000

Raman Shift (cm
-1

)

500 600
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-1

)

LabSpec 5 user manual 

 

Page | 169  

, allowing a small area of a spectrum/profile/image to be studied in detail.  

1 500

700



 

 

 

 

5.6. Intensity Shift 

 

Activates the Intensity Shift cursor, 

spectra and profiles, Z axis for images)

When this icon is active, the mouse cursor 

changes to the Intensity Shift cursor.

Left click and drag the Intensity 

spectrum, profile or image window to adjust the 

scaling. 

o Dragging upwards (as in the example 

shown right) will make the upper display 

limit of the intensity axis be reduced.

This is equivalent to zooming in on the 

intensity axis; for images the affect will be 

to brighten the image. 

o Dragging downwards will make the upper 

display limit of the intensity axis be 

increased.  This is equivalent to zooming 

out on the intensity axis; for images the 

effect will be to darken the image.

 

 

 

Note that this function is purely a display function 

it does not affect the actual data of the 

 

Available for:  Spectrum, Video, SpIm, Point, Map, Score, Model

5.7. Scale Shift 

 

Activates the Scale Shift cursor, allowing the 

or lower values. 

When this icon is active, the mouse cursor 

changes to the Scale Shift cursor.
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cursor, allowing the upper display limit of the intensity axis (Y axis for 

spectra and profiles, Z axis for images) to be manually scaled. 

, the mouse cursor 

cursor. 

ntensity Shift cursor on the 

spectrum, profile or image window to adjust the 

(as in the example 

will make the upper display 

limit of the intensity axis be reduced.  

This is equivalent to zooming in on the 

intensity axis; for images the affect will be 

 

Dragging downwards will make the upper 

y limit of the intensity axis be 

This is equivalent to zooming 

out on the intensity axis; for images the 

effect will be to darken the image. 

Note that this function is purely a display function – 

it does not affect the actual data of the spectrum. 

Spectrum, Video, SpIm, Point, Map, Score, Model 

hift cursor, allowing the display scales of the X and Y axes to be shifted to higher 

When this icon is active, the mouse cursor 

cursor. 
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of the intensity axis (Y axis for 

isplay scales of the X and Y axes to be shifted to higher 

1 000 1 500

Raman Shift (cm
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)

1 000 1 500

Raman Shift (cm
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)



 

 

 

 

Left click and drag the Scale S

spectrum, profile or image window to shift 

the X and Y axes.  

 

 

 

 

 

 

 

 

 

 

To reset the X and Y axes scales do one of the 

following: 

o Click on the “Scale Normalizati

the Icon bar– see section 

 

o Use the <CTRL>+N keyboard short cut 

for “Scale Normalization”.

 

o Right click and select “Rescale”

Available for:  Spectrum, Video, SpIm

5.8. Add Constant 

 

Activates the Add Constant cursor, allowing a 

from all pixels in the active spectrum (i.e., to shift the entire spectrum up or down in the intensity (Y) 

axis). 

When this icon is active, the mouse cursor 

changes to the Add Constant cursor.
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Shift cursor on the 

spectrum, profile or image window to shift scales of 

axes scales do one of the 

Click on the “Scale Normalization” icon in 

section 4.4.1, page 91. 

+N keyboard short cut 

“Scale Normalization”. 

Right click and select “Rescale” 

Spectrum, Video, SpIm, Point, Map, Score, Model 

onstant cursor, allowing a constant intensity value to be added to or subtracted 

pixels in the active spectrum (i.e., to shift the entire spectrum up or down in the intensity (Y) 

When this icon is active, the mouse cursor 

onstant cursor. 

0
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constant intensity value to be added to or subtracted 

pixels in the active spectrum (i.e., to shift the entire spectrum up or down in the intensity (Y) 

1 000

Raman Shift (cm
-1

)

1 000 1 500

Raman Shift (cm
-1

)



 

 

 

 

 

Left click and drag the Add Constant cursor on the 

spectrum window to shift the spectrum up or down.

o Dragging upwards (as in the example 

shown right) will shift the spectrum 

upwards (to a higher intensity position), 

equivalent to adding a constant to the 

spectrum 

o Dragging downwards will shift the 

spectrum downwards (to a lower

position), equivalent to subtracting a 

constant from the spectrum.

 

 

 

 

 

This function is related to the “Const+” function 

available in the Math dialog window 

4.6.6, page 131. 

Available for: Spectrum, Point, Model

5.9. Multiply by Constant

 

Activates the Multiply by Constant cursor, allowing all pixels in the active spectrum to be multiplied or 

divided by a constant value to be added to or subtracted from all pixels in the active spectrum (i.e., to 

increase or decrease the entire spectrum intensity).

When this icon is active, the mouse cursor 

changes to the Multiply by Constant cursor.
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onstant cursor on the 

window to shift the spectrum up or down. 

(as in the example 

will shift the spectrum 

upwards (to a higher intensity position), 

equivalent to adding a constant to the 

Dragging downwards will shift the 

ds (to a lower intensity 

position), equivalent to subtracting a 

constant from the spectrum. 

This function is related to the “Const+” function 

available in the Math dialog window - see section 

Spectrum, Point, Model 

Multiply by Constant 

onstant cursor, allowing all pixels in the active spectrum to be multiplied or 

value to be added to or subtracted from all pixels in the active spectrum (i.e., to 

increase or decrease the entire spectrum intensity). 

When this icon is active, the mouse cursor 

onstant cursor. 
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onstant cursor, allowing all pixels in the active spectrum to be multiplied or 

value to be added to or subtracted from all pixels in the active spectrum (i.e., to 
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1 000 1 500

Raman Shift (cm
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)



 

 

 

Left click and drag the Multiply by C

on the spectrum window to shift the spectrum up or 

down. 

o Dragging upwards (as in the example 

shown right) will increase 

intensity, equivalent to multiplying the 

spectrum by a constant.

o Dragging downwards will 

spectrum intensity, equivalent to 

the spectrum by a constant

 

 

 

 

 

This function is related to the “Const*” function 

available in the Math dialog window 

4.6.6, page 131. 

Available for: Spectrum, Point, Model

5.10. Add Peak 

 

Activates the Add Peak cursor, allowing manual labelling of a peak position on the spectrum.

When this icon is active, the mouse cursor 

changes to the Add Peak cursor.
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Multiply by Constant cursor 

on the spectrum window to shift the spectrum up or 

Dragging upwards (as in the example 

increase the spectrum 

intensity, equivalent to multiplying the 

spectrum by a constant. 

Dragging downwards will decrease the 

, equivalent to dividing 

a constant. 

This function is related to the “Const*” function 

available in the Math dialog window - see section 

Spectrum, Point, Model 

Activates the Add Peak cursor, allowing manual labelling of a peak position on the spectrum.

When this icon is active, the mouse cursor 

changes to the Add Peak cursor. 
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Activates the Add Peak cursor, allowing manual labelling of a peak position on the spectrum. 
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Left click the Add Peak cursor at the desired 

spectrum position to label a peak.  The peak label 

will be positioned in the X axis according to the 

click position; the Y (intensity) axis position will be 

automatically set according to the spectrum 

intensity at that position. 

Note that the actual display of the peak label will 

depend on the settings in the Peak Options dialog 

window.  See section 4.6.7.4, page 

 

 

 

 

 

 

 

When the Add Peak cursor is active, and the 

mouse is hovered over an existing peak label, the 

cursor changes to a Move Peak cursor.

Left click and drag the Move Peak cursor to move 

the peak label to a different position on the 

spectrum.  
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Left click the Add Peak cursor at the desired 

spectrum position to label a peak.  The peak label 

will be positioned in the X axis according to the 

click position; the Y (intensity) axis position will be 

automatically set according to the spectrum 

of the peak label will 

depend on the settings in the Peak Options dialog 

page 144. 

When the Add Peak cursor is active, and the 

mouse is hovered over an existing peak label, the 

cursor changes to a Move Peak cursor. 

Left click and drag the Move Peak cursor to move 

label to a different position on the 
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When multiple peaks are labelled on a spectrum, 

the active peak label is enclosed in a dashed box.  

Use the Move Peak cursor to activate a different 

peak label, by left clicking on that peak lab

 

 

 

 

 

 

 

 

 

 

 

The Add Peak and Move Peak cursors should be used in conjunction with the Peak Searching and 

Fitting module - see section 4.6.7

Available for: Spectrum, SpIm, Point, Model

5.11. Adjust Peak 

 

Activates the Adjust Peak cursor, allowing peak fit parameters to be manually adjusted prior to fitting.  

The peak position, amplitude and full width at half maximum height 

this cursor. 

Typically this function requires that the

position can be manually adjusted to approximately fit the raw data.  The peak shape display can be 

set in the Peak Options dialog window 

When this icon is active, the mouse cursor 

changes to the Adjust Peak cursor

the position of the mouse on the spectrum, this 

cursor has three possible forms: 

o When the mouse hovers over a peak 

label the Adjust Position cursor is 

displayed. 

LabSpec 5

 

When multiple peaks are labelled on a spectrum, 

enclosed in a dashed box.  

Use the Move Peak cursor to activate a different 

, by left clicking on that peak label. 

The Add Peak and Move Peak cursors should be used in conjunction with the Peak Searching and 

4.6.7, page 135. 

Spectrum, SpIm, Point, Model 

Activates the Adjust Peak cursor, allowing peak fit parameters to be manually adjusted prior to fitting.  

The peak position, amplitude and full width at half maximum height (FWHM) can be adjusted using 

Typically this function requires that the peak shape is visible on the spectrum, so that the shape and 

position can be manually adjusted to approximately fit the raw data.  The peak shape display can be 

set in the Peak Options dialog window – see section 4.6.7.4, page 144. 

When this icon is active, the mouse cursor 

changes to the Adjust Peak cursor.  Depending on 

the position of the mouse on the spectrum, this 

 

When the mouse hovers over a peak 

label the Adjust Position cursor is 
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The Add Peak and Move Peak cursors should be used in conjunction with the Peak Searching and 

Activates the Adjust Peak cursor, allowing peak fit parameters to be manually adjusted prior to fitting.  

can be adjusted using 

peak shape is visible on the spectrum, so that the shape and 

position can be manually adjusted to approximately fit the raw data.  The peak shape display can be 
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o When the mouse hovers to the left of a 

peak label the Adjust Width cursor is 

displayed. 

o When the mouse hovers to the right of a 

peak label the Adjust Width cursor is 

displayed. 

Adjustment to a peak shape and position is only 

possible for the active peak label/shape.  In a 

spectrum with multiple peak labels/shapes, use the 

Add Peak / Move Peak cursor to activate the peak 

which is to be adjusted – see section 

173. 

Left click and drag on the peak label to adjust its 

position and amplitude. 
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When the mouse hovers to the left of a 

peak label the Adjust Width cursor is 

When the mouse hovers to the right of a 

peak label the Adjust Width cursor is 

Adjustment to a peak shape and position is only 

possible for the active peak label/shape.  In a 

spectrum with multiple peak labels/shapes, use the 

Add Peak / Move Peak cursor to activate the peak 

see section 5.10, page 

Left click and drag on the peak label to adjust its 
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Left click and drag on either side of the peak to 

adjust the peak full width at half maximum height 

(FWHM). 

o Dragging away from the peak (as in the 

example shown right) will increase the 

full width at half maximum height 

(FWHM). 

o Dragging towards the peak will decrease 

the full width at half maximum height 

(FWHM). 

 

 

 

 

 

 

 

The Adjust Position and Adjust Width cursors should be used in conjunction with the Peak Searching 

and Fitting module - see section 

Available for: Spectrum, SpIm, Point, Model

5.12. Remove Peak 

 

Activates the Remove Peak cursor, allowing a peak label to be removed from a spectrum.

When this icon is active, and mouse is hovered 

over a peak the mouse cursor changes to the 

Remove Peak cursor. 
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Left click and drag on either side of the peak to 

full width at half maximum height 

Dragging away from the peak (as in the 

example shown right) will increase the 

full width at half maximum height 

Dragging towards the peak will decrease 

the full width at half maximum height 

The Adjust Position and Adjust Width cursors should be used in conjunction with the Peak Searching 

see section 4.6.7, page 135. 

Spectrum, SpIm, Point, Model 

Activates the Remove Peak cursor, allowing a peak label to be removed from a spectrum.

When this icon is active, and mouse is hovered 

over a peak the mouse cursor changes to the 
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The Adjust Position and Adjust Width cursors should be used in conjunction with the Peak Searching 

Activates the Remove Peak cursor, allowing a peak label to be removed from a spectrum. 
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Left click on a peak label to remove it from the 

spectrum. 

 

 

 

 

 

 

 

 

 

 

 

 

The Remove Peak cursor should be used in conjunction with the Peak Searching and Fitting module 

see section 4.6.7, page 135. 

Available for: Spectrum, SpIm, Point, Model

5.13. Integral 

 

Activates the Integral cursors and opens the Integral dialog window

of a region of the spectrum to be calculated.

Note that this function does not apply any deconvolution of overlapping peaks 

which are overlapping needs to be calculated it is necessary to perform a full peak fitting routine.  See 

section 4.6.7, page 135 for full information about the Peak Searching and Fitting module.

Similarly, the baseline function of the Integral cursors uses a basic linear baseline 

baselines are present then it is necessary to perform a full baseline subtraction routine.  See section 

4.6.2, page 116 for full information about the Baseline Correction module.
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Left click on a peak label to remove it from the 

The Remove Peak cursor should be used in conjunction with the Peak Searching and Fitting module 

Spectrum, SpIm, Point, Model 

Activates the Integral cursors and opens the Integral dialog window, allowing the integrated area/sum 

of a region of the spectrum to be calculated. 

Note that this function does not apply any deconvolution of overlapping peaks –

which are overlapping needs to be calculated it is necessary to perform a full peak fitting routine.  See 

for full information about the Peak Searching and Fitting module.

ion of the Integral cursors uses a basic linear baseline 

baselines are present then it is necessary to perform a full baseline subtraction routine.  See section 

for full information about the Baseline Correction module. 
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The Remove Peak cursor should be used in conjunction with the Peak Searching and Fitting module - 

, allowing the integrated area/sum 

– if the area of peaks 

which are overlapping needs to be calculated it is necessary to perform a full peak fitting routine.  See 

for full information about the Peak Searching and Fitting module. 

ion of the Integral cursors uses a basic linear baseline – if more complex 

baselines are present then it is necessary to perform a full baseline subtraction routine.  See section 
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When this icon is active, the Integral cursors are 

displayed on the spectrum.  In addition to the 

cursors the display includes 

o The shaded part of the spectrum from 

where the area/sum value is calculated 

o The baseline used for the area/sum 

calculation. 

 

Left click and drag on either cursor to adjust its 

position.  The values in the Integral dialog window 

will be automatically updated. 

If one or both of the cursors are not visible on the 

spectrum, do one of the following: 

o Click on the “Center Cursors” icon in the 

Icon bar– see 4.4.3, page 92. 

 

o Right click and select “Center cursor”. 

Available for: Spectrum, Point, Model 

5.13.1. Integral Dialog Window 

The Integral dialog window displays the integrated area/sum of the spectrum between the Integral 

cursors, and allows the information display to be configured, and the cursor positions to be manually 

adjusted. 

 

From 

Displays the spectral position of the lower cursor.  The value can be manually adjusted by typing in 

the desired value and clicking [Apply]. 
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To 

Displays the spectral position of the upper cursor.  The value can be manually adjusted by typing in 

the desired value and clicking [Apply]. 

Top 

Displays the peak Sum or Area above the baseline in the shaded region.  Note that Top = Full – 

Base. 

Base 

Displays the peak Sum or Area below the baseline in the shaded region.  Note that Base = Full – 

Top. 

Full 

Displays the full peak Sum or Area in the shaded region.  Note that Full = Top + Base. 

Format 

Click on the “Format” drop down box to select the maximum number of significant digits displayed in 

the “Top”, “Base” and “Full” boxes. 

Type 

Click on the “Type” drop down box to select whether peak Area or Sum should be calculated and 

displayed in the “Top”, “Base” and “Full” boxes. 

Line 

Click on the “Line” drop down box to set the color, width and line style used to outline the shaded area 

between the Integral cursors. 

Fill 

Click on the “Fill” drop down box to set the color and style used to fill the shaded area between the 

Integral cursors. 

Apply 

Click on [Apply] to update the cursor display on the spectrum according to values manually set in the 

“From” and “To” boxes. 

Copy 

Click on [Copy] to copy the From, To, Top, Base and Full values to the clipboard, so that they can be 

pasted into other programs. 

Note that Integral dialog window will be automatically closed when a different Graphical Manipulation 

icon is activated.  If [Close] is used to close the Integral dialog window the Integral icon will still be 

active.  To restore the Integral dialog window, activate a different icon, and then re-activate the 

Integral icon; the Integral cursors and dialog window will be displayed again. 

 

 

 

 



 

 

 

5.14. Add Baseline Points

 

Activates the Add Baseline Points icon, allowing

prior to baseline correcting a spectrum.  The type of baseline displayed when using the Add Baseline 

Points icon will depend on settings in the Baseline dialog window 

When this icon is active, the cursor will change 

from the mouse cursor to the Add Baseline Points 

cursor. 

Left click the Add Baseline Points cursor 

spectrum to add a baseline point to the displayed 

baseline curve.  If there is no baseline curve on the 

spectrum the first left mouse click in this mode will 

create the baseline. 

 

 

 

 

 

 

 

 

 

 

When the Add Baseline Points cursor is active, and 

the mouse is hovered over an existing baseline 

point, the cursor changes to a Move Baseline 

Points cursor. 
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Add Baseline Points 

Activates the Add Baseline Points icon, allowing baseline points to be manually added to a spectrum, 

ne correcting a spectrum.  The type of baseline displayed when using the Add Baseline 

Points icon will depend on settings in the Baseline dialog window – see section 4.6.2

When this icon is active, the cursor will change 

from the mouse cursor to the Add Baseline Points 

the Add Baseline Points cursor on the 

spectrum to add a baseline point to the displayed 

baseline curve.  If there is no baseline curve on the 

spectrum the first left mouse click in this mode will 

oints cursor is active, and 

the mouse is hovered over an existing baseline 

point, the cursor changes to a Move Baseline 

LabSpec 5 user manual 

 

Page | 181  

baseline points to be manually added to a spectrum, 

ne correcting a spectrum.  The type of baseline displayed when using the Add Baseline 

4.6.2, page 116. 



 

 

 

 

Left click the Move Baseline Points cursor 

the baseline point to a new position.

 

 

 

 

 

 

 

 

 

 

 

 

The Add Baseline Points cursor should be used in conjunction with the Baseline Correction module 

see section 4.6.2, page 116. 

Available for: Spectrum, SpIm, Point, Model

5.15. Remove Baseline Points

 

Activates the Remove Baseline Points cursor

a spectrum, prior to baseline correcting a spectrum.

When this icon is active, and the mouse is hovered 

over an existing baseline point, the cursor change

to the Remove Baseline Points cursor.
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the Move Baseline Points cursor to drag 

the baseline point to a new position. 

The Add Baseline Points cursor should be used in conjunction with the Baseline Correction module 

Spectrum, SpIm, Point, Model 

Remove Baseline Points 

Activates the Remove Baseline Points cursor, allowing baseline points to be manually removed from 

a spectrum, prior to baseline correcting a spectrum. 

, and the mouse is hovered 

over an existing baseline point, the cursor changes 

to the Remove Baseline Points cursor. 
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The Add Baseline Points cursor should be used in conjunction with the Baseline Correction module - 

, allowing baseline points to be manually removed from 



 

 

 

Left click on a baseline point to remove it from the 

spectrum. 

 

 

 

 

 

 

 

 

 

 

 

 

The Remove Baseline Points cursor should be used in conjunction with the Baseline Correction 

module - see section 4.6.2, page 

Available for: Spectrum, SpIm, Point, Model

5.16. Axes 

 

Activates the Axes cursor, allowing the position 

active window to be adjusted. 

When this icon is active, and the mouse is hovered 

over the spectrum/profile/image display, the cursor 

changes to the Shift Axes cursor.
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Left click on a baseline point to remove it from the 

Baseline Points cursor should be used in conjunction with the Baseline Correction 

, page 116. 

Spectrum, SpIm, Point, Model 

Activates the Axes cursor, allowing the position and size of the spectrum/profile/image display in the 

, and the mouse is hovered 

image display, the cursor 

cursor. 
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Baseline Points cursor should be used in conjunction with the Baseline Correction 

of the spectrum/profile/image display in the 



 

 

 

 

Left click and drag the Shift Axes

the position of the spectrum/profile/image display 

in the window. 

 

 

 

 

 

 

 

 

 

 

 

When this icon is active, and the mouse is hovered 

over one of the axis drag points, the cursor 

changes to the Adjust Axes cursor.

Left click and drag the Adjust Axes cursor to adjust 

the spectrum/profile/image display size in the 

window. 
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Axes cursor to adjust 

the position of the spectrum/profile/image display 

and the mouse is hovered 

over one of the axis drag points, the cursor 

changes to the Adjust Axes cursor. 

Left click and drag the Adjust Axes cursor to adjust 

the spectrum/profile/image display size in the 
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Note that only information visible within the window 

will be active for copy and paste functions.  Thus it 

is important that axes titles, scales and the 

spectrum/profile/image display are kept within the 

boundary of the window. 

Available for: Spectrum, Video, SpIm, Point, Map, Scor

5.17. Points Mapping 

 

Activates the Points Mapping cursor, allowing positions for a

specified on the active video image.

When this icon is active, and the mouse is hovered 

over the video image the cursor 

the Add Points cursor. 

Left click with the Add Points cursor to 

multipoint position to the video image.
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visible within the window 

will be active for copy and paste functions.  Thus it 

is important that axes titles, scales and the 

spectrum/profile/image display are kept within the 

Spectrum, Video, SpIm, Point, Map, Score, Model 

 

Activates the Points Mapping cursor, allowing positions for an automated multipoint acquisition to be 

specified on the active video image. 

When this icon is active, and the mouse is hovered 

 will change from to 

Left click with the Add Points cursor to add a 

multipoint position to the video image. 

LabSpec 5 user manual 

 

Page | 185  

automated multipoint acquisition to be 



 

 

 

 

The points which are added are sequentially 

numbered, starting at 1.  They will be analysed in 

the order they are added. 

When the Add Points cursor is active, and the 

mouse is hovered over an existing multipoint 

position, the cursor changes to the Move/Delete 

Points cursor. 

Left click with the Move/Delete Points cursor to 

delete the existing multipoint po

points displayed on the video will be renumbered 

accordingly. 
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The points which are added are sequentially 

numbered, starting at 1.  They will be analysed in 

When the Add Points cursor is active, and the 

mouse is hovered over an existing multipoint 

position, the cursor changes to the Move/Delete 

the Move/Delete Points cursor to 

delete the existing multipoint position.  The other 

points displayed on the video will be renumbered 
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Left click and drag with the Move/Delete Points 

cursor to move the existing multipoint position to a 

new position. 

 

 

 

 

 

 

 

 

 

 

 

 

 

To clear all existing points and set point 1 at the 

center of the video image do one of the following:

o Click on the “Center Cursors

Icon bar– see 4.4.3, page 

 

o Right click and select “Center

 

Note that the automated multipoint acquisition is 

started by using the Mapping Acquisition icon 

see section 4.5.4, page 96.  The data is acquired 

as a multidimensional spectral array, with the 

standard SpIm, Point and Map windows.

Available for: Video 
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Left click and drag with the Move/Delete Points 

cursor to move the existing multipoint position to a 

and set point 1 at the 

center of the video image do one of the following: 

Cursors” icon in the 

, page 92. 

Center cursor”. 

Note that the automated multipoint acquisition is 

started by using the Mapping Acquisition icon – 

.  The data is acquired 

as a multidimensional spectral array, with the 

standard SpIm, Point and Map windows. 
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5.18. Hor Line Mapping

 

Activates the Horizontal Line Mapping cursor, allowing a horizontal line for line mapping to be defined 

on the active video image. 

When this icon is active, and the mouse is hovered 

over the line, the cursor changes to the Shift Hor 

Line cursor. 

Left click and drag with the Shift Hor Line cursor to 

move the line to the desired position on the video 

image. 

When this icon is active, and the mou

over the line drag points (at each end of the line), 

the cursor changes to the Adjust Hor Line cursor.

Left click and drag with the Adjust Hor Line cursor 

to make the line longer or shorter.

To clear the existing line, and create a new defaul

line at the center of the video image do one of the 

following: 

o Click on the “Center Cursors

Icon bar– see 4.4.3, page 

 

o Right click and select “Center

 

The Shift Hor Line and Adjust Hor Line cursors should be used in conjunction with the Mapping 

Properties dialog window - see section 

Available for: Video 

5.19. Rectangular Mapping

 

Activates the Rectangular Mapping cursor, allowing a rectangular area for mapping to be defined on 

the active video image. 

When this icon is active, and the mouse is hovered 

over the existing rectangle, the cursor changes to 

the Shift Rectangle cursor. 
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Hor Line Mapping 

Activates the Horizontal Line Mapping cursor, allowing a horizontal line for line mapping to be defined 

, and the mouse is hovered 

over the line, the cursor changes to the Shift Hor 

Left click and drag with the Shift Hor Line cursor to 

move the line to the desired position on the video 

, and the mouse is hovered 

over the line drag points (at each end of the line), 

the cursor changes to the Adjust Hor Line cursor. 

Left click and drag with the Adjust Hor Line cursor 

to make the line longer or shorter. 

To clear the existing line, and create a new default 

line at the center of the video image do one of the 

Cursors” icon in the 

, page 92. 

Center cursor”. 

The Shift Hor Line and Adjust Hor Line cursors should be used in conjunction with the Mapping 

see section 4.5.5, page 97. 

Rectangular Mapping 

Activates the Rectangular Mapping cursor, allowing a rectangular area for mapping to be defined on 

, and the mouse is hovered 

over the existing rectangle, the cursor changes to 
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Activates the Horizontal Line Mapping cursor, allowing a horizontal line for line mapping to be defined 

The Shift Hor Line and Adjust Hor Line cursors should be used in conjunction with the Mapping 

Activates the Rectangular Mapping cursor, allowing a rectangular area for mapping to be defined on 



 

 

 

Left click and drag with the Shift Rectangle cursor 

to move the line to the desired position on the 

video image. 

When this icon is active, and the mouse is hovered 

over the rectangle drag points, the cursor changes 

to the Adjust Rectangle cursor. 

Left click and drag with the Adjust Rectangle 

cursor to adjust the rectangle size.

To clear the existing rectangle 

default rectangle at the center of the video image 

do one of the following: 

o Click on the “Center Cursors

Icon bar– see 4.4.3, page 

 

o Right click and select “Center

The Shift Rectangle and Adjust Rectangle cursors should be used in conjunction with the Mapping 

Properties dialog window - see section 

Available for: Video 

5.20. Line Mapping 

 

Activates the Line Mapping cursor, allowing a line for line mapping to be defined on the active video 

image. 

When this icon is active, and the mouse is hovered 

over the line, the cursor changes to the Shift Line 

cursor. 

Left click and drag with the Shift Line cursor to 

move the line to the desired position on the video 

image. 

When this icon is active, and the mouse is hovere

over the line drag points (at each end of the line), 

the cursor changes to the Adjust Line cursor.

Left click and drag with the Adjust Line cursor to 

make the line longer or shorter, or to rotate the line 

about the opposite drag point. 

To clear the existing line and create a new default 

line at the center of the video image do one of the 

following: 

LabSpec 5

 

Left click and drag with the Shift Rectangle cursor 

to move the line to the desired position on the 

, and the mouse is hovered 

over the rectangle drag points, the cursor changes 

Left click and drag with the Adjust Rectangle 

cursor to adjust the rectangle size. 

 and create a new 

default rectangle at the center of the video image 

Cursors” icon in the 

, page 92. 

Center cursor”. 

The Shift Rectangle and Adjust Rectangle cursors should be used in conjunction with the Mapping 

e section 4.5.5, page 97. 

Activates the Line Mapping cursor, allowing a line for line mapping to be defined on the active video 

, and the mouse is hovered 

over the line, the cursor changes to the Shift Line 

Left click and drag with the Shift Line cursor to 

move the line to the desired position on the video 

, and the mouse is hovered 

over the line drag points (at each end of the line), 

the cursor changes to the Adjust Line cursor. 

Left click and drag with the Adjust Line cursor to 

make the line longer or shorter, or to rotate the line 

and create a new default 

line at the center of the video image do one of the 
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The Shift Rectangle and Adjust Rectangle cursors should be used in conjunction with the Mapping 

Activates the Line Mapping cursor, allowing a line for line mapping to be defined on the active video 



 

 

 

 

o Click on the “Center Cursors

Icon bar– see 4.4.3, pa

 

o Right click and select “Center

The Shift Line and Adjust Line cursors should be used in conjunction with the Mapping Properties 

dialog window - see section 4.5.5

Available for: Video 

5.21. Circle Mapping 

 

Activates the Circle Mapping cursor, allowing a circle for mapping to be defined on the active video 

image. 

When this icon is active, and the mouse is hovered 

over the line, the cursor changes to the Shift 

cursor. 

Left click and drag with the Shift 

move the line to the desired position on the video 

image. 

When this icon is active, and the mouse is ho

over the circle area drag points (at each 

the circle area), the cursor changes to the Adjust 

Circle cursor. 

Left click and drag with the Adjust 

adjust the circle size. 

To clear the existing circle and create a new 

default circle at the center of the video image do 

one of the following: 

o Click on the “Center Cursors

Icon bar– see 4.4.3, page 

 

o Right click and select “Center

 

The Shift Circle and Adjust Circle 

dialog window - see section 4.5.5

Available for: Video 
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Cursors” icon in the 

, page 92. 

Center cursor”. 

The Shift Line and Adjust Line cursors should be used in conjunction with the Mapping Properties 

4.5.5, page 97. 

Activates the Circle Mapping cursor, allowing a circle for mapping to be defined on the active video 

, and the mouse is hovered 

over the line, the cursor changes to the Shift Circle 

Left click and drag with the Shift Circle cursor to 

move the line to the desired position on the video 

, and the mouse is hovered 

drag points (at each edge of 

), the cursor changes to the Adjust 

Left click and drag with the Adjust Circle cursor to 

and create a new 

at the center of the video image do 

Cursors” icon in the 

, page 92. 

Center cursor”. 

Circle cursors should be used in conjunction with the Mapping Properties 

4.5.5, page 97. 
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The Shift Line and Adjust Line cursors should be used in conjunction with the Mapping Properties 

Activates the Circle Mapping cursor, allowing a circle for mapping to be defined on the active video 

cursors should be used in conjunction with the Mapping Properties 



 

 

 

5.22. Ver Line Mapping

 

Activates the Vertical Line Mapping cursor, allowing a vertical line for line mapping to be defined on 

the active video image. 

When this icon is active, and the mouse is hovered 

over the line, the cursor changes to the Shift Ver 

Line cursor. 

Left click and drag with the Shift Ver Line cursor to 

move the line to the desired position on the video 

image. 

When this icon is active, and the mouse is hovered 

over the line drag points (at each end of the line), 

the cursor changes to the Adjust Ver Line cursor.

Left click and drag with the Adjust Ver Line cursor 

to make the line longer or shorter.

To clear the existing line, and create

line at the center of the video image do one of the 

following: 

o Click on the “Center Cursors

Icon bar– see 4.4.3, page 

 

o Right click and select “Center

 

The Shift Ver Line and Adjust Ver Line cursors

Properties dialog window - see section 

Available for: Video 

5.23. Polygon Mapping

 

Activates the Polygon Mapping cursor, allowing a po

video image. 

When this icon is active, and the mouse is hovered 

over the video image the cursor will change to the 

Add Polygon Points cursor. 
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Ver Line Mapping 

Activates the Vertical Line Mapping cursor, allowing a vertical line for line mapping to be defined on 

, and the mouse is hovered 

over the line, the cursor changes to the Shift Ver 

Left click and drag with the Shift Ver Line cursor to 

move the line to the desired position on the video 

, and the mouse is hovered 

over the line drag points (at each end of the line), 

the cursor changes to the Adjust Ver Line cursor. 

Left click and drag with the Adjust Ver Line cursor 

to make the line longer or shorter. 

To clear the existing line, and create a new default 

line at the center of the video image do one of the 

Cursors” icon in the 

, page 92. 

Center cursor”. 

The Shift Ver Line and Adjust Ver Line cursors should be used in conjunction with the Mapping 

see section 4.5.5, page 97. 

Polygon Mapping 

Activates the Polygon Mapping cursor, allowing a polygon for mapping to be defined on the active 

When this icon is active, and the mouse is hovered 

over the video image the cursor will change to the 
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Activates the Vertical Line Mapping cursor, allowing a vertical line for line mapping to be defined on 

should be used in conjunction with the Mapping 

lygon for mapping to be defined on the active 



 

 

 

 

Left click with the Add Polygon 

add a polygon definition point to the video image.

 

 

 

 

 

 

 

 

 

 

 

 

 

 

When the Add Polygon Points cursor is active, and 

the mouse is hovered over an existing 

definition point, the cursor changes to the 

Move/Delete Polygon Points cursor.
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Polygon Points cursor to 

to the video image. 

Points cursor is active, and 

the mouse is hovered over an existing polygon 

, the cursor changes to the 

Points cursor. 
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Left click with the Move/Delete 

cursor to delete the existing 

point. 

 

 

 

 

 

 

 

 

 

 

 

 

Left click and drag with the Move/Delete 

Points cursor to move the existing 

definition point to a new position.
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Left click with the Move/Delete Polgyon Points 

existing polygon definition 

Left click and drag with the Move/Delete Polygon 

Points cursor to move the existing polygon 

to a new position. 
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To clear all existing polygon definition points, and 

set a single point at the center of the video image 

do one of the following: 

o Click on the “Center Cursors” icon in the 

Icon bar– see 4.4.3, page 92. 

 

o Right click and select “Center cursor”. 

Note that the polygon shape is created by locating 

nearest neighbours to each polygon definition 

point.  Slight adjustment of polygon definition 

points may be required to obtain the desired 

polygon mapping shape. 

The Add Polygon Points and Move/Delete Polygon Points cursors should be used in conjunction with 

the Mapping Properties dialog window - see section 4.5.5, page 97. 

Available for: Video 

5.24. Axes3D 

 

Activates axis drag points on a 3D image, allowing its position, shape and perspective to be modified. 

When this icon is active, four drag points are 

activated on the 3D image. 

 

 

 

 

 

 

Left click and drag the drag points to adjust the 

position, shape and perspective of the image: 

Drag Point 1 

Dragging up/down adjusts the size of the vertical 

(intensity) axis. 

Dragging left/right skews the image about its 

center point, keeping the left hand side and right 

hand side vertical axes static. 

1 

2 

3 4 
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Drag Point 2 

Dragging up/down/left/right adjusts the image 

position within the display window. 

Drag Point 3 

Dragging up/down/left/right skews the image, 

keeping the back and right hand side vertical axes 

static. 

Drag Point 4 

Dragging up/down/left/right skews the image, 

keeping the back and left hand side vertical axes 

static. 

 

To restore the 3D image to its default display, right click and select Axes, and then click on [Re-

center image] – see section 8.8.2, page 216. 

Available for: Video, SpIm, Map, Score (when displayed in 3D mode) 
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6. Data Bar 

The Data bar located on the right hand side of the LabSpec 5 graphical user interface (GUI) allows 

individual data objects (e.g., spectra, images, multidimensional spectral arrays) to be selected from a 

group of open objects.  In addition, the Data bar allows control of quick window formatting tools. 

This is an active toolbar, and the number of data object selector radio tags (see section 6.3, page 

199) will automatically update according to number of open objects in the currently selected window. 

 

 

6.1. Quick Select:  Single or Multiple Data View 

The Single and Multiple Data Graph icons allow fast selection of overlay mode for the active window. 

Note that when clicked an icon will be locked 

down.  Only one icon can be active and locked 

down at a time.  

The overlay mode can also be set using the 

Format and Scale dialog window – see section 8.1, 

page 205. 

6.1.1. Single Data Graph 

 

When the Single Data Graph icon is active and locked, only the active data object will be displayed in 

the window.  For example, if there are three spectra open, only the active spectrum will be displayed.  

Selecting a different spectrum using the Data bar (see section 6.3, page 199) will cause the selected 

spectrum to be displayed. 

 

 

Quick Select:  Single or Multiple data view 

Quick graph settings 

Selector radio tags for each open data object 
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In the example shown right, there are three open 

spectra, but only the active spectrum (——) is 

displayed. 

 

 

 

6.1.2. Multiple Data Graph 

 

When the Multiple Data Graph icon is active and locked, all open data objects will be displayed in the 

window.  For example, if there are three spectra open, all three will be displayed in an overlay mode 

in the window. 

In the example shown right, there are three open 

spectra, all of which are displayed. 

 

 

 

 

Note that the overlay mode (“Overlay”, “Tile”, 

“Stack”, “Projection” or “Trace”) used with the 

Multiple Data Graph icon will be the mode set in 

the Format and Scale dialog window (see section 

8.1, page 205).  To adjust the overlay mode right 

click and select “Format and Scale”, and select the 

desired mode from the “Mode” drop down box. 

 

 

 

 

 

 

 

500 1 000 1 500

Raman Shift (cm
-1

)

500 1 000 1 500

Raman Shift (cm
-1

)



 

 

 

 

6.2. Fast Graph Settings

When the Fast Graph Settings icon

be quickly modified. 

When Fast Graph Settings is active, the titles/units 

and maximum/minimum values on 

are underlined. 

 

 

 

 

 

Left click on an underlined item to m

formatting, by selecting a format from the drop 

down list. 

 

 

 

 

When Fast Graph Settings is inactive, the 

titles/units and minimum/maximum values on all 

visible axes are not underlined, and their formatting 

cannot be modified using a left click.

 

 

 

 

Complete formatting is possible using the Format 

and Scale dialog window – see 

205 for full information. 

Note that the current status of the Fast Graph 

Settings (i.e., active or inactive) is also displayed in 

the right click menu, under “Fast Settings”.  When 

the Fast Graph Settings is active, “Fast Settings” 

will be ticked. 
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Graph Settings 

icon is active and locked, the formatting of axis units and scaling can 

Graph Settings is active, the titles/units 

and maximum/minimum values on all visible axes 

Left click on an underlined item to modify its 

formatting, by selecting a format from the drop 

Graph Settings is inactive, the 

titles/units and minimum/maximum values on all 

visible axes are not underlined, and their formatting 

click. 

Complete formatting is possible using the Format 

see section 8.1, page 

Note that the current status of the Fast Graph 

(i.e., active or inactive) is also displayed in 

the right click menu, under “Fast Settings”.  When 

ngs is active, “Fast Settings” 
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is active and locked, the formatting of axis units and scaling can 



 

 

 

6.3. Selector Radio Tags for Open Data Objects

When multiple data objects (e.g., spectra, images, multidimensional 

are open within a single display window, the Data bar will display a selector radio tag for each object.

Each radio tag will be displayed in the same colour 

as the data object. 

o An active object has a color

tag, as shown right. 

 

o An inactive object has a hollow radio tag, 

as shown right. 

 

Hover the mouse cursor over a radio tag to see the 

data object name. 

<CTRL>+Click on a radio tag to hide/show an 

individual object.  If an object is hidden the radio 

tag will display a red cross. 

o In the example shown right there are 

three open spectra, all of which are 

displayed. 

 

 

 

 

o In the example shown right there are 

three open spectra, but one (

been hidden using <CTRL>

not displayed. 

 

The spectrum can be shown again by 

<CTRL>+Clicking on its radio tag.
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Selector Radio Tags for Open Data Objects 

When multiple data objects (e.g., spectra, images, multidimensional spectral arrays) of a similar type 

are open within a single display window, the Data bar will display a selector radio tag for each object.

Each radio tag will be displayed in the same colour 

An active object has a color-filled radio 

An inactive object has a hollow radio tag, 

Hover the mouse cursor over a radio tag to see the 

+Click on a radio tag to hide/show an 

individual object.  If an object is hidden the radio 

In the example shown right there are 

three open spectra, all of which are 

In the example shown right there are 

three open spectra, but one (——) has 

<CTRL>+Click and is 

m can be shown again by 

+Clicking on its radio tag. 

 

500 1 000

Raman Shift (cm

500 1 000

Raman Shift (cm
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spectral arrays) of a similar type 

are open within a single display window, the Data bar will display a selector radio tag for each object. 

1 000 1 500

Raman Shift (cm
-1

)

1 000 1 500

Raman Shift (cm
-1

)



 

 

 

 

7. Status Bar 

The Status bar displays information about system status (e.g., progress of an acquisition), active 

options (e.g., intensity correction, or extended range settings), a

 

 

7.1. System Messages

System messages show information relevant to the current operation.  Typical examples include the 

estimated time remaining until completion of a measurement, current status/operation of the 

autocalibration routine, or current status/operation of the spectr

7.2. Active Options 

The Active Options icons indicate whether certain data acquisition options are active 

are options which have a significant effect on the measurement.

Photo-bleaching On 

When Photo-bleaching is active (i.e., the photo

bleaching time is >0s) the Photo-

is displayed.  

For more information about Photo

how to turn it on and off, please see section 

3.5.4.4, page 35). 

Autofocus On 

When Autofocus is active the Autofocus On icon is 

displayed.  

For more information about Autofocus and how to 

turn it on and off, please see section 

39). 

Intensity Correction On 

When Intensity Correction is active the Intensity 

Correction On icon is displayed. 

For more information about Intensity Correction 

and how to turn it on and off, please see section 

3.5.4.14, page 43. 

 

 

system 

messages 
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nformation about system status (e.g., progress of an acquisition), active 

options (e.g., intensity correction, or extended range settings), and cursor values.

Messages 

System messages show information relevant to the current operation.  Typical examples include the 

estimated time remaining until completion of a measurement, current status/operation of the 

autocalibration routine, or current status/operation of the spectrometer. 

The Active Options icons indicate whether certain data acquisition options are active 

are options which have a significant effect on the measurement. 

bleaching is active (i.e., the photo-

-bleaching On icon 

For more information about Photo-bleaching and 

how to turn it on and off, please see section 

When Autofocus is active the Autofocus On icon is 

For more information about Autofocus and how to 

turn it on and off, please see section 3.5.4.8, page 

When Intensity Correction is active the Intensity 

  

For more information about Intensity Correction 

and how to turn it on and off, please see section 

active 

options 

detector progress bar 
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nformation about system status (e.g., progress of an acquisition), active 

nd cursor values. 

 

System messages show information relevant to the current operation.  Typical examples include the 

estimated time remaining until completion of a measurement, current status/operation of the 

The Active Options icons indicate whether certain data acquisition options are active – typically these 

cursor values 
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Extended Range On 

When an Extended Range measurement is active 

(i.e., the extended range function is set to either 

Multiwindow or Autoscanning) the Extended 

Range On icon is displayed. 

For more information about Extended Range 

acquisition and how to turn it on and off, please 

see section 3.5.6, page 49. 

7.3. Detector 

The Detector display shows the detector temperature (in degrees celsius, 
o
C), and (on systems 

equipped with multiple detectors) can be used to switch from one detector to another. 

7.3.1. Detector Temperature 

The detector icon is colored according to the 

temperature status of the active detector, relative 

to the temperature set in the “Detector” dialog 

window (see section 3.5.7, page 57). 

o Actual temperature is between set 

temperature and 5
o
C above the set 

temperature; detector can be used.  

 

o Actual temperature is between 5
o
C and 

10
o
C above the set temperature.  

 

Detector can be used, but data acquired 

in this state may exhibit slightly reduced 

quality (signal to noise). 

 

o Actual temperature is greater than 10
o
C 

above the set temperature; it is 

recommended that the detector is not 

used.  

 

Note that use of a detector at high 

temperature will not damage it, but data 

acquired in this state will exhibit 

significantly reduced quality (signal to 

noise). 

 

 

 



 

 

 

 

7.3.2. Switching Detector

On systems equipped with multiple detectors, click 

on the detector icon to view a list of available 

detectors.  The currently active detector is 

indicated with a tick. 

To switch detector, select the desired detector from 

the list of available detectors. Note that

initialization message may be displ

detector is switched. 

7.4. Progress Bar 

The Progress Bar indicates whether a hardware/software process is active, and displays the 

approximate progress of an active process.

the Progress Bar “Pause” icon. 

When a process is active, the Progress Bar 

displays a moving circle icon, and blue bars which 

indicate the current progress. 

 

 

 

 

Left click on the “Pause” icon to pause the current 

process.  The process will continue until the 

current section of the process is completed, and it 

will then pause.  The “Pause” icon will change into 

the “Start” icon. 

Left click on the “Start” icon to re

process.  The “Start” icon will cha

“Pause” icon. 

When no process is active, the Progress Bar is 

empty.  

7.5. Cursor Values 

The Cursor Value display shows a range of information depending on the type of cursor

active – e.g., the X and Y axis positions of the cursors, the spectrum/profile/image intensity at the 

cursor position, width between two cursors, and approximate peak width.

The following symbols are used to identify information displayed in the 

LabSpec 5

 

Switching Detector 

On systems equipped with multiple detectors, click 
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o S – spectral (X axis) position in a spectrum.  The units will be those selected in Options > 

Unit (see section 3.4.1, page 22), typically Raman shift (cm
-1

) or wavelength (nm). 

o I – intensity.  The units for spectra and cursor generated profiles/maps will be those selected 

in Options > Unit (see section 3.4.1, page 22), typically counts (cnt) or counts per second 

(cnt/s).  The units for video images will be arbitrary units (a.u.). 

o X, Y, Z – spatial position in a profile or image.  The units will be micrometers (µm). 

o P – spectral (X axis) width between a paired set of map analysis cursors.  The units will be 

those selected in Options > Unit (see section 3.4.1, page 22), typically Raman shift (cm
-1

) or 

wavelength (nm). 

o W – approximate peak width as indicated by the Peak cursor.  The units will be those 

selected in Options > Unit (see section 3.4.1, page 22), typically Raman shift (cm
-1

) or 

wavelength (nm).  



 

 

 

 

8. Right Click Menus

Right mouse clicking on the data windows will display a menu, which typically will allow access to 

additional dialog windows, provides shortcuts to other functions within 

information about the current configuration.

The right click menu is active, and its appearance and content will update according to the currently 

selected window.  For example, the options appearing for a Spectrum window will differ from those 

appearing for a video image. 

At the end of each function’s description, a

click menu is given.  The possible windows are as follows:

Spectrum 

The spectrum display window for individual spectra acquired using the 

acquisition (  /  ) and spectru

Video 

The video display window for optical images acquired with the integrated microscope camera(s).

SpIm 

The overlay of all spectra within a multidimensional spectral array.

Point 

The spectrum at the current cursor position w

Map 

The cursor intensity profile/image display created from a multidimensional spectral array.

Score 

The score profile/image created by DCLS modelling of a multidimensional spectral array

Model 

The reference component spectra used for DCLS modelling of a multidimensional spectral array.

 

To display the right click menu, right click 

anywhere within the active window.

menu item to open a new dialog window, or run the 

function. 

 

 

 

Note that setting a function in a right click menu dialog window will only set that function for the active 

window.  It is possible to have different settings for different windows.  For example, a Spectrum 

Point window can have different format and scale settings, by applying different settings through the 

Format and Scale dialog window for each window.
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8.1. Format and Scale 

The Format and Scale dialog window allows control over the window display format, and the data 

scaling within the window. 

Note that depending on the data window selected, the Format and Scale dialog window may slightly 

differ from that shown below. 

 

Available for: Spectrum, Video, SpIm, Point, Map, Score, Model 

8.1.1. Style 

The Style section of the Format and Scale dialog window allows control over the appearance of the 

data window, and how data is displayed within it. 

Internal 

Select the internal area color and fill option from 

the “Internal” color drop down box. 

Note that when a data window is copied as an 

image, it will be copied with the default internal 

white background. 

The internal area is shaded in the image shown 

right. 

External 

Select the external area color and fill option from 

the “External” color drop down box. 

Note that when a data window is copied as an 

image, it will be copied with the default external 

white background. 

The external area is shaded in the image shown 

right. 

 

 

INTERNAL    AREA 

 

EXTERNAL  AREA 
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Mode 

Select the overlay mode for data objects (e.g., 

spectra, images, multidimensional spectral arrays) 

from the “Mode” drop down box. 

A number of overlay modes are available: 

o Single – display only the currently active 

data object in the window. 

 

 

 

 

 

 

 

o Overlay – display all open data objects in 

the window. 

 

 

 

 

 

 

o Tile – display all open data objects in 

separate tiled sections within the window.  

 

 

 

 

 

 

 

o Stack – display all open data objects in 

the window, offsetting each by a certain 

amount. 
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o Projection – displays a series of images 

corresponding to the open data object in 

separate tiled sections within the window.   

 

This mode is only available for 

multidimensional spectral arrays, and is 

intended for display of 3D data sets (e.g., 

XYZ datacubes). 

 

 

 

o Trace - displays a single image from a 

multi-image single data object within the 

window.  The scroll bar on the right hand 

side can be used to scroll through each 

image corresponding to the data object; 

the axis value for the image is displayed 

in the top right hand corner of the 

window. 

 

This mode is only available for 

multidimensional spectral arrays, and is 

intended for display of 3D data sets (e.g., 

XYZ datacubes). 

Dimension 

Select the display dimension from the “Dimension” 

drop down box.  The number of dimensions used 

for data display refers to the number of non-

intensity axes.  For example, a simple spectrum is 

considered a 1D display, because it constitutes the 

intensity dimension plus one other dimension (the 

spectral axis, typically Raman shift or wavelength).  

A video image is considered a 2D display, because 

it constitutes the intensity dimension plus two 

spatial axes (X and Y). 

Three display dimensions are available: 

o 1D – simple ‘graph’ presentation, 

typically used for spectra (including 

Spectrum, SpIm, Point and Model 

windows). 
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o 2D – simple image presentation, typically 

used for images (including video, map 

and score windows).  Multiple images 

can be overlaid in this mode. 

 

 

 

 

 

o 3D – for pseudo 3D representation of 2D 

data, where all three axes (intensity plus 

two spatial) are visible.  Only a single 

image component can be displayed in 

this mode. 

 

Note that 3D images are configured 

using the right click menus Axes (see 

section 8.8.2, page 216) and 3Dimage 

(see section  8.18, page 225). 

 

Use Scroll Bars 

When “Use scroll bars” is ticked, scroll bars will be displayed if part of the data is off scale (e.g., not 

actually displayed in the data window). 

Always Show Scroll Bars 

When “Always show scroll bars” is ticked, the scroll bar display section of the data window will always 

be present, even if all data is displayed within the window.  The scroll bar(s) will only become active if 

part of the data is off scale (e.g., not actually displayed in the data window). 

One Data per View 

When “One data per view” is ticked, each data object associated with the data window will always 

open into a new data window.  In this case, it is not possible to overlay objects in a single window. 

Preserve Scale Ratio 

When “Preserve scale ratio” is ticked, the aspect ratio will be retained.  Typically this function is used 

for image display only. 

Use Data Only with Same X Axis 

When “Use data only with same X axis” is ticked, only data objects which share the same X axis units 

will be opened within the window.  Objects with other X axis units will be opened into a new data 

window.  For example, if a spectrum with Raman shift (cm
-1

) units is already open in a data window, 

when a spectrum with wavelength (nm) units is opened, a new data window will be created for it. 
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8.1.2. Scale 

The Scale section of the Format and Scale dialog window allows control over the scaling of data 

within the data window. 

Each available axis for the active data object is displayed in the “Scale” section, with a number of 

options for its scaling.  Typical axes displayed here are: 

o Hor – the X axis, typically the spectral axis for spectra, or the X (µm) axis for images. 

o Ver – the Y axis, typically the intensity axis for spectra, or the Y (µm) axis for images. 

o Intens – the intensity axis for images. 

From and To 

Displays the start (“From”) and stop (“To”) axis values which will be displayed.  These can be 

manually adjusted by typing in desired values and clicking [OK]. 

Freeze 

When “Freeze” is ticked the axis scaling is fixed, and will not be affected by scale normalization (see 

section 4.4.1, page 91), its right click shortcut “Rescale” or its keyboard shortcut <CTRL>+N. 

The axis scaling can also be fixed using the Fast Graph Settings and selecting “Fixed” for the axis 

(see section 6.2, page 198). 

Auto 

When “Auto” is ticked the axis will autoscale to display all data open in the data window. 

The axis scaling can also be set to autoscaling by using the Fast Graph Settings and selecting “Auto” 

for the axis (see section 6.2, page 198). 

Rel 

When “Rel” is ticked all data open in the data window will be displayed with identical minimum and 

maximum intensities.  The scale values displayed for the axis will correspond to the active data 

object. 

The data shown right are displayed with normal 

scaling. 

 

 

 

The data shown right are displayed with relative 

scaling.  The active spectrum is ——. 

 

 

 

The axis scaling can also be set to relative scaling by using the Fast Graph Settings and selecting 

“Relative” for the axis (see section 6.2, page 198). 
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Log 

When “Log” is ticked the axis will be displayed with logarithmic scaling rather than linear scaling. 

8.2. Fast Settings 

When “Fast settings” is ticked, the Fast Graph Settings are active (see section 6.2, page 198). 

Left click on “Fast settings” to tick (activate) or untick (deactivate) this function. 

Available for: Spectrum, Video, SpIm, Point, Map, Score, Model 

8.3. Rescale 

Left click on “Rescale” to rescale the active window so that all data is visible.  In normal operation all 

axes are affected, but note that an axis with scaling set to “Fixed” will not be rescaled.  To rescale an 

axis ensure that “Freeze” or “Fixed” scaling is turned off (see section 8.1, page 205). 

This function can also be activated with the Scale Normalization icon (see section 4.4.1, page 91) or 

with the <CTRL>+N keyboard shortcut. 

Available for: Spectrum, Video, SpIm, Point, Map, Score, Model 

8.4. Swap X axis 

Click on “Swap X axis” to reverse the X axis display. 

_________________________________________________________________________________ 

 

CAUTION: WHEN AN XY MOTORIZED SAMPLE STAGE IS PRESENT, THE AXIS DISPLAY FOR VIDEO IMAGES 

SHOULD ALWAYS BE LEFT IN THE DEFAULT CONFIGURATION TO ENSURE CORRECT MAPPING AND EXTENDED 

VIDEO IMAGING ACQUISITION. 

 

THE X AXIS SHOULD HAVE UNITS RUNNING FROM 

NEGATIVE ON THE LEFT HAND SIDE, THROUGH TO 

POSITIVE ON THE RIGHT HAND SIDE, AS DISPLAYED 

RIGHT. 

 

 

 

 

 

 

_________________________________________________________________________________ 

 

Available for: Spectrum, Video, SpIm, Point, Map, Score, Model 
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8.5. Swap Y axis 

Click on “Swap Y axis” to reverse the Y axis display. 

_________________________________________________________________________________ 

 

CAUTION: WHEN AN XY MOTORIZED SAMPLE STAGE IS PRESENT, THE AXIS DISPLAY FOR VIDEO IMAGES 

SHOULD ALWAYS BE LEFT IN THE DEFAULT CONFIGURATION TO ENSURE CORRECT MAPPING AND EXTENDED 

VIDEO IMAGING ACQUISITION. 

 

THE Y AXIS SHOULD HAVE UNITS RUNNING FROM 

NEGATIVE AT THE TOP, THROUGH TO POSITIVE AT THE 

BOTTOM, AS DISPLAYED RIGHT. 

 

 

 

 

 

 

 

_________________________________________________________________________________ 

 

Available for: Spectrum, Video, SpIm, Point, Map, Score, Model 

8.6. Image Colors 

The Colors dialog window allows control of the color palettes used for image rendition, and 

adjustment of image brightness and contrast. 

 

Available for: Spectrum, Video, SpIm, Point, Map, Score, Model 
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8.6.1. Colors 

LabSpec 5 uses an RGB palette for its image rendition – by default, red (R), green (G) and blue (B) 

components are used to create the colored images displayed. 

When a color “Red”, “Green” or “Blue” is ticked, it will be used to create the colored images.  For 

correct color rendering of images based on the selected color palette (see section 8.6.2, page 212) 

ensure that all three colors (“Red”, “Green” and “Blue”) are ticked. 

When “Neg” is ticked, the negative image will be displayed for the selected color palette. 

8.6.2. Palette 

Available color palettes are listed in this section.  Left click on one of the palette radio buttons ( ) to 

select the palette. 

There are two types of palette: 

o True color – with this palette each color 

component is displayed in its true color.   

 

In the case of a video image, the three 

components (red, green and blue) are 

displayed in their individual colors to yield 

a composite colored image. 

 

In the case of a map image created from 

a multidimensional spectral array the 

cursor intensity image corresponds to the 

cursor color.  For example, the image 

generated using the red map analysis 

cursor will be displayed in a one color red 

scale. 

 

In the case of a score image created 

from a multidimensional spectral array 

the score image corresponds to the 

reference component spectrum displayed 

in the Model window.  For example, the 

score image for a red spectrum in the 

Model window will be displayed in a one 

color red scale. 

 

This palette should be used for video 

images, and map/score images where 

multiple components are overlaid. 
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o False color – with one of these palettes, 

image pixels are displayed in different 

colors depending on their intensity. 

 

These palettes are useful when an image 

has regions of both high and low 

intensity, which can be hard to visualize 

with a traditional true color palette. 

 

These palettes should only be used for 

representation of a single component 

(e.g., a single cursor intensity map 

image, or a single score image). 

8.6.3. Contrast and Brightness 

Left click and drag the “Brightness” slider to adjust 

the brightness for the image display.  

Left click and drag the “Contrast” slider to adjust 

the contrast for the image display. 

If {All} is selected ( ), the brightness and contrast 

adjustments will affect the complete RGB palette. 

If one of {R}, {G} or {B} is selected ( ), the 

brightness and contrast adjustments will only affect 

the selected component (R, red; G, green; B, blue) 

of the RGB palette. 

Click on the Contrast and Brightness Initialization 

icon to reset the brightness and contrast settings to 

their default values.  Note that this operation needs 

to be done individually for {All}, {R}, {G} and {B}. 

8.7. Center Cursor 

Left click on “Center cursor” to center the active cursor(s) in the active window. 

This function is useful when cursors are not visible in a window, because their position lies outside the 

range of the window.  Right click and select “Center cursor” and the cursor(s) will be immediately 

visible in the center of the window. 

This function can also be activated with the Center Cursors icon (see section 4.4.3, page 92). 

Available for: Spectrum, Video, SpIm, Point, Map, Score, Model 
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8.8. Axes 

The Axes dialog window allows control over what axes are displayed, and how they are displayed 

within the data window. 

There are two Axes dialog windows, depending on the selected dimension (see section 8.1.1, page 

205) of the data window.  These two windows are discussed in turn below. 

Available for: Spectrum, Video, SpIm, Point, Map, Score, Model 

8.8.1. Axes Dialog Window for 1D and 2D Windows 

 
 

8.8.1.1. Options 

The five possible display axes are listed, with tick boxes to select whether ticks, grid lines, axis values 

and labels are shown. 

 

The fives axes are indicated on the image shown 

right. 
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Ticks 

When the “Ticks” box is ticked tick marks are displayed on the axis. 

Grid 

When the “Grid” box is ticked ‘main’ and ‘sub’ grid lines are displayed in the spectrum window.  The 

spacing of the grid lines are automatically calculated by LabSpec 5, but can be manually assigned 

using the “Fix X grid to” and “Fix Y grid to” options in the Style section of the Axes dialog window (see 

section 8.8.1.2, page 215) 

Values 

When the “Values” box is ticked axis values are displayed along the axis. 

Labels 

When the “Labels” box is ticked the axis title and units are displayed adjacent to the axis.  Custom 

labels can be used by typing in the desired axis label in the “Labels” text box. 

To restore the default labels for an axis delete the text in the box. 

8.8.1.2. Style 

The Style section allows the formatting of the axis components (frame, ticks, grid lines, values and 

labels) to be set. 

Frame 

Select the line style for the axes frame using the “Frame” drop down box. 

Main grid 

Select the line style for the ‘main’ grid lines using the “Main grid” drop down box. 

Sub grid 

Select the line style for the ‘sub’ grid lines using the “Sub grid” drop down box. 

Fix X grid to 

When the “Fix X grid to” box is ticked the main grid lines for the X axis will be spaced at the interval 

displayed in the box.  To adjust the spacing type the desired grid line spacing into the text box. 

3D look 

When the “3D look” box is ticked the axes frame is displayed in a “3D” style. 

Values 

Select the font style for the axis values from the “Values” drop down box. 

Labels 

Select the font style for the axis values from the “Labels” drop down box. 

Ticks 

Select the line style for the ticks using the “Ticks” drop down box. 

Fix Y grid to 

When the “Fix Y grid to” box is ticked the main grid lines for the Y axis will be spaced at the interval 

displayed in the box.  To adjust the spacing type the desired grid line spacing into the text box. 
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8.8.2. Axes dialog Window for 3D Windows 

 

8.8.2.1. Options 

The schematic in the Options section illustrates the seven available axes (six surrounding the 3D 

image, and one for intensity).  Each axis is configured individually. 

Select an axis by clicking the appropriate radio tag. 

When the tick box is ticked the three forward axes are displayed, in front of the 3D image. 

Ticks 

When the “Ticks” box is ticked tick marks are displayed on the axis. 

Values 

When the “Values” box is ticked axis values are displayed along the axis. 

Labels 

When the “Labels” box is ticked the axis title and units are displayed adjacent to the axis.  Custom 

labels can be used by typing in the desired axis label in the “Labels” text box. 

To restore the default labels for an axis delete the text in the box. 

Swap X and Y 

Click on [Swap X and Y] to reverse the positions of the X and Y axes in the 3D image display. 

Re-center image 

Click on [Re-center image] to return the image to its default position in the display window.  This 

function is useful if the image position has been modified using the Axes3D icon – see section 5.24, 

page 194. 

8.8.2.2. Style 

The Style section allows the formatting of the axis components (frame, ticks, values and labels) to be 

set. 

Frame 

Select the line style for the axes frame using the “Frame” drop down box. 
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Ticks 

Select the line style for the ticks using the “Ticks” drop down box. 

Values 

Select the font style for the axis values from the “Values” drop down box. 

Labels 

Select the font style for the axis values from the “Labels” drop down box. 

8.9. Legend 

The Legend dialog window allows control of the legend display and formatting. 

 

The legend is displayed for spectral windows, and 

shows the data object name and its display color. 

 

 

 

Show 

Tick the boxes for Single and Multi to activate the legend for single and overlay display modes 

respectively. 

Frame 

Select the line style for the legend frame using the “Frame” drop down box. 

Text 

Select the font style for the legend text from the “Text” drop down box. 

Available for: Spectrum, SpIm, Point, Model 
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8.10. Spectrum 

The Spectrum dialog window allows control of the spectrum display format. 

 

 

Style 

Select the display style from the following options: 

o Line  

 

 

 

 

 

 

 

 

 

o Dot 

 

 

 

 

 

 

 

 

 

o Bar 
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Use same style for all spectra 

When “Use same style for all spectra” is ticked all spectra in the current window will share a common 

line style, based upon the current setting in the Spectrum dialog window. 

If “Use same style for all spectra” is not ticked then the line style setting in the Spectrum dialog 

window is applied to the active spectrum only.  In this mode it is possible to have multiple spectra 

displayed with different line styles. 

Line 

Select the spectrum display color and (where appropriate) line style for the spectrum using the “Line” 

drop down box. 

Point size 

Select the point size for the “Dot” spectrum display.  Note that the point color is set in the “Line” drop 

down box. 

Available for: Spectrum, SpIm, Point, Model 

8.11. Cursor 

The Cursor dialog window allows control of the cursor behaviour and display format. 

 

Style 

Select the cursor style from the “Style” drop down box.  The following cursor styles are available: 

Spectrum, Model windows 

o Line – single vertical line cursor, displaying the X axis position (S) of the cursor and the 

intensity (I) of the spectrum at the cursor position. 

o Cross – cross hair cursor, displaying the X axis position (S) and Y axis position (I) of the 

cursor. 

o Level – cross hair cursor which tracks the intensity of the spectrum, displaying the X axis 

position (S) and Y axis position (I) of the cursor.  In this case, the Y axis position is 

equivalent to the spectrum intensity at the cursor position. 

o Double – two vertical cursors, displaying the X axis position (S) of each cursor and the width 

between the two cursors (W). 

o Peak – three linked vertical cursors, the central one locking to the maximum intensity pixel in 

a peak, and the outer two locking to the pixels closest to the full width at half maximum 



 

 

 

 

height (FWHM) of the peak.  The Peak cursor displays the X axis position (S), intensity (I) 

and approximate full width at half maximum height (W) of the peak at the cursor position.

Video, Map, Score windows

o Cross – cross hair cursor, displaying the X axis position (X) and Y axis position (Y) of the 

cursor, and pixel intensity (I) at the cursor position.  For the Map and Score windows, the

spectrum associated with the cursor position will be displayed in the Point window.

o Rect – rectangular cursor (resizeable by left clicking and dragging the drag points), 

displaying the X axis position (X) and Y axis position (Y) of the bottom, right hand 

the rectangular cursor.  For the Map and Score windows, the average spectrum from within 

the rectangle is displayed in the Point window.

Selected 

Select the display formatting for the cursor when it is selected (i.e., active), using the Selected 

down box. 

Deselected 

Select the display formatting for the cursor when it is not selected (i.e., inactive), using the Deselected 

drop down box. 

Transparent 

When “Transparent” is ticked the cursor is displayed in a transparent mode, allowing features b

the cursor to be visualized. 

Fixed width 

When “Fixed width” is ticked the width between “Double” cursors is fixed to its current value.  In this 

mode, both cursors will move together when dragged by the mouse.  To adjust the width of the 

“Double” cursors ensure that “Fixed width” is unticked.

Allow selected points 

When “Allow selected points” is ticked multiple discrete points within a map or score profile/image can 

be selected. 

When <CTRL> is held down the mouse cursor 

changes to the Select Point cursor.

<CTRL>+click to select a position in the map or 

score profile/image.  Multiple positions can be 

simultaneously selected by clicking additional 

positions. 

When <CTRL> is held down and the mouse cursor 

is hovered over an existing selected point, the 

mouse cursor changes to the Remove point cursor.

<CTRL>+click to delete an existing selected point.

The average spectrum from the selected points will 

be displayed in the Point window.
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the rectangular cursor.  For the Map and Score windows, the average spectrum from within 

Select the display formatting for the cursor when it is selected (i.e., active), using the Selected drop 
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Add position to custom info 

When “Add position to custom info” is ticked the cursor values are included within the Custom tab of 

the parameters information dialog window (see section 4.4.5, page 92). 

Available for: Spectrum, Video, Map, Score, Model 

8.12. Red Cursor 

The Red Cursor dialog window allows control of the cursor behaviour and display format for the red 

(SpImRed) map analysis cursor (see section 5.2, page 166). 

The Red Cursor dialog window is identical to the standard Cursor dialog window described above 

(see section 8.11, page 219). 

The map analysis cursor should be operated in “Double” mode.  It is advisable that the color is 

retained as red to avoid confusion. 

Available for: SpIm, Point 

8.13. Green Cursor 

The Green Cursor dialog window allows control of the cursor behaviour and display format for the 

green (SpImGreen) map analysis cursor (see section 5.2, page 166). 

The Green Cursor dialog window is identical to the standard Cursor dialog window described above 

(see section 8.11, page 219). 

The map analysis cursor should be operated in “Double” mode.  It is advisable that the color is 

retained as green to avoid confusion. 

Available for: SpIm, Point 

8.14. Blue Cursor 

The Blue Cursor dialog window allows control of the cursor behaviour and display format for the blue 

(SpImBlue) map analysis cursor (see section 5.2, page 166). 

The Blue Cursor dialog window is identical to the standard Cursor dialog window described above 

(see section 8.11, page 219). 

The map analysis cursor should be operated in “Double” mode.  It is advisable that the color is 

retained as blue to avoid confusion. 

Available for: SpIm, Point 
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8.15. Image 

The Image dialog window allows the image color and smoothing options to be set. 

 

Style 

Select the smoothing interpolation style from the 

available options: 

o No smoothing – image is displayed in 

raw pixelated form.  

o X smoothing – image is displayed with 

smoothing interpolation in the X 

dimension.  

o Y smoothing – image is displayed with 

smoothing interpolation in the Y 

dimension.  

o XY smoothing – image is displayed with 

smoothing interpolation in the X and Y 

dimensions. 

Color 

Select the image display color for the active image component from the “Color” drop down box. 

Note that the color selected is only displayed when the image is displayed in True Color mode – see 

section 8.6, page 211) for full information about image colors. 

When the color is changed for a DCLS modelling score image the reference component spectrum 

display in the Model and Point windows will be automatically updated.  Similarly, the score image 

color will be automatically updated if the reference component spectrum color is modified in the Model 

window. 

Available for: Video, Map, Score 
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8.16. Scale Bar 

The Scale Bar dialog window allows control of display formatting for the image scale bar. 

 

Line 

Select the line style from the “Line” drop down box for the line surrounding the scale bar. 

Fill 

Select the fill colour from the “Fill” drop down box for the scale bar. 

Font 

Select the font style from the “Font” drop down box for the scale display text.  Note that the color of 

the text is set through the “Color” drop down box. 

Color 

Select the color from the “Color” drop down box for the scale display text. 

Available for: Video, Map, Score 

8.17. Imposition 

The Imposition dialog window allows information from the multidimensional spectral array Map and 

Score windows to be superimposed on the active video camera image. 

The display color is automatically assigned by LabSpec 5 to match the color of the object being 

superimposed. 

To start the selected superimposition click [OK] and then activate a Map or Score window. 
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Show data limits 

When “Show data limits” is ticked, the mapping 

area is superimposed on the video image. 

 

 

 

Show data points 

When “Show data points” is ticked, the individual 

acquisition positions for the map are superimposed 

on the video image. 

 

 

 

 

Show data name 

When “Show data name” is ticked, the name of the 

image component is superimposed on the video 

image. 

 

 

 

Show index 

When “Show index” is ticked, the XY index of the 

individual acquisition positions for the map are 

superimposed on the video image. 

 

 

 

 

Overlay images 

When “Overlay images” is ticked the Map or Score 

image is superimposed on the video image.  Note 

that the overlay mode in the Map/Score window 

will be reflected in the superimposition. 
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1 µm

1 µm
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The superimposed image will always be displayed 

in True Color, whatever the palette setting in the 

Colors dialog window – see section 8.6, page 211. 

Font 

Select the font style for the data index and data 

name text display from the “Font” drop down box.  

Note that the font color is automatically assigned 

by LabSpec 5 to match the color of the object 

being superimposed. 

Available for: Video 

8.18. Image3D 

The Image3D dialog window allows control of formatting and display options for 3D images.  It should 

be used in conjunction with the Colors dialog window (see section 8.6, page 211). 

 

 

Type 

Select the display mode from the following options: 

o Line 

 

The line color is selected from the “Line” 

drop down box. 
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o Line and Fill 

 

The line color is selected from the “Line” 

drop down box.  The line display can be 

removed by setting the line color to 

“None”. 

 

When there is no “Gradation” selected 

(i.e., X, Y and Z gradation boxes are all 

unticked) the fill color is selected from the 

“Fill” drop down box.  The example 

shown right is displayed without 

gradation. 

 

 

 

 

 

 

 

When “Gradation” is selected (i.e., one or 

more of the X, Y and Z gradation boxes 

are ticked) the graded fill color is set 

according to the palette selected in the 

Colors dialog window (see section 8.6, 

page 211).  The example shown right is 

displayed with Z gradation using a 

greyscale palette. 

 

 

 

 

 

 

Gradation 

Select the axis (or axes) direction for graded fill color: 

o X – graded fill from low X axis value to 

high X axis value. 
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o Y – graded fill from low Y axis value to 

high Y axis value. 

 

 

 

 

 

 

 

 

 

 

 

 

o Z – graded fill from low Z (intensity) axis 

to high Z (intensity) axis. 

 

 

 

 

 

 

 

 

 

 

 

 

Color 

Select the line color from the “Color” drop down box. 

Note that the Line and Width options in this drop down box are not active for 3D images. 

Fill 

Select the fill color from the “Fill” drop down box.  The fill color selected in the “Fill” drop down box is 

only displayed when the “Line and Fill” type is selected, and no gradation option is selected (see 

above).  If a gradation option is selected, the fill color is set according to the palette selected in the 

Colors dialog window (see section 8.6, page 211). 

Note that the Fill option in this drop down box is not active for 3D images. 

Available for: Video, SpIm, Map, Score (when displayed in 3D mode) 

 

  

5

In
te

n
si

ty
 (

a.
u
.)

-100

0

100

X (µm)

0

100
Y (µ

m)

5

In
te

n
si

ty
 (

a.
u
.)

-100

0

100

X (µm)

0

100
Y (µ

m)



 

 

 

 

9. Control Panel 

The Control Panel located at the bottom of the screen contains sections which are directly related to 

the hardware configuration of the instrument.  This panel will 

correctly installed and configured.  The descripti

aware that some of these may not be visible in your software.

9.1. Laser 

The drop down box lists all of the laser 

wavelengths available on the instrument.

Click on the drop down box to display the list, and 

then select the laser wavelength to be used.

 

 

On fully automated systems (such as LabRAM 

ARAMIS, automated LabRAM HR, or XploRA) the 

necessary hardware and optics will switch 

automatically. 

On manual systems (such as LabRAM 300, 

LabRAM 1B, manual LabRAM HR, U1000 or 

T64000) remember to change the optics necessary 

to use the selected laser.  These optics include 

switching mirror(s), interference fil

notch/edge filter(s). 

9.2. Filter 

Most systems have a number of neutral density filters available which can be used to reduce the laser 

power incident on the sample.  

power, and burns/degrades when the full power is used.  Note that the detected Raman signal is 

proportional to laser power, so the lower the laser power the longer your measurement will 

to obtain a good quality Raman spectrum.

These filters are motorized, and will automatically be inserted into the laser path once selected.

The drop down box lists all of the 

on the instrument.  These will be displayed either

in optical density (OD) or percentage (%).

following table shows the relationship between OD 

and % values. 
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The Control Panel located at the bottom of the screen contains sections which are directly related to 

the hardware configuration of the instrument.  This panel will only show sections for devices which are 

correctly installed and configured.  The description below shows all of the standard

aware that some of these may not be visible in your software. 

The drop down box lists all of the laser 

n the instrument. 

Click on the drop down box to display the list, and 

then select the laser wavelength to be used.  

On fully automated systems (such as LabRAM 

ARAMIS, automated LabRAM HR, or XploRA) the 

necessary hardware and optics will switch 

On manual systems (such as LabRAM 300, 

LabRAM 1B, manual LabRAM HR, U1000 or 

to change the optics necessary 

to use the selected laser.  These optics include 

switching mirror(s), interference filter(s) and 

Most systems have a number of neutral density filters available which can be used to reduce the laser 

power incident on the sample.  Typically these are necessary if the sample is sensitive to the laser 

power, and burns/degrades when the full power is used.  Note that the detected Raman signal is 

proportional to laser power, so the lower the laser power the longer your measurement will 

to obtain a good quality Raman spectrum. 

d, and will automatically be inserted into the laser path once selected.

The drop down box lists all of the filters available 

These will be displayed either 

in optical density (OD) or percentage (%). The 

following table shows the relationship between OD 
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The Control Panel located at the bottom of the screen contains sections which are directly related to 

show sections for devices which are 

standard sections, but be 

Most systems have a number of neutral density filters available which can be used to reduce the laser 

Typically these are necessary if the sample is sensitive to the laser 

power, and burns/degrades when the full power is used.  Note that the detected Raman signal is 

proportional to laser power, so the lower the laser power the longer your measurement will need to be 

d, and will automatically be inserted into the laser path once selected. 
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OD      % 

 

- - - 100% (no attenuation) 

D0.3 50% 

D0.6 25% 

D1 10% 

D2 1% 

D3 0.1% 

D4 0.01% 

 

Click on the drop down box to display the list, and 

then select the filter to be used. 

9.3. Hole 

The confocal hole is used to define the spatial resolution and analysis volume of a measurement, and 

should be used in conjunction with correct choice of microscope objective and laser wavelength to 

fully optimise a measurement.   

Typically the confocal performance of a system improves (i.e., the spatial resolution increases) as the 

confocal hole diameter decreases.   

Confocal analysis 

Confocal analysis means the measurement will be made with high spatial resolution, suitable for 

analysis of true microscopic particles and thin layers with dimensions in the range 500nm – 10µm.  To 

analyze these types of samples the hole should be set to a small diameter. Note that in a confocal 

mode you are analysing less molecules (because the analysis volume is small), and the signal level 

you observe will decrease. 

Macro or bulk analysis 

For analysis of bulk powders and liquids, or any sample where high spatial resolution is not 

necessary, it is best to run the system in a non-confocal mode.  By setting the hole diameter to a large 

value the spatial resolution will be low, and the analysis volume of the measurement will be increased.  

Note that in a non-confocal mode you are analysing more molecules (because the analysis volume is 

large), and the signal level you observe will increase. 

Some instruments have fully adjustable holes, whilst others have fixed hole settings.  The controls on 

these are different. 

9.3.1. Control of fully adjustable hole 

Type in the desired diameter of the hole, and press 

<enter ����   > so that the value is registered. 

Click on the left hand arrow to send the hole to a 

closed position (0 µm diameter). 

Click on the right hand arrow to send the hole to its 

maximum position. 



 

 

 

 

Click on the initialization icon to send the hole to its 

reference position, and then back to the displayed 

diameter. 

9.3.2. Control of fixed position

The drop down box lists all of the 

available on the instrument. 

 

 

 

Click on the drop down box to display the list, and 

then select the hole diameter to be used

Click on the initialization icon to send the hole to its

reference position, and then back to the displayed 

diameter. 

9.4. Slit 

The slit is used to define spectral resolution, and should be used in conjunction with c

laser wavelength and diffraction grating.  On most systems equipped with array detectors (such as a 

CCD or InGaAs array) the diffraction grating

effect on spectral resolution than the slit

grating has been selected. 

Typically the spectral resolution of a system will increase as the slit width is decreased.  High spectral 

resolution (obtained with a narrow slit width) 

analyzed, and close lying peaks to be separated.

Some instruments have fully adjustable 

these are different. 

9.4.1. Control of fully adjustable 

Type in the desired diameter of the 

<enter ����   > so that the value is registered.

Click on the left hand arrow to send the 

closed position (0 µm width). 

Click on the right hand arrow to send the 

maximum position. 
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ation icon to send the hole to its 

reference position, and then back to the displayed 

fixed position hole 

the hole diameters 

Click on the drop down box to display the list, and 

to be used. 

ation icon to send the hole to its 

reference position, and then back to the displayed 

The slit is used to define spectral resolution, and should be used in conjunction with c

laser wavelength and diffraction grating.  On most systems equipped with array detectors (such as a 

diffraction grating (see section 9.6.1, page 232) has a more significant 

than the slit.  The slit should only be adjusted once a suitable diffraction 

Typically the spectral resolution of a system will increase as the slit width is decreased.  High spectral 

(obtained with a narrow slit width) allows subtle changes in a spectrum to be confidently 

d, and close lying peaks to be separated. 

Some instruments have fully adjustable slits, whilst others have fixed slit settings.  The controls on 

Control of fully adjustable slit 

r of the slit, and press 

so that the value is registered. 

Click on the left hand arrow to send the slit to a 

Click on the right hand arrow to send the slit to its 
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The slit is used to define spectral resolution, and should be used in conjunction with correct choice of 

laser wavelength and diffraction grating.  On most systems equipped with array detectors (such as a 

has a more significant 

nly be adjusted once a suitable diffraction 

Typically the spectral resolution of a system will increase as the slit width is decreased.  High spectral 

trum to be confidently 

settings.  The controls on 



 

 

 

Click on the initialization icon to send the 

reference position, and then back to the displayed 

width. 

9.4.2. Control of fixed position 

The drop down box lists all of the 

available on the instrument. 

 

 

 

Click on the drop down box to display the list,

then select the slit diameter to be used

Click on the initialization icon to send the 

reference position, and then back to the displayed 

width. 

9.5. Spectrometer 

The spectrometer control allows the wavelength (nm) or wavenumber (Raman shift, cm

be selected.  With an array detector (such as CCD or InGaAs array) the specified 

wavelength/wavenumber position lies at the 

this position will be detected.  The precise range depends upon the spectrometer focal length, laser 

wavelength, and diffraction grating.  

As an example, if the spectrometer position is set at 1500cm

970cm
-1

, and the highest position could 

1500cm
-1

.  

The spectrometer position can be quickly controlled, allowing you to monitor Raman peaks in a 

specific area of the full spectrum.  In most 

spectrum range, which is typically 100

Raman range then you should use the Extended Range 

Type in the desired central position of the 

spectrometer, and press <enter 

value is registered.  The current units will be 

displayed next to the input box. 

 

Click on the left hand arrow to send the 

spectrometer to the calibration ‘Zero Order’ 

position (0 nm). 
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ation icon to send the slit to its 

reference position, and then back to the displayed 

Control of fixed position slit 

The drop down box lists all of the slit diameters 

Click on the drop down box to display the list, and 

to be used. 

ation icon to send the slit to its 

reference position, and then back to the displayed 

The spectrometer control allows the wavelength (nm) or wavenumber (Raman shift, cm

be selected.  With an array detector (such as CCD or InGaAs array) the specified 

wavelength/wavenumber position lies at the center of the detector, and a certain range either side of 

this position will be detected.  The precise range depends upon the spectrometer focal length, laser 

wavelength, and diffraction grating.   

As an example, if the spectrometer position is set at 1500cm
-1

 then the lowest position cou

and the highest position could be 2030cm
-1

.  The central position in the spectrum will be 

The spectrometer position can be quickly controlled, allowing you to monitor Raman peaks in a 

specific area of the full spectrum.  In most cases, the detected range will be less than the full Raman 

spectrum range, which is typically 100-4000cm
-1

.  If you wish to acquire a spectrum across the full 

use the Extended Range mode – see section 3.5.6

Type in the desired central position of the 

<enter ����   > so that the 

value is registered.  The current units will be 

 

Click on the left hand arrow to send the 

to the calibration ‘Zero Order’ 
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The spectrometer control allows the wavelength (nm) or wavenumber (Raman shift, cm
-1

) position to 

be selected.  With an array detector (such as CCD or InGaAs array) the specified 

ain range either side of 

this position will be detected.  The precise range depends upon the spectrometer focal length, laser 

then the lowest position could be 

The central position in the spectrum will be 

The spectrometer position can be quickly controlled, allowing you to monitor Raman peaks in a 

cases, the detected range will be less than the full Raman 

.  If you wish to acquire a spectrum across the full 

3.5.6, page 49. 
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Click on the right hand arrow to send the 

spectrometer to its maximum position. Note that 

the maximum position will depend upon the 

spectrometer, laser and diffraction grating. 

Click on the initialization icon to send the 

spectrometer to its calibration position, and then 

back to the displayed position. 

9.6. Options 

The Options section allows you to specify the diffraction grating, microscope objective and data name 

tag.  

 

 

 

 

9.6.1. Diffraction grating 

The diffraction grating is the dispersing optical element within the spectrometer, which splits the 

spectrum into its constituent colours. 

Each grating offers a certain level of dispersion (which affects the spectral resolution of the system) 

and wavelength coverage (which affects the spectrum intensity, and compatibility with particular laser 

wavelengths).  Gratings are typically classified by a number of grooves per mm – for example, 

300gr/mm (low resolution) or 3600gr/mm (high resolution).  The higher the number the higher the 

achievable spectral resolution. 

Each system is equipped with different diffraction gratings, which are chosen to take into account the 

available laser wavelengths and requirements for spectral resolution.   

Most instruments have grating turrets, with multiple gratings attached.  This allows you to quickly 

switch from one grating to another (for example, to switch from low resolution to high resolution 

analysis).  The following list shows the standard maximum number of gratings available on the turret: 

1 grating (fixed position): HE spectrograph, Axial spectrograph 

1 grating: U1000, T64000 

2 gratings (manual switching): LabRAM 300 / 1B (and IR, IR
2
 and INV configurations) 

2 gratings (motorized switching): LabRAM HR (and IR, IR
2
 and INV configurations) 

4 gratings (motorized switching): LabRAM ARAMIS (and IR and IR
2
 configurations), XploRA 

 

It is also possible to manually exchange diffraction gratings on the LabRAM HR base unit, U1000 and 

T64000.  For example, a LabRAM HR could be equipped with three diffraction gratings in total.  Two 

would be mounted on the motorized turret, and the third would be kept in a box by the system.  One 

Diffraction grating 

Microscope objective 

Data name tag 



 

 

 

of the gratings on the turret could be exchanged with the third grating if desired. 

grating typically takes a few minutes to complete, and there is no optical realignment required.

9.6.1.1. Selecting a grating

The drop down box lists all of the 

gratings available on the instrument.

Click on the drop down box to display the list, and 

then select the diffraction grating

 

A message will prompt you to now manually select 

the desired diffraction grating.  Typically this is 

done on the instrument using a push

other switching device.  Once the diffraction grating 

is selected click [OK]. 

 

9.6.1.2. Selecting a grating (

The drop down box lists all of the 

gratings available on the instrument.

Click on the drop down box to display the list, and 

then select the diffraction grating

diffraction grating will now be moved into positio

by the software. 

9.6.1.3. Selecting a grating for manual exchange

The drop down box lists all of the 

gratings available on the instrument.

Click on the drop down box to display the list

Gratings available for manual exchange are listed 

with either “A->” or “B->” in front of their identifier.  

This implies that they are intended to be 

exchanged in the A position of the turret, or the B 

position of the turret.  The first grating listed (in this 

case 1800) is in the A position.  The second 

grating listed (in this case the 600) is in the B 

position.   

This example shows that there is also a 300gr/mm 

grating which could be exchanged in the B 
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of the gratings on the turret could be exchanged with the third grating if desired.  Manually exchang

grating typically takes a few minutes to complete, and there is no optical realignment required.

Selecting a grating (manual turret) 

The drop down box lists all of the diffraction 

available on the instrument. 

drop down box to display the list, and 

the diffraction grating to be used.  

A message will prompt you to now manually select 

the desired diffraction grating.  Typically this is 

done on the instrument using a push-pull bar, or 

other switching device.  Once the diffraction grating 

Selecting a grating (motorized turret) 

The drop down box lists all of the diffraction 

available on the instrument. 

Click on the drop down box to display the list, and 

the diffraction grating to be used. The 

diffraction grating will now be moved into position 

Selecting a grating for manual exchange 

The drop down box lists all of the diffraction 

available on the instrument. 

Click on the drop down box to display the list.  

available for manual exchange are listed 

>” in front of their identifier.   

they are intended to be 

exchanged in the A position of the turret, or the B 

position of the turret.  The first grating listed (in this 

e 1800) is in the A position.  The second 

grating listed (in this case the 600) is in the B 

This example shows that there is also a 300gr/mm 

grating which could be exchanged in the B 
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Manually exchanging 

grating typically takes a few minutes to complete, and there is no optical realignment required. 



 

 

 

 

position.  This means that it would replace the 

current 600gr/mm grating. 

To replace the diffraction grating first select the 

diffraction grating you wish to replace, and send 

the spectrometer to Zero Order (see

page 231).  Now take out the current diffraction 

grating, and replace it with desired replacement 

diffraction grating. 

 

Once the manual exchange is complete, 

select the replacement diffraction grating in the 

drop down list. 

 

 

A message box will appear prompting you to 

replace the grating.  Click [OK]. 

 

 

 

_________________________________________________________________________________

 

CAUTION: THE DIFFRACTION GRATING 

YOU TOUCH OR SCRATCH THE SURFACE OF THE G

INSTRUMENT IMMEDIATELY PLACE IT IN ITS P

____________________________________

9.7. Microscope objective

On most systems the microscope is manually controlled, and objectives

and exchanged.  However, it is important that the correct objective is also selected in 

order to have correctly scaled video images, and for Raman maps to be acquired over the correct part 

of the sample. 

9.7.1.1. Selecting a microscope objective

The drop down box lists all of the 

available on the microscope. 

Click on the drop down box to display the list

then select the objective to be used
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position.  This means that it would replace the 

To replace the diffraction grating first select the 

diffraction grating you wish to replace, and send 

to Zero Order (see section 9.5, 

).  Now take out the current diffraction 

grating, and replace it with desired replacement 

exchange is complete, now 

select the replacement diffraction grating in the 

A message box will appear prompting you to 

 

_________________________________________________________________________________

DIFFRACTION GRATING IS EXTREMELY FRAGILE AND EXPENSIVE.  ON NO ACCOUNT SHOULD 

THE SURFACE OF THE GRATING.  AS SOON AS IT IS REMO

LY PLACE IT IN ITS PROTECTIVE CASING. 

_________________________________________________________________________________

Microscope objective 

On most systems the microscope is manually controlled, and objectives must be manually selected 

and exchanged.  However, it is important that the correct objective is also selected in 

order to have correctly scaled video images, and for Raman maps to be acquired over the correct part 

microscope objective 

The drop down box lists all of the objectives 

Click on the drop down box to display the list and 

to be used.  
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_________________________________________________________________________________ 

N NO ACCOUNT SHOULD 

S SOON AS IT IS REMOVED FROM THE 

_____________________________________________ 

must be manually selected 

and exchanged.  However, it is important that the correct objective is also selected in LabSpec 5 in 

order to have correctly scaled video images, and for Raman maps to be acquired over the correct part 
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A message will prompt you to now select the 

desired objective.  Once the correct objective is 

selected on the microscope click [OK]. 

9.8. Data name tag 

The data name tag is a prefix which is used for every newly acquired spectrum.  In addition, it is used 

as the default file name during a File > Save As procedure. 

If the data name is unchanged for multiple accumulations each new spectrum will be acquired with 

the same prefix, and then sequentially numbered. 

In the example shown to the right, the data name 

tag has been set as sample_A.  Each spectrum will 

be acquired as sample_A_1, sample_A_2 etc.     

 

 

If the data name tag is left blank, as in this 

example, then spectra will be automatically 

labelled as _1, _2 etc.  

 

 

9.9. Acquisition 

The Acquisition section allows the user to specify acquisition times (also called exposure times) for 

the Real Time Display, Spectrum Acquisition and Mapping Acquisition, and the number of 

accumulations (or averages) for each measurement.  

 

9.9.1. Real Time Display (RTD) acquisition time 

The Real Time Display (RTD) provides a continuous readout of the detector, and is useful to adjust 

the fine focus of the sample to optimise Raman signal, and to monitor whether a sample is degrading 

or burning.  The RTD is started using the  /  icon – see section 4.5.1, page 95, for more details. 

Real Time Display (RTD) acquisition time (s) 

Acquisition time (s) 

Number of accumulations 
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Normally the RTD acquisition time should be kept small in order to allow fast and continuous 

spectrum read out.  Typical values are in the range 0.2s–2s. 

To adjust the RTD acquisition time simply type the 

desired time (in seconds) into the box, and press 

<enter ����   >. 

 

9.9.2. Acquisition time 

The acquisition time is the time taken to acquire a Raman spectrum.  Typically the longer the 

acquisition time the better quality the resulting spectrum.  The acquisition time set affects the 

Spectrum Acquisition (  / ; see section 4.5.3, page 96) and Mapping Acquisition (  / ; see 

section 4.5.4, page 96). 

Note that for an extended range spectrum acquisition (see section 3.5.6, page 49) the acquisition time 

is the time taken for each spectral window within the full spectral range.  For multidimensional spectral 

array measurements, the acquisition time is the time taken for each spectral window of each spectrum 

acquisition in the array. 

Minimum acquisition times are in the order of 0.2s-0.5s for standard Raman spectra and mapping 

experiments, and <50ms for SWIFT ultra-fast Raman mapping experiments. 

There is no maximum value for the acquisition time, since this will depend on the desired spectrum 

quality – however, the CCD detector will saturate at and above a particular signal level, so it is 

important that the acquisition time is not so large that saturation occurs.  The saturation level depends 

on the specific detector installed on your system.  Modern detectors generally saturate at 

approximately 65,000 counts, whereas older detectors may saturate at lower values (such as 

approximately 32,000 counts). 

To adjust the acquisition time simply type the 

desired time (in seconds) into the box, and press 

<enter ����   >. 

 

 

9.9.3. Number of accumulations 

Acquiring multiple accumulations of data and averaging them results in improved spectrum quality.  

However, with array detectors such as CCDs and InGaAs arrays it is generally best to improve 

spectrum quality by first increasing the acquisition time.  When the saturation point is reached, then it 

is worth increasing the number of accumulations. 

Depending on the chosen mode of the spike (or cosmic ray) filter (see section 3.5.4.7, page 37) it is 

recommended to have a minimum of two accumulations so that the spike filter can detect and remove 

random spikes in the spectrum.  
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Data from multiple accumulations will either be averaged, or summed – the desired mode can be 

selected from Acquisition > Options (see section 3.5.4.6, page 37). 

To adjust the number of accumulations simply type 

the desired number into the box, and press 

<enter ����   >. 

 

 

9.10. XYZ Coords 

  

The XYZ Coords section shows the current position (in micrometers, µm) of installed XY and Z 

stages.  It can be used for a number of functions: 

o Move the stage by a set distance by inputting a value, rather than using the joystick 

o Noting a reference position on a sample, and returning to that position as required 

o Measuring distances moved by the stage 

o Switching between different stage configurations (for example, motorized XY stage and 

DuoScan™). 

There are a number of variants of the XYZ Coords section, depending on the system configuration.  

The operation of each variant is described below. 

9.10.1. Using XYZ Coords 

The current stage position (X, Y and Z coordinates) 

are shown in the respective boxes.  The units are 

micrometers (µm). The tick boxes must be ticked 

for coordinate read out to be active for each axis. 

 

Note that if one of the stages is not present (for 

example, the Z stage) then it will be greyed out. 

 

 



 

 

 

 

The current position coordinates can be set to 0 

µm by clicking on the ‘set current position as origin’ 

icons for each axis.  

 

 

To move the stage to a specific position hig

the current value and type in the desired position 

(in micrometers, µm).  Press <

stage will now move to the desired location.

 

 

________________________________________

 

CAUTION:  MOVE THE STAGE WITH C

IS POSSIBLE TO DAMAGE THE SAMPLE

MICROSCOPE OBJECTIVE IF THE SAMPLE HEIGHT

CHECKED.  THERE IS PARTICULAR R

STAGE IS USED WITH HIGH MAGNIFICATION 

OBJECTIVES. 

________________________________________

 

The coordinate read out and control can be 

deactivated for each axis independently by 

unticking the respective tick box.

 

 

9.10.2. Using XYZ Coords with multiple stages

The main control of XYZ Coords 

outlined above (see section 9.10.1

this section – typically the stages will be “XYZ Motorized” for a standard motori

Scanlab” for the DuoScan™ stage (see section 

Click on the ‘switch stage’ icon

desired stage.  
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position coordinates can be set to 0 

µm by clicking on the ‘set current position as origin’ 

To move the stage to a specific position highlight 

the current value and type in the desired position 

<enter ����   >.  The 

stage will now move to the desired location.  

________________________________________ 

OVE THE STAGE WITH CAUTION, SINCE IT 

MAGE THE SAMPLE, STAGE OR 

IF THE SAMPLE HEIGHT IS NOT 

HERE IS PARTICULAR RISK WHEN THE Z 

IGH MAGNIFICATION 

________________________________________ 

The coordinate read out and control can be 

deactivated for each axis independently by 

respective tick box. 

ing XYZ Coords with multiple stages 

The main control of XYZ Coords when multiple stages are configured and active

9.10.1, page 237).  Note that the name of the XYZ stage is displayed in 

he stages will be “XYZ Motorized” for a standard motoriz

Scanlab” for the DuoScan™ stage (see section 4.5.10, page 111) 

Click on the ‘switch stage’ icon, to select the 
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active is identical to that 

Note that the name of the XYZ stage is displayed in 

zed stage, and “XYZ 



 

 

 

9.11. Instrument Setup

 

 

 

 

The Instrument Setup section is only present for the XploRA

control of the laser beam (on/off) and other 

macro chamber etc). 

9.11.1. Control of Laser Beam (for XploRA

On the XploRA™ system the selected laser (see 

section 9.1, page 228) can be turned on or off 

using the laser toggle switch.  

 

 

Click on the toggle switch to turn the laser on and 

off. 

 

 

 

9.11.2. Control of Laser Beam (for LabRAM ARAMIS)

On the LabRAM ARAMIS system the mechanical 

shutter for the selected laser (

page 228) can be opened or closed using the 

toggle switch.  When the shutter is open the 

sample will be exposed to the laser (if the laser is 

turned on and active). 

Click on the toggle switch to open or close the 

shutter. 
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Instrument Setup 

The Instrument Setup section is only present for the XploRA™ or LabRAM ARAMIS systems.  It allows 

control of the laser beam (on/off) and other hardware options (such as polarizor

Control of Laser Beam (for XploRA™) 

system the selected laser (see 

) can be turned on or off 

turn the laser on and 

Control of Laser Beam (for LabRAM ARAMIS) 

On the LabRAM ARAMIS system the mechanical 

shutter for the selected laser (see section 9.1, 

) can be opened or closed using the 

toggle switch.  When the shutter is open the 

will be exposed to the laser (if the laser is 

Click on the toggle switch to open or close the 

Laser off 

Laser shutter 

closed 
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or LabRAM ARAMIS systems.  It allows 

polarizors, trinocular head, 

Laser on 

Laser shutter 

open 
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9.11.3. Control of Hardware Options (for XploRA™) 

The XploRA Setup window allows control of the following optional items: 

o Trinocular head on the microscope 

o Raman polarizors 

o Laser polarizors 

o Internal adjustment camera 

o White lamp illuminator for the internal adjustment camera 

o Fibre entrance 

 

 

 

 

 

 

 

Please note that depending on the configuration of your system certain items in the Setup window 

may be greyed out. 

The XploRA Setup window is opened by clicking 

on the Setup button. 

 

 

9.11.3.1. Microscope 

Select {Trino On} or {Trino off} to control the optical 

path to the trinocular head. 

Trino On 

Microscope eye pieces and top camera are active; 

Raman path is inactive. 

Trino Off 

Raman path is active; microscope eye pieces and 

top camera are inactive. 
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9.11.3.2. Adjustment Camera 

Click on [Show] to activate the internal adjustment 

camera and to switch the microscope to “Trino Off” 

mode. 

This camera is useful to visualize the laser spot on 

the sample.  White light illumination can be 

provided using the “White Lamp” slider bar to 

control an internal white LED, or by using the 

standard XploRA™ microscope illumination 

options. 

 

9.11.3.3. Raman Polarization 

Select {Horizontal}, {Vertical} or {Circular} to insert 

a polarizor element into the Raman beam path to 

control the polarization of the analyzed Raman 

signal. 

Horizontal 

Only Raman signal which is horizontally polarized 

will be detected. 

Vertical 

Only Raman signal which is vertically polarized will 

be detected. 

Circular 

All Raman signal will be converted to circularly 

polarized light prior to detection.  Most 

spectrometers have different sensitivities for 

horizontally and vertically polarized light.  By 

converting the signal from horizontal/vertical 

polarization to circular polarization the difference in 

spectrometer performance will be removed, and all 

light will be detected in exactly the same way. 

9.11.3.4. Laser Polarization 

Select {Lambda/2}, {Lambda/4} or {None} to insert 

a polarizor element into the laser beam path to 

adjust the polarization of the laser beam. 

Lambda/2 (or λλλλ/2) 

Rotates the laser beam polarization by 90
o
. 
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Lambda/4 (or λλλλ/4) 

Converts the laser beam polarization from linearly 

polarized to circularly polarized. 

None 

Leaves the laser beam with its intrinsic linear 

polarization. 

9.11.3.5. Fiber Entrance 

Select {Fiber On} or {Fiber Off} to select whether 

the Raman signal is detected from the microscope, 

or from a separate fiber optically coupled remote 

Raman probe head, such as a SuperHead. 

Fiber On 

In this mode, only Raman signal which is delivered 

via a fibre optic to the FC connector on the 

underside of the XploRA™ platform will be 

detected.  You should select this mode if you wish 

to work with a remote Raman probe. 

Fiber Off 

In this mode, Raman signal which originates from 

the microscope will be detected.  You should select 

this mode if you wish to make ‘standard’ 

microscope measurements with the XploRA™. 

9.11.3.6. White Lamp 

The White Lamp slider controls the intensity of an 

internal white LED to illuminate the sample when it 

is visualized using the internal Adjustment Camera. 
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9.11.3.7. Init 

The [Init] button will re-initialize all of the XploRA 

motors, and confirm that they are at their correct 

positions. 

 

 

 

 

 

9.11.4. Control of Hardware Options (for LabRAM ARAMIS) 

The LabRAM ARAMIS Setup window allows control of the following optional items: 

o Measurement location (microscope, fibre optic probe, macro chamber) 

o Laser and Raman path polarizors 

o Trinocular head on the microscope 

o Multiple detectors 

o “Point Mode” and “Line Mode” optics 

o UV/IR and visible dual path optics 

 

 

 

 

 

 

 

 

 

Please note that depending on the configuration of your system certain items in the Setup window 

may be greyed out. 

The LabRAM ARAMIS Setup window is opened by 

clicking on the Setup button. 
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9.11.4.1. Visualization 

Select {Video On} or {Video Off} to control the 

internal camera optics.  

Video On 

Optics for internal camera and reflected white light 

illumination are in the light path; Raman path is 

inactive.  This mode is used to visualize the 

sample and acquire white light images of the 

sample using the internal camera. 

Video Off 

Raman path is active; optics for internal camera 

and reflected white light illumination are out of the 

light path.  This mode is used to acquire a Raman 

spectrum. 

Select {Trino On}, {Trino Off} or {FTIR} in the “Top 

Video” section to control the optical path to the 

optional trinocular head and FTIR module 

Trino On 

Microscope eye pieces and top camera are active, 

with illumination beam splitter in place; Raman 

path, internal camera optics and FTIR module are 

inactive. 

Trino Off 

Raman path and internal camera optics are active; 

microscope eye pieces, top camera and FTIR 

module are inactive. 

FTIR 

FTIR module is active; Raman path and internal 

camera optics are inactive; microscope eye pieces 

and top camera are active for transmitted white 

light illumination only, and inactive for reflected 

white light illumination. 
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9.11.4.2. Polarization 

Select the required polarizor element to control the 

polarization of the laser beam and the analysed 

Raman signal. 

Laser - Vertical 

Allows the laser beam to be linearly polarized in a 

vertical orientation. 

Laser - Horizontal 

Allows the laser beam to be linearly polarized in a 

horizontal orientation. 

Laser - Circular 

Converts the laser beam polarization from linearly 

polarized to circularly polarized. 

Raman - Vertical 

Only Raman signal which is linearly polarized in a 

vertical orientation will be detected. 

Raman - Horizontal 

Only Raman signal which is linearly polarized in a 

horizontal orientation will be detected. 

Raman - Circular 

All Raman signal will be converted to circularly 

polarized light prior to detection. 

Raman – Scrambler 

The polarization of the Raman signal will be 

scrambled (removed) prior to detection. 

9.11.4.3. Measure Location 

Select the required measurement location on the 

system, including the microscope, macro chamber 

and external fibre optically coupled probes. 

Macro 90 

In this mode, Raman signal which originates from 

the macro chamber in a 90
o
 orientation will be 

detected.  You should select this mode if you wish 

to analyse bulk materials in the macro chamber 

using a 90
o
 orientation. 

Retro 

In this mode, Raman signal which originates from 

the macro chamber in a 180
o
 back scattering 

(retro) orientation will be detected.  You should 
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select this mode if you wish to analyse bulk 

materials in the macro chamber, using a back 

scattering geometry. 

Micro 

In this mode, Raman signal which originates from 

the microscope will be detected.  You should select 

this mode if you wish to make ‘standard’ 

microscope measurements with the LabRAM 

ARAMIS. 

External 

In this mode, Raman signal which originates from 

an external location will be detected, using the 

fiber optical input.  The light is passed directly from 

the fiber optical input into the spectrometer, 

bypassing the microscope optics.  You should 

select this mode when working with SuperHead 

fiber optic remote probe heads  

9.11.4.4. Measure 

Select {Point Mode} or {Line Mode} to control the 

optics for standard spot analysis or confocal line 

scan analysis. 

Point Mode 

Sets up the measurement for standard spot (or 

point) analysis.  You should select this mode if you 

wish to make ‘standard’ measurements with a 0.5-

10µm laser spot. 

Line Mode 

Sets up the measurement for confocal line scan 

analysis.  You should select this mode in 

combination with the LineScan scanning mirror 

controller, which allows the laser spot to be rapidly 

rastored across the sample.  This is useful for 

acquiring an average spectrum from along the 

entire line, and for fast Raman mapping 

applications. 
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9.11.4.5. Detection 

Select {CCD} or {PMT/IGA} to control the optics for 

multiple detectors mounted on the LabRAM 

ARAMIS. 

CCD 

In this mode the standard CCD detector will be 

used for the analysis. 

PMT/IGA 

In this mode the detector mounted on the second 

port will be used for the analysis.  Typically this 

detector will either be a photomultiplier tube (PMT), 

InGaAs array (IGA) or a second specialized CCD. 

 

 

9.11.4.6. UV / Visible 

Select {UV / IR} or {Visible} to control the dual path 

optics in the LabRAM ARAMIS, which allow 

optimised detection in either the UV/IR or visible 

spectral regions. 

UV / IR 

In this mode, mirrored optics are used which are 

optimised for UV and/or infra-red (IR) analysis. 

Visible 

In this mode achromatic lense optics are used 

which are optimised for standard visible analysis.  
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10. Appendix: Manual Wavelength Calibration of LabRAM Systems 

The procedure outlined below can be used to manually calibrate the LabRAM systems (including 

LabRAM 300, LabRAM 1B, LabRAM HR, LabRAM ARAMIS, LabRAM INV, LabRAM IR and LabRAM 

IR
2
). 

The full calibration procedure uses two software parameters 

o ZERO:  for calibration of the diffraction grating’s zero order peak position (0 nm) 

o KOEFF:  for calibration of the Raman peak position 

Note that this calibration procedure is a diffraction grating calibration, and should be repeated for all 

diffraction gratings on the system.  The software will retain individual calibration values for each 

diffraction grating. 

A full calibration of a system with multiple lasers requires one of the lasers to be designated as the 

‘reference laser’ – the wavelength of this laser is assumed to be constant, and known.  The remaining 

laser wavelengths are then calibrated relative to the reference laser. 

Before performing a manual calibration, ensure that all lasers which are to be used for the calibration 

have been turned on and left to warm up for a minimum of 15-30 minutes.  This is essential to ensure 

the laser wavelength has stabilised. 

10.1. Calibration of Zero Order Position (ZERO) 

Insert the silicon (Si) calibration sample 

underneath the microscope, and focus on it in the 

normal way, using a 50x or 100x magnification 

objective. 

Selecting the diffraction grating you wish to 

calibrate, using the Diffraction Grating drop down 

box in the control panel. 

 

Select the reference laser from the Laser drop 

down box in the Control Panel. 

 

 

Send the spectrograph to zero order (0 nm) using 

the icon in the Spectrometer section of the 

hardware toolbar.  
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Turn on the reference laser, and acquire a 

spectrum at zero order (0 nm) using the real time 

display (RTD) function.  Ensure the detector is not 

saturated - if the signal is too intense, insert a filter 

in the laser path, reduce the confocal hole 

diameter, or decrease the acquisition time.  

Stop the spectrum readout by clicking [STOP]. 

 

Zoom in on the peak, using the Zoom icon in the 

Graphical Manipulation toolbar.  

Use the cursor to locate the center of the zero 

order peak. 

If the peak is within ±4 data points of 0 nm, the 

calibration is acceptable.  If the peak is at a 

position greater than ±4 data points from 0 nm the 

calibration must be adjusted. 

To do this click on Setup > Instrument Calibration 

to open the Calibration dialog window.  

Adjust the ZERO parameter and then click the 

[Apply]. You should see the peak move.  Continue 

to adjust the ZERO value until the band is within ±1 

data point of 0 nm. 

Click [OK] to save the calibration values for the 

current grating and close the Calibration dialog 

window. 

 

 

Resend the spectrograph to zero order and retake 

the spectrum.  This will make sure that your 

calibration changes have taken effect.  Check the 

zero order position again and if necessary, make 

further adjustments (change ZERO, resend to 

zero, check position etc) until the position is 

acceptable. 

NOTE:  The ZERO parameter should be changed 

in small increments e.g. ±5 at a time. 

 

 



LabSpec 5 user manual 

 

 

 

 

Page | 250  

 

 

10.2. Calibration of Raman Peak (KOEFF) 

Move the spectrometer to 520.7 cm
-1

 to analyse 

the silicon (Si) first order Raman peak.  

 

 

Acquire a spectrum of the silicon (Si) sample using 

the real time display (RTD) function.  Ensure the 

detector is not saturated - if the signal is too 

intense, insert a filter in the laser path, reduce the 

confocal hole diameter, or decrease the acquisition 

time. 

Stop the spectrum readout by clicking [STOP].  

 

Zoom in on the peak, using the Zoom icon in the 

Graphical Manipulation toolbar.  

Use the cursor to locate the center of the 

520.7 cm
-1

 silicon (Si) peak. 

If the peak is within ±4 data points of 520.7 cm
-1

, 

the calibration is acceptable.  If the peak is at a 

position greater than ±4 data points from 520.7 cm
-

1
 the calibration must be adjusted. 

To do this click on Setup > Instrument Calibration 

to open the Calibration dialog window.  

Adjust the KOEFF parameter and then click 

[Apply]. You should see the peak move.  Continue 

to adjust the KOEFF value until the band is within 

±1 data point of 520.7 cm
-1

. 

Click [OK] to save the calibration values for the 

current grating and close the Calibration dialog 

window. 

 

 

 

 

 

520.7 
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10.3. Calibration of Additional Lasers 

The process outlined above is used to calibrate the 

diffraction grating, using the reference laser. 

Additional lasers must be calibrated using the 

following procedure – each laser must be 

calibrated individually, using this procedure. 

Select the laser to be calibrated from the Laser 

drop down box in the Control Panel. 

 

 

Move the spectrometer to 520.7 cm
-1

 to analyse 

the silicon (Si) first order Raman peak.  

 

 

Acquire a spectrum of the silicon (Si) sample using 

the real time display (RTD) function.  Ensure the 

detector is not saturated - if the signal is too 

intense, insert a filter in the laser path, reduce the 

confocal hole diameter, or decrease the acquisition 

time. 

Stop the spectrum readout by clicking [STOP].  

 

Zoom in on the peak, using the Zoom icon in the 

Graphical Manipulation toolbar.  

Use the cursor to locate the center of the 

520.7 cm
-1

 silicon (Si) peak. 

If the peak is within ±4 data points of 520.7 cm
-1

, 

the calibration is acceptable.  If the peak is at a 

position greater than ±4 data points from 520.7 

cm
-1

 the calibration must be adjusted. 

To do this manually adjust (by left clicking and 

typing) the laser wavelength displayed in the Laser 

drop down box in the Control Panel and press 

<enter ����   >. 

 

Repeat this laser calibration procedure for all other 

lasers which are to be calibrated.  

520.7 
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Axes ........................................................................ 183 

Axes3D ................................................................... 194 

Circle mapping ....................................................... 190 

Correct shape ......................................................... 168 

Hor line mapping.................................................... 188 

Integral ................................................................... 178 

Intensity shift ......................................................... 170 

Line mapping .......................................................... 189 

Map analysis cursors .............................................. 166 

Multiply by constant .............................................. 172 

Pointer ................................................................... 165 

Points mapping ...................................................... 185 

Polygon mapping ................................................... 191 

Rectangular mapping ............................................. 188 

Remove baseline points ......................................... 182 

Remove peak ......................................................... 177 

Remove spike ......................................................... 167 

Scale shift ............................................................... 170 

SpImBlue ................................................................ 166 

SpImGreen ............................................................. 166 

SpImRed ................................................................. 166 

Ver line mapping .................................................... 191 

Zoom ...................................................................... 169 

Graphical user interface .................................................. 8 

Guided Operation Wizard ............................................. 82 
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Help 

Context help ............................................................. 91 

Online topics ............................................................ 88 

Help menu .................................................................... 88 

About LabSpec... ...................................................... 88 

Help topics ............................................................... 88 

Language .................................................................. 88 
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Icon bar ......................................................................... 89 

Big icon ..................................................................... 89 

Cursors and data information icons ......................... 91 

Centre cursors ..................................................... 92 

Data range ........................................................... 92 

Intensity normalization ....................................... 92 

Scale normalization ............................................. 91 

Data acquisition icons .............................................. 95 

DuoScan ............................................................ 111 

Extended range acquisition ............................... 102 

Extended video .................................................. 103 

Mapping acquisition ............................................ 96 

Mapping properties ............................................. 97 

MultiPoint ......................................................... 105 

Spectrum acquisition ........................................... 96 

Spectrum RTD (real time display) ........................ 95 

Video ................................................................. 102 

Data management icons .......................................... 90 

Help ..................................................................... 91 

Open .................................................................... 90 

Print ..................................................................... 91 

Save ..................................................................... 91 

Data processing and analysis icons ........................ 115 

Baseline correction ............................................ 116 

Create spectral profile ....................................... 150 

Fourier transform .............................................. 128 

Map analysis ...................................................... 148 

Math .................................................................. 131 

Modelling .......................................................... 155 

Peak searching and fitting ................................. 135 

Profile ................................................................ 146 

Smoothing ......................................................... 125 

Spectral ID search .............................................. 115 

Spectral normalisation and correction .............. 121 

Delete data icon ....................................................... 90 

Delete .................................................................. 90 

Small icon ................................................................. 89 

Stop active function icon ........................................ 164 

Stop active function .......................................... 164 

Switch between "Big" and "Small" icons .................. 89 

Image 

Color palettes ......................................................... 212 

Contrast and brightness ......................................... 213 

Overlay map/score information on video image ... 223 

Scale bar ................................................................. 223 

Smoothing ............................................ See Smoothing 

Information 

Custom information ........................... See Custom info 
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Parameters ............................................................... 92 

Acquisition .......................................................... 94 

Custom ................................................................ 94 

History ................................................................. 95 

Intensity correction....................................................... 43 

Apply correction after acquisition ............................ 45 

Automatic correction during acquisition 

Turn off ............................................................... 45 

Turn on ................................................................ 44 

How is the correction factor calculated ................... 44 

Select a filter ............................................................ 75 

Status bar indicator ................................................ 200 

Use with manually selected filters ........................... 75 

Intensity profile ........................................................... 146 

L 

LabAssistant 

Templates ................................................................ 76 

Create .................................................................. 78 

Custom ................................................................ 77 

Default................................................................. 76 

Display templates in the Custom list ................... 79 

Organising ........................................................... 79 

Save ..................................................................... 78 

LabAssistant menu 

Create template ....................................................... 78 

Custom templates .................................................... 77 

Default templates .................................................... 76 

G.O. (Guided Operation Wizard) .............................. 82 

Manage templates ................................................... 79 

Label axes ..................................................................... 21 

Label peaks ....................... See Peak searching and fitting 

LabRAM ARAMIS 

Hardware control ................................................... 243 

Measurement location ...................................... 245 

Measurement mode (point / line)..................... 246 

Polarization ....................................................... 245 

Select detector .................................................. 247 

Select Visible or UV/IR optical path ................... 247 

Visualization ...................................................... 244 

Instrument setup ................................................... 239 

Turn on laser .......................................................... 239 

Language ....................................................................... 88 
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Create macro spot................................... See DuoScan 

Polarization ........................................ See Polarization 

Power filter ............................................................ 228 

Reduce power ........................................................ 228 

Scan spot over area ................................. See DuoScan 

Selecting laser wavelength ..................................... 228 

Set laser spot marker position on video image ........ 67 

Turning on 

LabRAM ARAMIS ............................................... 239 

XploRA ............................................................... 239 

Layout of LabSpec 5 software ......................................... 8 

Legend......................................................................... 217 

LineScan 

Activate LineScan for XY mapping ............................ 40 

Scale the video image for the scan size .................... 71 

Log-in password ........................... See User log-in profiles 
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Map ......................... See Multidimensional spectral array 

Math ........................................................................... 131 

Drag spectrum with mouse to add constant .......... 171 

Drag spectrum with mouse to multiply by constant

 .......................................................................... 172 

Mathematical manipulation .............................. See Math 

Menu bar ...................................................................... 10 
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Help .......................................................................... 88 
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Options ..................................................................... 22 

Scripts ....................................................................... 82 

Setup ........................................................................ 73 

Video ........................................................................ 66 

Window .................................................................... 86 

Microscope objective .................................................. 234 

Modelling 

Display 

Error map .......................................................... 157 

Model sum ........................................................ 157 

How to automatically create a model .................... 162 

How to manually model data ................................. 158 

Using previously saved reference spectra ......... 161 

Load current spectrum ........................................... 157 

Load multiple spectra ............................................. 157 

The "Create" factor analysis procedure ................. 156 

Set number of factors ........................................ 156 

Start ................................................................... 158 

The DCLS modelling procedure .............................. 155 

Normalized ........................................................ 155 

Unnormalized .................................................... 155 
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Threshold data ....................................................... 156 

Montage video images ...................... See Extended video 

Motorized sample stage 

Move by inputting coordinates .............................. 237 

Switching stage ...................................................... 238 

Viewing coordinate position .................................. 237 

Motors 

Calibrate ................................................................... 74 

Reinitialize ................................................................ 75 

Multi (batch processing) ............................................... 23 

Multidimensional spectral array 

Acquisition 

Measurement order ............................................ 99 

Changing the order ....................................... 102 

Parameters .......................................................... 97 

Start acquisition .................................................. 96 

Use external trigger for CCD................................ 99 

Use SWIFT for ultra-fast acquisition .................... 99 

Adding a new array dimension .............................. 101 

Baseline correction ................................................ 121 

Correct spectrum in array ...................................... 149 

Cursors for aray analysis ........................... See Cursors 

Define position on video image 

Circle ................................................................. 190 

Line 

Diagonal ....................................................... 189 

Horizontal ..................................................... 188 

Vertical ......................................................... 191 

Points ................................................................ 185 

Polygon ............................................................. 191 

Rectangle........................................................... 188 

Deleting an array dimension .................................. 101 

Factor analysis....................................... See Modelling 

Image properties .......................................... See Image 

Mean spectrum 

From selected area ............................................ 220 

From selected points ......................................... 220 

Modellling ............................................. See Modelling 

Overlay map/score information on video image ... 223 

Peak searching and fitting ....... See Peak searching and 

fitting 

Restore "Point" window if it has been deleted ...... 149 

Save all spectra in array as individual files ............... 11 

Spectral profile 

Add spectrum to profile .................................... 153 

Create from individual spectra .......................... 152 

Delete spectrum from profile ............................ 154 

Insert spectrum into profile .............................. 153 

Threshold data ....................................................... 123 

Multiply spectra ................................................. See Math 

Multipoint acquisition 

Marking points on video image .............................. 185 

Using XYZ coordinate list ........................................ 105 

Creating a list ..................................................... 110 

Note about coordinates used ............................ 111 

Saving data ........................................................ 108 

Multiwindow ..................................... See Extended range 

N 

Neutral density filter ................................................... 228 

Normalize .................................................................... 122 

Modes .................................................................... 124 

O 

Objective .................................. See Microscope objective 

Open data ..................................................................... 11 

Options menu ............................................................... 22 

Multi ......................................................................... 23 

Pressure unit ............................................................ 23 

Profiles... .................................................................. 25 

Template .................................................................. 29 

Unit .......................................................................... 22 
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Data for display ................................ See Data: Display 

Map/score information on video image ................ 223 
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Paste data ..................................................................... 18 

Peak area 

By cursor ................................................................ 178 

By fitting ................................................................. 136 

Peak pick ........................... See Peak searching and fitting 

Peak searching and fitting ........................................... 135 

Add peak to spectrum ............................................ 173 

Display options ....................................................... 144 

Display peak parameters ........................................ 139 

Fitting 

Adjust peak position and shape manually ......... 175 

Create image of fit parameters (for 

multidimensional spectral array) .................. 140 

Fit 138 

Options .............................................................. 137 

Remove peak manually ..................................... 177 

Shape function 
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Define custom shape .................................... 145 

Select ............................................................ 136 

Variables 

Add variables ................................................ 142 

Configure ...................................................... 141 

Delete variables ............................................ 143 

Searching 

Adjust peak position manually .......................... 175 

Label peak manually .......................................... 173 

Options .............................................................. 136 

Remove peak manually ..................................... 177 

Search................................................................ 137 

Pen tool ....................................................................... 168 

Pencil tool ................................................................... 168 

Photo-bleaching time ................................................... 35 

Status bar indicator ................................................ 200 

Turn off .................................................................... 36 

Turn on ..................................................................... 35 

Pointer ........................................................... See Cursors 

Polarization 

Control laser polarization 

LabRAM ARAMIS ............................................... 245 

XploRA ............................................................... 241 

Control Raman polarization 

LabRAM ARAMIS ............................................... 245 

XploRA ............................................................... 241 

Polarizors ................................................ See Polarization 

Pressure units ............................................................... 23 

Printing functions.......................................................... 13 

Print template page ................................................. 13 
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Intensity profile across 2D image . See Intensity profile 

Spectral .............. See Multidimensional spectral array 

User log-in profiles .................. See User log-in profiles 
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Real time display (RTD) 

Acquisition time ..................................................... 235 

Detector image read out RTD mode 

Configure ............................................................. 33 

Start acquisition .................................................. 96 

Spectrum read out RTD mode 

Start acquisition .................................................. 95 

Reinitialize instrument .................................................. 75 

Relative 

Positioning for multidimensional spectral arrays..... 98 

Report function ............................................................. 13 

Rescale ............................................................... See Scale 

Resize data .................................................................... 21 

Resolution 

Controlling depth resolution with confocal hole .... 229 

Controlling spectral resolution 

WIth diffraction grating ..................................... 232 

With slit ............................................................. 230 

Right click menus ........................................................ 204 

Axes ........................................................................ 214 

Blue cursor ............................................................. 221 

Centre cursors ........................................................ 213 

Cursor ..................................................................... 219 

Fast settings ........................................................... 210 

Format and scale .................................................... 205 

Green cursor .......................................................... 221 

Image ..................................................................... 222 

Image colors ........................................................... 211 

Image3D ................................................................. 225 

Imposition .............................................................. 223 

Legend .................................................................... 217 

Red cursor .............................................................. 221 

Rescale ................................................................... 210 

Scale bar ................................................................. 223 

Spectrum ................................................................ 218 

Swap X axis ............................................................. 210 

Swap Y axis ............................................................. 211 

RTD ........................................ See Real time display (RTD) 
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Save 

Options for saving data ............................................ 12 

Save all data ............................................................. 11 

Save all spectra in array as individual files ............... 11 

Save as ..................................................................... 11 

Save picture as ......................................................... 12 

Savitsky-Golay ........................................... See Smoothing 

Scale 

Format scale behaviour .......................................... 209 

Rescale 

All axes ................................................................ 91 

Drag spectrum with mouse to rescale .......... 170 

Intensity .............................................................. 92 

Drag spectrum with mouse to rescale .......... 170 

Scale bar for images ............................................... 223 

Scale data manually (shift, stretch, compress axis) .. 21 

Set scale of video images ................. See Video images 

Scanner ........................................................ See LineScan 

Scripts ........................................................................... 82 

Add scripts to menu list ........................................... 85 



LabSpec 5 user manual 

 

 

 

Page | 259  

 

 

Apply a script before/after acquisition .................... 85 

Edit ........................................................................... 84 

Load and manage ..................................................... 83 

Menu list .................................................................. 86 

Remove scripts from menu list ................................ 85 

Trigger ...................................................................... 85 

Use scripts to control motors ................................... 86 

Scripts menu ................................................................. 82 

Options .................................................................... 83 

Scroll bars ................................................................... 208 

Setup menu................................................................... 73 

ICS Filters ................................................................. 75 

Instrument calibration ............................................. 73 

Instrument init ......................................................... 75 

Slit ............................................................................... 230 

Small icon ...................................................... See Icon bar 

Smoothing 

Data 

Denoise 

After acquisition ........................................... 125 

Automatic Denoise during acquisition ........... 46 

Turn off ...................................................... 47 

Turn on ...................................................... 47 

Fourier transform .............................................. 128 

Median .............................................................. 127 

Savitsky-Golay ................................................... 126 

Image pixel smoothing ........................................... 222 

Spectral database ..................................... See Spectral ID 

Spectral ID 

Configuring LabSpec correctly................................ 115 

Start search from LabSpec ..................................... 115 

Using ........................ See separate Spectral ID manual 

Spectral profile........ See Multidimensional spectral array 

Spectral range ................................... See Extended range 

Spectrometer 

Select diffraction grating .......... See Diffraction grating 

Send to zero order reference position ................... 231 

Spectral position .................................................... 231 

Spectrum display ................................................ See Data 

Spike filter 

Automatic spike filter 

After acquisition ................................................ 127 

During acquisition ............................................... 37 

Turn off ........................................................... 38 

Turn on ........................................................... 38 

Manually remove spike after acquisition ............... 167 

Split spectral array ........................................................ 11 

Status bar .................................................................... 200 

Active options ........................................................ 200 

Cursor values ......................................................... 202 

Detector temperature ............................................ 201 

Progress bar ........................................................... 202 

System messages ................................................... 200 

Stitch video images ............................See Extended video 

Sub-pixel ........................................... See Extended range 

Subtract spectra ................................................. See Math 

SWIFT ultra-fast mapping See Multidimensional spectral 

array 

T 

Temperature 

Operating temperature of detector ........ See Detector 

Spectral profile ... See Multidimensional spectral array 

Templates .............................................. See LabAssistant 

Threshold .................................................................... 123 

Topography 

Acquire topography image ................ See Extra images 

Use Autofocus to analyse rough samples .............. See 

Autofocus 

Trigger 

Apply a script before/after acquisition .................... 85 

Use external trigger for CCD .................................... 99 

Trigger message window .............................................. 32 
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Units .............................................................................. 22 

Custom units ............................................................ 24 

Pressure units ........................................................... 23 

User log-in profiles ........................................................ 25 

Changing a user profile password ............................ 28 

Creating a new user profile ...................................... 27 

Log in during a session ............................................. 27 

Log-in at start ........................................................... 26 

User levels ................................................................ 25 
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Version number ............................................................ 88 

Video images 

Aspect ratio ............................................................ 208 

Brightness and contrast ......................................... 213 

Camera configuration .............................................. 67 

Default X axis display.............................................. 210 

Default Y axis display .............................................. 211 

Define multidimensional spectral array position ... 185 
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Extended video image ................... See Extended video 

List of installed cameras ........................................... 72 

Overlay map/score information ............................. 223 

Scale bar ................................................................. 223 

Selecting a camera ................................................... 72 

Set the image scale .................................................. 68 

Manually ............................................................. 70 

Using ................................................................... 68 

Set the laser spot marker position ........................... 67 

Set the LineScan image scale ................................... 71 

Start acquisition ..................................................... 102 

Video menu................................................................... 66 

Format ..................................................................... 67 

Laser position ........................................................... 67 

List of installed cameras ........................................... 72 

Offsets ...................................................................... 67 

Source ...................................................................... 67 

Video image scale .................................................... 68 

Visual basic scripting ........................................ See Scripts 
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Warm detector to room temperature .......................... 66 

Window menu .............................................................. 86 

Cascade .................................................................... 87 

Tile ........................................................................... 87 

X 

X axis 

Reverse display ...................................................... 210 

Units ......................................................................... 23 

XploRA 

Hardware control ................................................... 240 

Adjustment camera ........................................... 241 

Fiber entrance ................................................... 242 

Microscope ........................................................ 240 

Polarizors 

For laser ........................................................ 241 

For Raman .................................................... 241 

Re-initialise ........................................................ 243 

White lamp ........................................................ 242 

Instrument setup ................................................... 239 

Turn on laser .......................................................... 239 
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Y axis 

Reverse display ...................................................... 211 

Units ......................................................................... 23 

Z 

Zero data ..................................................................... 122 

Zero order position 

Manual calibration ............................... See Calibration 

Send spectrometer to zero order ........................... 231 
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